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SOFTWARE LICENSE AGREEMENT 
 
PLEASE READ THE TERMS OF THIS AGREEMENT BEFORE USING THE ENCLOSED 
SOFTWARE. BY USING THE ENCLOSED SOFTWARE, YOU ARE ACCEPTING THE TERMS OF 
THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THESE TERMS, PLEASE 
RETURN THIS SOFTWARE AND ASSOCIATED DOCUMENTATION WITHIN 90 DAYS OF THE 
PURCHASE DATE TO THE PLACE OF PURCHASE FOR A FULL REFUND OF THE PURCHASE 
PRICE. 
 
License Agreement 
 
Troopmaster Software, Inc. ("Troopmaster Software") grants you a non-exclusive, non-transferable, 
time-limited license to use the Software, which is defined as the TroopMaster computer program with 
which this Software License Agreement is included and any updates or maintenance releases thereto, 
and to use any documentation files and manuals ("Documentation") accompanying the Software. This 
Software License Agreement will remain in effect only during the License Period, which is defined as a 
one, two, or three-year period as assigned to the purchaser at the time of purchase. Do not use the 
Software until you have carefully read the following License Agreement. This License Agreement sets 
forth the terms and conditions for licensing of the Software from Troopmaster Software to you, and 
installing the Software indicates that you have read and understand this License Agreement and accept 
its terms and conditions. If you do not agree with the License Agreement, promptly return the Software 
and accompanying items to the place of purchase within ninety (90) days of purchase with a dated 
receipt for a full refund of the purchase price.  
 
Site License and Certain Restrictions 
 
The Software and Documentation in their entirety are protected by the copyright laws. You have no 
ownership rights in the Software, but only a license to use the Software as long as the Software License 
Agreement remains in full force and effect. Ownership of the Software, Documentation and all 
intellectual property rights therein shall remain at all times with Troopmaster Software. Any other use of 
the Software or Documentation by any person, business, corporation, government organization or other 
entity, except as expressly authorized in this Software License Agreement is strictly prohibited. 
 
The Software also contains Troopmaster Software trade secrets and other proprietary information. You 
agree to maintain the confidentiality of the Software using at least as great a degree of care as you use to 
maintain the confidentiality of your own most confidential information. You agree to reasonably 
communicate the terms and conditions of this Software License Agreement to those persons who are 
authorized hereby to use the Software and Documentation, and you agree to use reasonable efforts to 
ensure their compliance with such terms and conditions. 
 
In order to provide data encryption, this Software also contains the Polar Crypto Component from Polar 
(Copyright 1998-2003). 
 
 
 
 
You may not de-compile, reverse engineer, or disassemble any of the Software or otherwise reduce the 
Software to human-perceivable form. You may not copy, publish, modify, adapt, translate, rent, sub-
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license, assign, loan, or resell for profit the Software or Documentation or create derivative works based 
on the Software or any part, except in compliance with the terms and provisions of this Software License 
Agreement. 
 
When you purchase this Software, you are assigned a License Period of one, two, or three years. While 
your License remains in effect, you are entitled to download any new Software version releases, updates, 
and maintenance releases from our Internet site free of charge. If you wish to obtain a new or 
replacement copy of the software on CD or other storage media, your cost will be $5.00 plus a 
shipping/handling fee. When your License Period expires, you must either renew your License or stop 
using the Software.  
 
When you purchase this Software, you are provided a site license for a single troop, team, or crew 
("Unit"), which means that you may make as many copies of the Software and Documentation (except 
the copyrighted artwork described below) as needed for use by that Unit, including copies for individual 
members of the Unit. However, when you leave the Unit, you must either (1) leave all copies (including 
originals) of the Software and Documentation with the Unit or (2) take all copies of the Software and 
Documentation with you. If you choose to take all copies with you to your next Unit, you must re-
register the Software to the new Unit through Troopmaster Software. There is no re-registration fee. 
Software purchased with Unit funds and software that is the physical property of the Unit (and not a 
single individual) may only be re-registered to another Unit if the original Unit has folded. In this case, 
we would need to receive a signed letter from the local council stating that the original Unit is no longer 
in existence and that they are transferring all of their software license rights to the new Unit. Whenever 
the Software is re-registered to a new Unit, the previous Unit is automatically de-registered, and 
continued use of the Software by the previous Unit or any member of the previous Unit is a violation of 
this Software License Agreement. 
 
INSTALLATION OF THIS SOFTWARE ON ANY MEMBER’S COMPUTER INDICATES THAT 
THE MEMBER ACCEPTS ALL OF THE TERMS OF THIS SOFTWARE LICENSE AGREEMENT. 
 
The watercolor outdoor scene used to produce the bit map background for the Software main menu was 
painted especially for Troopmaster Software by artist Gail McIntosh. This art work is copyrighted and 
may not be reproduced without permission of the artist and Troopmaster Software. All rights are 
reserved. 
 
Interface with ScoutNET Program Administration System ("PAS") 
 
The Software provides a compatible interface with Boy Scouts of America's ScoutNET PAS. However, 
the Software is not an Official Boy Scouts of America Product and the Boy Scouts of America makes no 
guarantees and makes no warranties with respect to the performance of this Software, nor does the Boy 
Scouts of America provide any user support for this Software. The compatible interface between this 
Software and ScoutNET PAS enables the transfer of unit data between these two computer systems, but 
TroopMaster Software makes no warranties with respect to the content of the data being transferred. 
Troopmaster Software is not and will not be responsible for any personal injury or privacy damage 
arising out of the use, disclosure, dissemination, or publication of any of the data provided to the Boy 
Scouts of America through the ScoutNET PAS interface. 
 
 
LIMITED WARRANTY 
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TROOPMASTER SOFTWARE WARRANTS FOR A PERIOD OF NINETY (90) DAYS AFTER 
PURCHASE THAT THE SOFTWARE WILL OPERATE SUBSTANTIALLY IN ACCORDANCE 
WITH THE DOCUMENTATION. SHOULD THE SOFTWARE NOT SO OPERATE, YOUR SOLE 
AND EXCLUSIVE REMEDY, AND TROOPMASTER SOFTWARE'S SOLE OBLIGATION UNDER 
THIS WARRANTY SHALL BE REFUND OF THE FEE PAID FOR THE SOFTWARE LICENSE 
UPON DELIVERY OF THE SOFTWARE, DOCUMENTATION, AND A DATED RECEIPT TO THE 
PLACE OF PURCHASE. AFTER THE EXPIRATION OF THIS WARRANTY, YOU MAY 
REPLACE ANY DEFECTIVE SOFTWARE DISK BY SENDING YOUR ORIGINAL DISK, 
TOGETHER WITH A CHECK FOR $10.00, PLUS APPLICABLE TAX (VA RESIDENTS ONLY) 
TO TROOPMASTER SOFTWARE. EXCEPT FOR THE LIMITED WARRANTY STATED ABOVE, 
THE SOFTWARE IS PROVIDED "AS IS" TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW. TROOPMASTER SOFTWARE DISCLAIMS ALL OTHER WARRANTIES OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. TROOPMASTER SOFTWARE DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THIS SOFTWARE WILL MEET ANY OF YOUR NEEDS OR THAT THE 
SOFTWARE WILL OPERATE ERROR FREE, OR IN AN UNINTERRUPTED FASHION, OR THAT 
ANY DEFECTS OR ERRORS IN THE SOFTWARE WILL BE CORRECTED. SOME 
JURISDICTIONS DO NOT ALLOW THE WAIVER OR EXCLUSION OF IMPLIED WARRANTIES 
SO THEY MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS AS WELL, WHICH VARY FROM 
STATE TO STATE. 
 
LIMITATION OF LIABILITY 
 
IN NO EVENT WILL TROOPMASTER SOFTWARE BE LIABLE TO YOU OR ANY THIRD 
PARTY FOR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT 
LIMITATION, INDIRECT, SPECIAL, PUNITIVE, OR EXEMPLARY DAMAGES FOR LOSS OF 
BUSINESS, LOSS OF PROFITS, BUSINESS INTERRUPTION, OR LOSS OF BUSINESS 
INFORMATION) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, OR 
FOR ANY CLAIM BY ANY OTHER PARTY, EVEN IF TROOPMASTER SOFTWARE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. TROOPMASTER SOFTWARE'S 
AGGREGATE LIABILITY WITH RESPECT TO ITS OBLIGATIONS UNDER THIS LICENSE 
AGREEMENT OR OTHERWISE WITH RESPECT TO THE SOFTWARE AND 
DOCUMENTATION OR OTHERWISE SHALL NOT EXCEED THE AMOUNT OF THE LICENSE 
FEE PAID BY YOU FOR THE SOFTWARE AND DOCUMENTATION. BECAUSE SOME 
STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY 
FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU. 
 
 
 
 
 
 
 
 
Termination 
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This Software License Agreement is effective until it is terminated or until your License Period expires, 
whichever occurs first. You may terminate this Software License Agreement at any time by destroying 
or returning to Troopmaster Software all copies of the Software and Documentation in your possession 
or under your control. Troopmaster Software may terminate this Software License Agreement if you 
violate any of the terms of this Software License Agreement. Upon notification of termination, you 
agree to destroy or return to Troopmaster Software all copies of the Software and Documentation and to 
certify in writing that all known copies, including backup copies, have been destroyed. All provisions 
relating to confidentiality, proprietary rights, and non-disclosure shall survive the termination of this 
Software License Agreement. 
 
General Provisions 
 
You acknowledge that this License Agreement is a complete statement of the agreement between you 
and Troopmaster Software, and that there are no other prior or contemporaneous understandings, 
promises, representations, or descriptions regarding the Software, the Documentation, or any related 
services. This License Agreement does not limit any rights that Troopmaster Software may have under 
trade secret, copyright, patent, or other laws. Representatives of Troopmaster Software are not 
authorized to make modifications to this License Agreement, or to make any additional representations, 
commitments, or warranties binding on Troopmaster Software, other than in writing signed by an officer 
of Troopmaster Software. Accordingly, such additional statements are not binding on Troopmaster 
Software and you should not rely upon such statements. If any provision of this License Agreement is 
invalid or unenforceable under applicable law, then it is, to that extent, deemed omitted and the 
remaining provisions will continue in full force and effect. The validity and performance of this License 
Agreement shall be governed by Virginia law (without reference to choice of law principles), except as 
to matters are covered by federal laws.  
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INTRODUCTION 
 
Thank you for purchasing TroopMaster®, by far the most powerful and popular unit management system 
on the market! You will soon be joining the many thousands of your fellow Scouters who save time and 
effort using programs from the flagship of Scouting software, Troopmaster Software, Inc. 
 
TroopMaster offers significant advantages over similar software products: 
 

• TroopMaster was written specifically for Boy Scout Troops by professional software 
developers, one with over 25 years experience in Scouting, and his son, an Eagle Scout 
(1986). It “understands” how scout units operate and can track your scouts' progress to 
provide information that would be impossible on a simple database management system.  

 
• TroopMaster is intuitive and very easy to use. While it takes time to initially enter all of 

your unit data, maintaining the data from that point will be a breeze! 
 
• Most BSA rules for rank advancement are programmed into the system. For example, 

Eagle-required merit badges are monitored for you and advancement is not allowed until 
the minimum requirements are completed. Also, the Participation, Position of 
Responsibility, 2nd/1st Class Activity, and Service Project requirements are monitored 
for you and completion dates entered as soon as the respective requirements are 
complete. TroopMaster will automatically place each scout’s completed merit badges 
under the appropriate ranks for you. 

 
To get the most from your new software, we recommend the following:  
 

(1) Read this User’s Manual. It is especially important that you read Chapters 2, 3, 6, 7, 15, 
and Appendices B and F. We also recommend that you read all items that are highlighted 
using the following conventions: 

 
Information that is critical to utilizing TroopMaster is displayed as bold, red text within 
a shaded box. 

 
Information that requires special emphasis is displayed as black text within a shaded box. 

 
Helpful hints for getting the most out of your system are displayed in green text next to a 
light bulb icon. 

 
(2) Backup your data. Don't let a hardware failure force you to start over. See the “Making 

Backups” Chapter for recommended procedures.  
 
You are now ready to get started. If we have achieved our goal, you soon will be spending less time with 
paperwork and more time with the scouts who need you! Happy Scouting! 
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WHAT'S NEW IN THIS VERSION 
 
TroopMaster incorporates hundreds of user-suggested improvements! The following is a summary of the 
major improvements: 

 
• Latest Advancement Changes! The system is now up to date with all of the latest rank 

advancement changes for the 2008 year. 
 

• Data Security! All personal data is now encrypted, even when stored on your local hard drive. 
When you backup your data, email your data, or use the DotNet add-on to upload your data to 
your FTP site, the entire database is compressed and encrypted. No one can decompress or 
decrypt the data without valid Data Access and Data Encryption passwords that you specify. 

 
• Sensitive data items (e.g., SSNs, driver’s licenses, etc.) can now be hidden on reports, and you 

can block specific users from even being able to see selected data items. 
 
• DotNet users can now be limited to specific functional areas based on Data Access Password 

assignments. The same functional area can be assigned to more than one leader. 
 

• We’ve increased the maximum number of adults, MBCs, POCs, awards, activities, user-defined 
leadership positions, etc. 

 
• The Flag-a-Scout and Flag-Adults options have been replaced with a much more intuitive and 

flexible “Member Groups” feature. You can create as many groups as you like and give each a 
meaningful name (e.g., “Troop Committee”, “Summer Camp”). You can then select any of these 
groups when generating reports, sending email, crediting attendance, etc. 

 
• We’ve added BCC (blind carbon copy), attachment, and default signature options to the email 

function. 
 

• We’ve added support for direct SMPT emailing so you no longer need to rely on 3rd party 
programs such as Outlook or Windows Mail. 

 
• We’ve incorporated adults into the fundraisers and increased the maximum number of products. 

 
• You can now specify expiration dates for adult leader training courses and have those reflected 

on reports. 
 

• Medical information tracking has been expanded for scouts and adults. 
 

• TroopMaster now tracks and reports scout swimming levels for both scouts and adults. 
 

• You can now attach external documents to scouts and adults and then open those from 
TroopMaster. For example, you could scan health forms and attach those to your scouts/adults. 

 
• The Star, Life, and Eagle dialogs now show details on service hours remaining, days still needed 

for the position of responsibility requirement, etc. 
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• When you credit merit badges you can specify which counselor taught the badge. These details 

can be included on the Merit Badges Earned report and also as an optional attachment to the Unit 
Advancement Report/4403. (If you don’t need this option, you can turn it off through the 
Preferences dialog) 

 
• You can now update merit badge requirements as BSA changes them without affecting scouts 

who are working on the badge using an older set of requirements. 
 

• You can now track sub-requirements for the Venturing Gold, Quest, and Outdoor Bronze and 
Ranger awards. 

 
• TroopMaster now supports Sea Scout and Varsity awards, including Varsity Pins!  

 
• For you folks in the Midwest, we’ve added support for Mic-O-Say. 

 
• Support for LDS units has been expanded. For example, you can now group credit Duty to God 

requirements. Also, TroopMaster creates Member Groups (see above) for your troop, team, and 
crew and helps keep them current as scouts move up to the next levels. 

 
• We’ve added specific support for Unit Resource Survey data to the POCs area. 

 
• Archive files are now always included when backing up your data or emailing your database. If 

you are using DotNet, archive files are uploaded to the FTP site along with the active database. 
 

• All areas of the program including the reports now have a “Filtered Selection” option that you 
can use to control what’s included on the selection list or report. For example, when working 
with scouts, you could elect to include just 1st Class Scouts and below. 

 
• We’ve added group credit options for Venturing, Varsity, and Sea Scout awards. 

 
• Functionality has been enhanced on displays and reports for Venturing crews. 

 
• You can now define your own activity “levels” and the maximum number of activities and 

activity types has been increased. Activities now allow for starting and ending times. 
 

• Camps/hikes can now be designated as “backpacking” events. There is also a separate 
“backpacking” report, and backpacking can now be counted toward short-term camping for O/A 
eligibility regardless of camp length.  

 
• You can now define “minimum percentages” for scout attendance for any types of activities and 

have the Participation Summary report flag scouts whose attendance is low. 
 

• Activities have been integrated with the desk reference calendar using colors to differentiate 
activity types. An activity can be viewed or added by clicking on the desired date. 

 
• You can now generate permission slips or a tour permit directly from an activity dialog. 
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• Venturers who are 18 and older can now be included as drivers on tour permits. 
 

• Users can now save multiple export formats for repeated use of the same formats. 
 

• You can now optionally include formal names, middle initial, and suffix on member selection 
lists and reports. 

 
• We’ve added lots of new reports: Backpacking Summary, Rank Badge Summary, Rank Badge 

Matrix, World Conservation Award Application, Scout Swimming Levels, Scout Training List, 
Adult Training List, Adult Training Matrix, Unit Training Status, MBC Training Status, Varsity 
reports, Sea Scout reports, O/A Election Report, Mic-O-Say reports. We’ve also added tons of 
new options to the existing reports. 

 
• You can now generate “blue cards” (merit badge applications)! 

 
• The Unit Calendar now shows multi-day events. 

 
• TroopMaster will now compute the average time it takes for scouts in your unit to earn each of 

the ranks. These averages are included on the new Rank Badge Matrix report. 
 

• The “Awards Summary” portion of the Court of Honor report now optionally includes award 
order code numbers for your council office. 

 
• The Eagle Palm Assistance report is now a facsimile of the official BSA form. 

 
• The individual scout reports can now be emailed to multiple scout/parent email addresses. 

 
• You can now get separate camping totals for non-cabin camping. 

 
• Medical information can now optionally be included on permission slips, and the permission 

forms can be emailed to your scouts/parents. 
 

• Recharter selections are now saved for up to 60 days. This allows you to save your work and 
then come back later and pick up where you left off. 

 
• A “Months to Age 18” column has been added to the Target Eagle and Scouts Not Advancing 

reports. 
 

• You can now include all scouts on both the Target 1st Class and Target Eagle reports. This 
allows you to attach the two reports together to create an advancement wall chart. 

 
• Your selections for the Tour Permit Assistance report are now saved so that you can make 

changes later, if needed. Drivers’ cell phones can now optionally be included. 
 
• You can now print Merit Badge ‘blue cards’ applications directly from the system. 
 
• Our new AutoMailer now allows you to schedule email messages and reminders to be sent at a 

later date. 
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• You can now save your backup files directly to CD. 
 
• We’ve added full support for 2 separate email addresses per member. 
 
• Added support for full middle name to better support electronic rechartering and submission of 

your advancement records. 
 
• Much more! Little surprises abound! 
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CHAPTER 1. INSTALLATION 
 
1.0 Overview 
 

The program CD in your package contains the TroopMaster SETUP program. SETUP will 
create the necessary folders, install the software, and create an empty database. If you are 
upgrading, SETUP will convert the data from your previous version to the new database 
formats. SETUP will also install a PDF copy of the User’s Manual. 
 
You will need the following: 
 
(1) Windows 95/98/ME/2000/NT/XP/Vista or newer 
 
(2) A hard disk drive with at least 20 MB of available disk space. If you also need to install 

Adobe® Acrobat® Reader, up to 90 MB additional disk space may be needed. 
 
(3) A printer supported by Windows. 

 
1.1 Registering Your Software 
 

During the installation, SETUP will ask you for your unit number (i.e., your troop, crew, or 
team number), license key, and license expiration date. 
 
 If you purchased the software directly from Troopmaster Software, you are already 
registered. Your unit number, license key, and license expiration date are on a label inside the 
case that contains your program CD.  
 
If you purchased the software from your council office, you must register the software 
through TroopMaster Software to obtain a license key. You can install the software without 
this key but if you do, you can only run the program a maximum of 10 times. After that you 
must complete the registration process in order to continue using the program. Registration 
can be accomplished via the “Registration” form on our web site, by email, by phone, or by 
returning the Software Registration Card. If you email us, please include all of the 
information from the Software Registration Card, including the software serial number from 
the top of the card. Regardless of how you initially register, you must also return the 
Software Registration Card since that is your proof-of-purchase. Only one leader with your 
unit should register—we only track one point of contact per unit. 
 
If you don’t obtain your license key until after installing, start TroopMaster, click on the 
word “Unregistered” and enter your unit number, license key, and license expiration date in 
the pop-up registration dialog. If you try to run an unregistered program after the trial period 
has expired, you will be taken directly to the registration dialog. 

 
To reregister the software to a new leader, please call or email us with the name, mailing 
address, and email address of the new point of contact.  

 
Once activated, license information can be viewed through the Help>License Details dialog. 
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1.2 Installing TroopMaster 
 

SETUP will ask you to specify folders for your new software and database. We recommend 
using the default folders but you can modify those, if desired.  

 
We do not recommend using a removable media (e.g., usb drive) as the primary location for 
your database. Removable media are not nearly as reliable as a hard drive. 

 
If you are upgrading from an earlier version of TroopMaster and have existing data that 
needs to be converted to the New TroopMaster data formats, please read para 1.3 before 
proceeding.  

 
To install TroopMaster, insert the program CD into your CD-ROM drive. The installation 
menu program should launch automatically. If it does not, follow the steps below: 

 
(1) Click the Start button and then select “Run”. 
 
(2) Click the browse button and navigate to the SETUP.EXE file on the CD-ROM drive. 
 
(3) Click Open. 
 
(4) In the Run dialog box, click OK. 

 
Follow the instructions provided on the screen. When the installation is complete, remove the 
CD and store it in your CD case. 

 
The full Users Manual will be installed on your computer in PDF format. You must have 
Adobe Acrobat Reader 4.0 or newer installed on your computer in order to view the manual. 
In case you don’t have Acrobat Reader, SETUP will offer to install a copy. 

 
1.3 Upgrading from a Previous Version 
 

During the installation, SETUP will ask if you are a new user or upgrading. This information 
is necessary because if you are upgrading and your existing data is in a previous version 
format, it must be converted to the new TroopMaster database formats. SETUP will convert 
data from TroopMaster 2000 or newer.  
 
If two or more leaders with your unit were running the old version, only one of them should 
select the “upgrading” option during installation. The others should install as “new users” 
and then restore a backed up copy of the converted database created by the one leader who 
upgraded and converted the data from the old version. The only reason to select the 
“upgrading” option during program installation is if you have earlier version data to convert. 
 
Archived data is converted at the same time as the active unit data. If you have more than one 
archive and not all of them are on the same computer, please see the second note below. If 
after installing, another archive from the earlier version turns up, you can convert that 
separately using the “Data Conversion Program” option on the “TroopMaster” program 
group, which can be accessed through the Windows Start button. 
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If your troop has been using the distributed database feature, you must merge all of your 
satellites before installing TroopMaster and converting your data. NOTE: This feature is also 
being phased out of the program so that we can provide better support for our DotNet add-on 
and other new features being added to the system. 
 
If more than one leader has been deleting/archiving scouts and adults, you may have different 
archives located on different computers. This is especially likely if your unit was using the 
DotNet add-on because archive(s) were not part of the web database. The TroopMaster 
installation program will convert archive(s) as well as your active data but in order to be fully 
successful, all of the archives must be on the same computer where the conversion takes 
place. You should therefore consolidate all of your archive(s) on one computer before 
installing. This may involve retrieving scouts/adults from one archive and then re-archiving 
them to another archive. 
 
Please do not install this new version into the same folder you used for the previous version.  

 
Installation of TroopMaster will not delete or modify earlier TroopMaster versions. You 
should retain the earlier version for several months until you are certain that all of your 
previous data was converted properly. After that, you can safely uninstall the earlier version. 
However, we recommend that you retain backups of your previous data and archive files. 
Please remember that in earlier versions, your archive(s) had to be backed up separately. 

 
If your data is already in the New TroopMaster format (i.e., you converted the data during a 
previous TroopMaster installation or one of the other leaders with your unit converted the 
data), you should install as a “new user” and then restore the New TroopMaster data through 
the “File>Restore Database” menu option. 

 
1.4 Starting TroopMaster 
 

Either double-click the desktop icon or click the Start button, select “Programs,” highlight 
the TroopMaster folder, and click the TroopMaster icon. If you are the administrator you can 
define data access passwords by going to File>Database Management Passwords. An 
administrator password can be created by replacing the word ‘admin’ with your own 
password. If you are not the administrator you may be prompted for your data access 
password when you restore data files or while downloading from DotNet. 

 
Please read para 3.15 regarding the definition/use of Database Access Passwords. 

 
1.5 Reinstalling TroopMaster 
 

If you previously installed TroopMaster and need to reinstall it or if you want to install it on a 
second computer, you’ll need a backup of the unit database. This can be obtained using the 
File>Backup Database option.  
 
Run the installation as described above and select the “New User” option. When the 
installation is complete, start TroopMaster, enter your Data Access Password, and select the 
File>Restore Database option. 
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1.6 Updating/Upgrading TroopMaster 
 

We will periodically update the software with both bug fixes and enhancements and when we 
do, we will produce a program update patch (e.g., V4.01, V4.02, etc.). The free program 
update patch will be posted at the bottom of the TroopMaster product page on our web site. 
To see if you need an update, select the Help>About option to see which version of the 
software you are currently running. Then, click the “Check for newer version” hyperlink at 
the bottom of the dialog, which will take you directly to the latest patch on our web site. 
Compare the version you have to the version of the patch. If your version is older, please 
download and install the update patch. For guidance on downloading and installing a patch, 
please see the FAQ’s page on our web site. 
 
When you click on the patch, we recommend that you select your browser’s “Run” or 
“Open” option instead of downloading the patch to your hard drive. If you do download the 
patch, please do not save it into the main program folder because you might inadvertently 
overwrite the TroopMaster program.  

 
 Major new versions (e.g., V5.00) of TroopMaster are also free as long as your software 

license remains current. When a major new version is released, you will be provided a link 
from which you can download a free copy of the new version. If you would also like to 
receive the new version on CD, you can get that for only $5 plus shipping/handling. 

 
1.7 Moving TroopMaster to Another Computer 
 

If you purchase a new computer or if you turn over your responsibilities to a new leader, you 
should first install TroopMaster and the most recent update patch (para 1.6) on the other 
computer. Then, transfer the database through the File>Backup Database and File>Restore 
Database menu options. 
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CHAPTER 2. USING TROOPMASTER  
 
2.0 Overview 
 

This Chapter covers the “basics” you need to operate your new unit management system. 
TroopMaster is intuitive and very easy to use. However, reading this Chapter first will save 
you time. 

 
2.1 Main Menu 
 

There are ten main options on the Main Menu: File, Activities, Adults, Advancement, 
Fundraisers, Mic-O-Say, O/A, Reports, Scouts, and Unit. There is a separate Chapter in this 
Users Manual corresponding to each of these menu options. Within each Chapter, there is a 
subsection for each option on the associated pull-down menu. 

 
2.2 Tool Bar 
 

A tool bar is available to provide faster access to the most frequently used features in 
TroopMaster. The following list identifies each of the tool bar buttons from left to right along 
with the equivalent menu path. 

 
Button      Icon Description    Menu Equivalent

 
   Backup     Diskettes with letter “B”  File>Backup Database 
 
   Restore     Diskettes with letter “R”  File>Restore Database 
 
   Notepad     Notepad and pencil   File>Notepad 
 
   Email      Envelope and Earth   File>Send Email Message 
 
   Calendar     Desk calendar     Activities>Activity Calendar 
 
   Adult Management  Man’s face      Adults>Adult Management 
 
   MBC Management  Citizenship in Nation MB  Adults>MBC Management 
 
   POC Management   Rolodex      Adults>POC Management 
 
   Activity Management  Camping tent     Activities>Activity Management 
 
   Fundraisers    Fleur-de-lis w/dollar signs Funraisers>Sales & Payments 
 
   Advancement    Yellow Fleur-de-lis   Advancement>Individual Scout 
 
   Scout Management  Boy’s face      Scouts>Scout Management 
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2.3 Backups 
 

Backing up your unit database is extremely important because this data represents a major 
investment of your time. Don't let a hard drive failure force you to reenter everything from 
scratch. Please see Chapter 14 for recommended procedures.  

 
The File>Backup Database option in conjunction with the File>Restore Database option 
can be used to transfer the unit data and archive files from one computer to another. 
However, all of the unit’s data on the target machine will be overwritten by the data 
restore option.  

 
2.4 System Date 
 

TroopMaster gets the date from your system clock and uses it extensively throughout the 
program. The date is especially important to the automatic crediting functions. Please ensure 
your system date is correct before starting TroopMaster. 

 
2.5 Data Entry Dialogs 
 

The cursor can be positioned to or within any data entry field with your mouse. Press TAB to 
move to the next data entry field or Shift-TAB to move to the previous field. Pressing 
ENTER activates the highlighted button. 

 
Please do not make data entries with Caps Lock on. Doing so makes it very difficult for 
TroopMaster to fit your entries on displays and reports. Even worse, it can cause ScoutNET 
processing of your council reports to fail. 

 
To facilitate collecting data on your scouts and adult leaders, several data collection forms 
are available. There are personal data collection forms for your scouts, adults, merit badge 
counselors, and points of contact as well as an advancement data collection form for your 
scouts. Copies of these can be printed through the Reports>Forms option. 

 
The File>Preferences option has fields for you to enter the city, state, zip code, and area 
code common to most of your scouts and adults. Your entries here will be used as the 
defaults whenever you add a new scout or adult to the database. 

 
Most items on the various data entry dialogs are self-explanatory. For others, holding the 
mouse pointer over the field label will display an expanded description. 

 
 
 
 
 
 
 

 20



2.6 Dates 
 

Dates can be entered in a variety of formats using slashes, dashes, or periods as separators or 
by typing a six-digit date with no separators. The following entries are equivalent: 09/06/08, 
9/6/08, 9.6.08, 9-6-08 and 090608. If you omit the year (e.g., 9/6), TroopMaster will 
automatically append the current year. You don’t need to enter 4-digit years. TroopMaster 
internally appends the century based on context logic. Context logic is applied even if you do 
enter a 4-digit year (e.g., if you enter a rank requirement completion date of 4/4/1908, it will 
be saved as 4/4/2008, since “1908” in that context is an obvious error). 
 
In addition, some date fields (mostly in the advancement area) allow special entries. This is 
done by typing a single character in the first position of the date field: 

 
a. Complete. Enter a C. Available only in the O/A and scout advancement areas, this is used 

to show completion of a requirement when no specific date is available. 
 
b. N/A. Enter an N. Available only in the scout advancement area, this is used to mark a 

new requirement that BSA added after the scout completed that rank. 
 
c. Old Rules. Enter an O. Available only in the scout advancement area, this option can be 

entered for any item under 1st Class and below. If a scout completed a rank under the old 
Skill Awards (pre-1989), use this option to mark completion of the newer requirements. 

 
d. Same Date. Enter an L or S. TroopMaster will repeat the last date entered. 
 
e. Today's Date. Enter a T. This option is available in all date fields. 
 
f. Transfer. Enter an X. Available only in the O/A and scout advancement areas, this option 

is used to show that a scout completed a requirement with his previous unit and you don’t 
know the exact date. 

 
Actual dates (MM/DD/YY) are required for awards, merit badges, and Boards of Review. 

 
TroopMaster no longer has a “Waived” option because BSA no longer allows some of the 
swimming requirements to be waived. Instead, they now offer alternate requirements. 

 
There is also a pop-up menu to assist you in date entry. Simply right-click the date field and 
you can then choose to copy/paste a date, select today’s date, repeat the same date you 
previously entered, or select a specific date from a pop-up calendar. 

 
You can increase (decrease) and existing date by one day by positioning the cursor in that 
field and pressing the plus (minus) key. 

 
2.7 Modifying Date Entries 
 

To change the completion date on an award, merit badge, or training course that has been 
added to a list box, double-click the entry and enter the new date in the pop-up window. 

 

 21



2.8 Saving Changes 
 

Clicking the OK button always saves data entries. Click Cancel to exit a data entry dialog 
without saving your changes. 

 
 
2.9 List Box Selection 
 

a. Single Selection. In addition to highlighting the desired item and clicking OK or Select, 
single-selection list boxes allow you to simply double-click the item. Double-clicking 
will immediately execute the request unless additional information is needed.  

 
b. Multiple Selection. Some (but not all) list boxes allow you to make multiple selections. 

For example, when crediting group advancement, you can select multiple names from the 
list of scouts. To select more than one item from a list box, hold the CTRL key down 
while you click the desired items with the mouse. To select a contiguous group of items, 
click on the first item desired; then, hold the SHIFT key down and click the last desired 
item in the group.  

 
You can distinguish multiple selection list boxes by the field label. For example, if more than 
one activity type can be selected, the label will say, “Select type(s)”. 

 
One way to move quickly to the desired point in a long list of entries is to move the focus to 
the list box and then start typing the name of the desired item. For example, type WH while 
the focus is on a list of merit badges to move directly to “Whitewater”. 

 
2.10 Quick Access Buttons 
 

Numerous dialogs include quick access buttons that enable you to move quickly to related 
dialogs. For example, when on an adult’s personal data dialog, quick access buttons let you 
to jump to the adult’s awards, training, leadership, or O/A dialogs. 

 
2.11 Family Links 
 

All of the scout and adult personal data dialogs have “link” options that let you link family 
members together. Once this is done, all common data items between the records will be 
updated whenever any record is updated. Because it is very important that you understand 
how these work, we strongly recommend that you read Chapter 15. 
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2.12 Filtered Selection 
    

We recognize that your database may be large and that the standard options on reports and 
selection lists may not sufficiently limit the members who are included. To give you more 
control, TroopMaster provides “Filtered Selection” options on many displays and reports. 
For example, on the Scout Management dialog, the “Display” drop-down box lets you 
control which scouts are displayed on the selection list. In addition to being able to limit the 
selection list to a specific patrol, you can also choose the “Filtered Selection” option. 
Choosing this option displays a dialog that provides very flexible selection criteria. For 
example, using this dialog, you could limit the display list to, say, specific rank(s) or 
leadership position(s). You can select any combination of the available filter options. 
 
There are filtered selection dialogs available for scouts, adult leaders, merit badges 
counselors (MBCs), and points of contact (POCs). A specific description of each of these 
dialogs follows. 
 
a.  Adults. The filter dialog allows you to select one or more leadership positions. 

Checkboxes allow you to limit the report to leaders, non-leaders, or just O/A members. 
Click the Select Member Groups button to select one or more groups created through 
the Unit>Group Members option (para 4.4). You can even use the filter to search for 
specific text within the “Remarks” fields on your adult leaders’ personal data dialogs.  

 
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
b.  Scouts. The filter dialog allows filter based on specific rank(s) or patrol(s) and/or via an 

“O/A Members” checkbox.  
 

Click the Select Member Groups button to select one or more groups created through 
the Unit>Group Members option (para 4.4). You can even use the filter to search for 
specific text within the “Remarks” fields on your scouts’ personal data dialogs.  
 
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
c.  Merit Badge Counselors. The filter dialog provides a range of options, including limiting 

the list to counselors who teach a specific badge. Checkbox options allow you to limit the 
list to “active” or “inactive” counselors. The “Zip Code” field enables you to look for 
counselors within a full or partial zip code. For example, an entry of “229” would retrieve 
counselors in zip codes 22901 through 22999.  
 
The “Certification” block lets you retrieve counselors whose “Recertification” date falls 
within a specific from-to period. Entering a “From” date without a “To” retrieves all 
counselors certified on or since that date, while entering a “To” date without a “From” 
retrieves all counselors last certified on or earlier than that date. You can optionally 
include counselors who have no certification date.  

 
You could use the certification “To” option when generating personal data reports, mailing 
labels, envelopes, or email messages for counselors who need to be recertified. 
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Click the Select Member Groups button to select one or more groups created through 
the Unit>Group Members option (para 4.4). You can even use the filter to search for 
specific text within the “Remarks” fields on your counselors’ personal data dialogs.  

    
Click Reset Filter to clear all of your selections. Uncheck the “Activate Filter” checkbox 
to turn the filter off. 

 
d.  Points of Contact. If you have defined categories (para 8.3b) and assigned POCs to them, 

you can select one or more categories. The “Skills/Interests” block lets you retrieve POCs 
who match any or all of the specified entries. Click the Select Member Groups button to 
select one or more groups created through the Unit>Group Members option (para 4.4). 
You can even use the filter to search for specific text within the “Remarks” fields on your 
POCs’ personal data dialogs. Click Reset Filter to clear all of your selections. Uncheck 
the “Activate Filter” checkbox to turn the filter off. 

 
2.13 Data Entry Guidelines Regarding ScoutNET  
 

TroopMaster produces advancement, recharter, and additional enrollment reports in a format 
compatible with your council’s ScoutNET computer system. However, there are several steps 
that you can take that will reduce errors during automated processing of these reports: 
 
1) Don't enter data with Caps Lock on, particularly when entering names. ScoutNET expects 
the first letter to be capitalized and the remainder to be lower case. Obviously, names like 
“Van Dam” are exceptions. 
 
2) Don't punctuate any information, especially addresses and abbreviations. For example, 
instead of St. enter St; instead of Apt #22-B enter Apt 22B; etc. 
 
3) If a person has a name prefix (e.g., “Dr”), don't enter that in the first name field--just enter 
the first name. TroopMaster only tracks prefixes for Points of Contact. Also, TroopMaster 
has separate fields for “First Name” versus “Nickname”. Enter the formal first name in the 
“First Name” field. Enter a suffix (e.g., “Jr”) in the “Suffix” field, not the last name field 
 
4) Don’t enter driver’s license number and expiration date in the driver’s license number 
field because the expiration date will cause ScoutNET processing of your report to fail. 
 
We recommend adding the name, phone, and/or email address of a point of contact to your 
ScoutNET reports so the registrar will know whom to contact if there’s a question/problem. 
 
On data entry dialogs, ScoutNET-required data items are marked with green field labels. 

 
2.14 Data Protection and Privacy 
 

TroopMaster provides several features to help protect your data from unauthorized people. 
For example, personal data is always encrypted when saved to your hard drive. This helps 
prevent someone who is not authorized to use the program or not authorized to view certain 
data items from viewing personal data with some other software program outside of 
TroopMaster.  
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In addition, whenever you use TroopMaster to backup your data (para 3.1), email your data 
(para 3.4), or upload your data to an FTP site via the DotNet add-on (para 3.16), the data is 
compressed into small backup files, which are then encrypted. If you do not create a Data 
Encryption Password, then the data is encrypted using a default, internal password. However, 
anyone with a current copy of TroopMaster can decrypt and decompress any of these files. 
Because of that, we strongly encourage you to create a Data Encryption Password (para 
3.16b). Once you have created a password, no one can decrypt or decompress your backup 
files without having this password.  
 
Regardless of whether or not you create a Data Encryption Password, neither the 
File>Restore Data menu option nor the DotNet add-on feature will work unless the user has 
a valid Data Access Password (para 3.15). 
 
TroopMaster also provides a method (para 3.15) for you to hide certain sensitive data items 
(such as social security numbers and dates of birth) from certain users. For each Data Access 
Password, you can specify which sensitive data items, if any, that you want leaders with that 
password to be able to access. Any items not checked will be hidden from those leaders on 
displays and reports. Of course, the database administrator always has access to all of the 
data items. 
 
We also recognize that you may want to generate “sanitized” reports that, for example, can 
be posted on your unit’s web site. To accommodate that, TroopMaster provides a method 
(para 3.17e) for hiding sensitive data items when generating reports. Any items you select 
can still appear on displays but not on reports. 

 
If you want to set up a single computer (e.g., at the scout hut) and allow different people to 
log on with different levels of access (para 3.15), install the program and database and then 
check the “Prompt for Data Access Password on startup” checkbox (para 3.17) on the 
File>Preferences dialog.  
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CHAPTER 3. FILE 
 
3.0 Overview 
 

This menu provides a group of miscellaneous utilities. It includes such things as file 
backup/restore, data import/export, database management, and archive access. 

 
3.1 Backup Database 
 

This option allows you to backup your active data and archived files. You can backup to a 
diskette, to a zip cartridge, to a CD, or to another directory on your hard drive. Either enter a 
destination path or use the Browse button to select a backup location. All of your active unit 
data and archive(s) will be included in the backup. 

 
TroopMaster will compress your data and archive into much smaller backup (*.bak) files. 
Please do not rename these files. Optionally, it will attempt to do the same with your 
scout/adult photos. However, photos do not compress as well as data so they require a lot 
more space. If your photos backup will not fit on a floppy diskette, you will either need to 
use a larger medium, such as a zip cartridge, or turn the photos option off. 
 

 
3.2 Open Archive Files 
 

To review your archive or to print a report on a scout or adult who has been archived, select 
this option. Since it’s possible to have more than one archive, TroopMaster will ask you to 
select the desired archive. The default choice will be the archive you most recently accessed. 
TroopMaster will then load the selected archive and change the window title to remind you 
that you are in the archive. Options not available in the archive (e.g., File>Activities) are 
deactivated. See Chapter 13 for more information on using the archive. 
 
The menu option name will change to “Open Active Unit Data.” When you have finished 
reviewing your archive, select this option to switch back to your active data files. 

 
3.3 Restore Database 
 

This option enables you to restore your database from a backup made through the 
File>Backup Database menu option (para 3.1). The file names will be “TM4Data.bak”, 
“TM4Archive.bak”, “TM4DataPhoto.bak”, etc. All of your active data and archive(s) will be 
restored. Check “Restore files” to restore any user-defined files, such as member groups, 
recipient groups, custom report definitions (such as general purpose worksheets you’ve 
saved), etc. If you want to delete existing user-defined files before restoring the ones in the 
backup, check the appropriate box. 
 
You cannot restore data from a database backup without a valid Data Access Password. In 
addition, if an encryption password was in effect when the backup was created, you must 
also have that. Please see para 3.15 for more information on the use of passwords. 
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Enter the path to your backup or browse to the desired folder and then click OK. To help 
ensure that you are restoring from the correct backup set, TroopMaster will display the date 
on which the selected backup was created. 
 
“Restoring” data is a critical operation. If the backup files are damaged, that damage 
will be transferred to the files on your hard drive, making some or all of those unusable. 
Before restoring a database backup, you should backup your existing database to a 
different diskette or hard drive folder. This will allow you to recover if the restored 
data is damaged. 

 
3.4 Email Database 
 

If more than one unit leader is using the software, you will need to periodically provide 
database updates to the other leaders. This option makes it easy to email the database so that 
you don’t need to hand deliver it. Simply select the desired recipient(s) and click Send. 
 
TroopMaster will compress your database into much smaller backup files, attach those to the 
message, and send your message. The recipient will need to save the message attachments to 
a hard drive folder, and then restore the backed up files via the File>Restore Database menu 
option (see above). Please see para 3.5 for more information on sending email messages. 

 
3.5 Send Email Message 
 

There are several ways to initiate email from within TroopMaster. For example, you can 
select this menu option, click the email tool bar button, or click the email button with any 
report displayed.  

 
You can also send an email message to an individual recipient by clicking the “Email” button 
next to the member’s email address on his personal data dialog. 
 
If you plan to send carbon copies, you should first select the carbon copy (“CC”) or blind 
carbon copy (BCC) option, as desired. Before using BCC, you should ensure that the email 
program you are using has that feature. 
  
Next, select the desired recipient(s) for your message. First, click the “Display” drop-down 
list to choose the desired group (i.e., scouts, adults, parents, etc.) From each group, highlight 
the recipient names and then click To or CC/BCC to add the selected names to the primary 
addressee (i.e., “To”) list or the CC/BCC list. You can select names from as many of the 
different groups as you like. If you need to email someone who is not in the database, enter 
that email address in the “Other” field. To remove a recipient that was added in error, 
highlight the name and click Remove. If you want TroopMaster to review all of your 
recipients and remove duplicate addresses (for example, a husband and wife with the same 
address), check the associated checkbox. 
 
Enter the subject of your message in the field provided. TroopMaster provides a limited 
“Body” field where you can enter text for your message. However, your email system 
provides a much larger text field as well as extensive editing and formatting options. To take 
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advantage of those features, click the “Display message prior to sending” checkbox. Then, 
when you click Send, TroopMaster will activate your email system, which will display your 
new message. This gives you a chance to refine your message before it is transmitted. 
 
To attach one or more files to your message, click the Attach Files button and browse to the 
desired file(s). 

 
Clicking the Email Options button on this dialog will display a dialog with several options 
from which to choose. Email from the program can be sent using either direct SMTP or 
through a MAPI compliant email system that uses the SMTP protocol. If you would like to 
use the direct SMTP (recommended), you should contact your internet service provider (e.g., 
AOL, Earthlink, etc.) for the correct settings to their mail server. If you’re not sure if your 
email program is MAPI compliant, or if you do not know your SMTP settings, contact your 
internet service provider. 
 
When sending an email using MAPI (send through 3rd party software, e.g., Windows Mail, 
Outlook, etc.) TroopMaster uses the mail system that is currently set up as the Windows 
default. This setting cannot be changed from within TroopMaster but can generally be set in 
your individual email program (through the Tools>Options menu). You can also select the 
default mail system using Internet Explorer and viewing the Tools>Internet 
Options>Programs tab. 

 
Some email programs have a security feature that warns you if another program (such as 
TroopMaster) adds a message to your “Outbox”. You may get this warning if you did not 
check the “Display message prior to sending” checkbox. Some of these email programs will 
allow you to turn these warnings off. 
 
The Display Messages Prior to Sending option is only active if using the MAPI interface. 
When sending messages through direct SMTP, TroopMaster acts as the email editor for your 
messages. 
 
a. Save Recipient Group. Often, there is a specific group of people to whom you send 

messages on a regular basis. This option makes it easy to create as many different groups 
as you need. To save a selected group of recipients for use again later, add all of the 
desired names to the “To” and “CC/BCC” lists, and then click the Save Recipient Group 
button. Next, enter a unique group name and click OK. Recipient groups that you have 
defined are available through the “Display” drop-down list. To modify a recipient group, 
select it, make the needed modifications, and then re-save it. To delete a recipient group, 
select it from the drop-down list and click the Delete Recipient Group button. 

 
 
 
 
 
 
b. Email Options. Click this button to adjust your email setup options.  
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a. Direct SMTP – Use this option to send email from TroopMaster directly through your 
internet provider’s mail server.. You will need to obtain the SMPT Server, User 
Name, Password, and Return address information from your internet service 
provider. If User Name and Password are required by your provider, these fields 
must also be entered. 

 
b. MAPI (send through 3rd party software, e.g., Windows Mail, Outlook, etc.) 

 
(1) Build Message Using – If your email system cannot handle names and email 
addresses, select the “Email address only” option. 

 
(2) Retain Email Session – If the first message you send after starting 
TroopMaster works but subsequent messages fail, checking this box usually 
corrects the problem. 

 
(3) Omit ‘SMTP” – TroopMaster usually prefixes each email address with 
“SMTP:” although this is generally hidden from the user. If you can see this 
prefix and it’s causing error messages within your email system, checking this 
box will correct the problem.  

 
(4) Default Signature. If you want TroopMaster to add a default signature to your 
email messages, check this box and enter the desired signature block. 

 
3.6 Schedule Email Messages 
 
   Use this feature to schedule messages to be sent at a later date using our new AutoMailer. 
 

a. Add. Click ‘Add’ to schedule a new email. On this dialog you will be able to select the 
recipients for your message as well as to specify the subject and compose the body text of 
your message. (See para 3.5). You will also specify the date/time that you wish your 
message(s) to be sent.  

 
b. Edit. To edit an existing scheduled email select the message you want to edit then click 

the ‘Edit’ button 
 

c. Delete. To delete an existing scheduled email, select the message you want to delete then 
click the ‘Delete’ button. 

 
Use of the email scheduling feature requires the direct SMTP option. You may enter the 
SMTP settings for your mail server by clicking the Email Options button. If you do not know 
the correct settings for your mail server, please contact your internet service provider. 

 
Scheduled messages are sent by a separate program (TSI-Automailer). The default settings 
will load this program automatically when you start your computer. If the Automailer 
program is not running, any scheduled messages will  not be sent for you. You can start the 
Automailer manually by clicking Start>All Programs>TroopMaster>AutoMailer. 
You can open the AutoMailer program and view any scheduled messages waiting to be sent 
by clicking the TSI-Automailer icon in your Windows System Tray. Although your 
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scheduled message may only be created/edited in the TroopMaster program, you can view 
the date, time and other details for each message that you currently have scheduled. Sent 
messages are automatically removed from the list. If there were any problems sending a 
particular message, it will be flagged with an asterisk. You can click the View Log button to 
see more information on sent/failed messages.  

 
3.7 Export 
 

There are two main export options. 
 
a. ASCII Delimited. Many people like to design custom reports or to use unit data for other 

purposes. For example, having access to the scouts' names and addresses could allow you 
to create mail/merge documents with your word processor. 

 
To facilitate that, TroopMaster allows you to export data from virtually any area of the 
database. The data is written to delimited ASCII files using any delimiter you choose. 
Most of the time you will want to import the data into a database management system or 
spreadsheet so that you can manipulate the data, design reports, etc. 

 
The default delimiter is a comma but you can change that to any character desired. To 
create TAB delimited files, enter T. If you would like to have the names of the data items 
you select to appear in the first line of the export file, check the associated checkbox. If 
you will be exporting dates, select the desired format.  

 
Then, select the area (e.g., scout data, adult data, activities, etc.) of the database from 
which to export data. TroopMaster will display a list of data items from that area in the 
“Available Fields” list box. You can then select the specific data items you want and add 
them to the “Fields to Export” list box. To do that, highlight the desired fields and click 
Add. If you want all of the data items, click Add All. To remove an item that was added 
in error, highlight the item and click Remove.  

 
If you are exporting merit badge counselor data for import into our MBCounselors program, 
there is a button at the bottom of the dialog that will set the correct export format for you. 

 
If you use a comma as the delimiter, check the “Include field names” option, and save the 
export file with a “CSV” extension, you’ll be able to open the export file directly in Excel 
and your field names will be column headers 
 

When you have finished selecting all of the desired data items, review the order of the 
items in the “Fields to Export” list. This is the sequence order in which these fields will 
appear in the export file. If you need to change the sequence, highlight the field that 
needs to be relocated and click the Move Up or Move Down button. 

 
 
 
(1) Filtering Activities. If you are exporting activity data, you can optionally limit the 

export file to a specific activity type. If you want all activity types, select that option 
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from the drop-down list. If you only want activities that fall within a desired time 
period, enter the desired “Start-End” dates. 

 
(2) Filtering Scouts/Adults/MBCs/POCs. If you are exporting member data and you wish 

to limit the export to specific group of members, use the “Members” dropdown list to 
selected the desired group or choose “Filtered Selection” to limit qualifying members. 

 
If you think you may want to use this same export file format again, click the Save 
button, assign a name to the current export format, and click OK. Then, the next time you 
need to use this format, you’ll be able to select it from the dropdown list. To delete a 
format that you no longer need, select it from the list and click Delete. 
 
You are now ready to create the export file. If you wish to view and/or print a copy of the 
file format, click the View Export File button. When finished, click the Export button. 
TroopMaster will display a Save As dialog that allows you name the file and select the 
target folder. 

 
b. Automated District Management System (ADMS). These options let you transfer data on 

your unit to your district leader if he is using the ADMS program from Troopmaster 
Software, Inc. There are two export options. 

 
(1) Unit Information. This allows you to provide routine updates on your unit to the 

district leader. The export file includes basic personal data on your scouts and adult 
leaders as well as advancement summary data for each scout and training/awards data 
on adult leaders. It also shows camping history (i.e., campout dates) for the current 
year. Optionally, you can choose to export all adults, just those with leadership 
positions, or just the adults you last chartered. If your official unit number differs 
from the one in the software, please change that before creating the export file. 

 
(2)  MB Counselors. This option provides a one-time transfer of data on your MBCs to 

your district leader for import into his ADMS program. The export files will add your 
counselors to the ADMS database; it will not update data on counselors already in the 
ADMS database. 

 
c.  SOAR. Use this feature to create an export file for units hosting websites on S.O.A.R. 

This new feature can automatically create the necessary export file to repopulate your 
membership and specific advancement information on a SOAR website. If you would 
like more information on SOAR or their products, please visit their website at: 
http://www.soarol.com/ 
 

 
Export files are not encrypted. If the file contains personal data, you should protect it 
carefully. The ADMS export files always contain sensitive personal data. 

 
3.8 Import 
 

TroopMaster will import data from any of our other software packages. You can also import 
from an ASCII delimited file or a ScoutNET export file. 
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a. ASCII Delimited. This option enables you to import data that you were maintaining on 
some other database system so that you don’t have to reenter it. You must first export the 
data to an ASCII delimited text file. You can use any delimiter you like.  

 
We recommend that you first create an import format structure in TroopMaster and then 
use that format when creating the export file from your other program. First, select the 
type of data you plan to import from the “Select area” drop-down list. Then, highlight the 
desired data items and click Add. If you add a field by mistake, highlight it and click 
remove. If necessary, adjust the data item sequence by highlighting the item to be moved 
and click the Move Up or Move Down button. When finished, click the View Import 
Format button and print a copy of the file format. Use this along with the delimiter you 
selected to create your import file. 
 
When you have the file, return to this dialog, recreate the same import structure, and click 
Continue. Lastly, browse to the import file and click Open to begin the import process. 

 
If you are importing personal data on scouts, adults, merit badge counselors, or POCs, 
the members being imported will be added as new members to the database. If you are 
importing other data on scouts and adults (e.g., merit badges, special awards, training, 
etc.), then for each member in the import file, TroopMaster will look for a name match 
in the existing database; if it finds one, it will add the new data to that person’s records. 
 
If you import advancement data, then when you exit this dialog, TroopMaster will validate 
the Boards of Review for each scout. Any Boards of Review that are invalid, based on 
completion dates of merit badges and other requirements, will be removed. TroopMaster will 
display a list of any problems it found. 

 
b. Counselors. TroopMaster can import counselors from the Automated District 

Management System (ADMS) or from MBCounselors.  
 

(1) ADMS. You can import counselor data from a transfer file created through the 
ADMS MBCs>Transfer Counselor Files menu option. The name of the file will 
be “ADMS_MBC Transfer.bak.” Normally, counselors in the file will replace any 
counselors who are currently in your database. If you want to add the imported 
counselors to your existing database, uncheck the “Delete existing Counselors” 
checkbox. The import process cannot be used to update data on existing 
counselors. By default, the import process will only import counselors who are 
associated with your troop but if you also want to import counselors who are 
willing to teach outside of their associated troops, check that box. 

 
(2) MBCounselors. This option lets you import merit badge counselors from an 

export file created by a district leader who is using Troopmaster Software’s 
“MBCounselors” program. The district leader must have created the file through 
the MBCounselors File>Export feature. Also, he must have selected the “Export 
badges by number” option. If you want to replace the counselors you currently 
have in the database with the ones in the export file, check the “Delete all existing 
counselors before importing” checkbox. Otherwise, the new counselors will be 
added to the ones already in your database. 
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c. Cub Scouts from PackMaster. This option lets you import scouts who are graduating 

from a Cub Scout pack that is using the PackMaster program from Troopmaster 
Software, Inc. The pack representative should give you a transfer diskette containing the 
graduating scouts and, optionally, adults. The import feature will add the new scouts and 
adults to your troop and transfer their personal data. If earned, Arrow of Light will be 
added to each scout's special awards file. 

 
You cannot import from a backup of the PackMaster database. The pack leader must use the 
PackMaster Graduate to Boy Scouts option. The file name will be “graduate06.txt”. 

 
This same feature is accessible through the Scouts>Receive Cub Scouts option. 
 
d. ScoutNET. TroopMaster can import scout and adult data from an export file created by 

your local council using the BSA ScoutNET computer system. Council personnel 
procedures are as follows: 

 
To generate the unit roster files:  

 
1) Enter ScoutNET and click on PROGRAM  
2) Double-click on UNIT  
3) Select which unit you are generating files for and click EXPORT  
4) Go to the Print Repository in ScoutNET and find the file. Click on it.  
5) When BSAPrint is displayed, click Open, then Save.  
6) Change the "Save as type" to "Text File". Save the file to a location that you can 

find later  
  
To generate the advancement history file:  
 

1) Enter ScoutNET and click on PROGRAM  
2) Double-click on Membership Reports  
3) Select Unit Advancement Detail Report  
4) Select which unit you are generating files for and run the report  
5) Go to the Print Repository in ScoutNET and find the file. Click on it.  
6) When BSAPrint is displayed, click Open, then Save.  
7) Change the “Save as type” to “Text File”.  Save the file to a location that you can 

find later.  
 
If that's done correctly, the name of the personal data should be "LODxxxxx.CSV”, 
where xxxxx denotes your unit type and number (the advancement file will be named 
manually by the council). The File>Import from ScoutNET menu option will import 
from that, which will save you from having to start with an empty database. 

 
This procedure will add the scouts/adults in the export file to your database. You cannot 
use this to update existing scouts and adults. As of this writing, only a limited amount of 
personal data is imported. The ScoutNET file does not contain advancement data. 
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e. TroopLedger. This option is provided in case your unit started with Troopmaster 

Software’s “TroopLedger” program and you want to transfer the data on scouts/adults 
from that program. This is a one-time operation. The data to be imported is created 
through the TroopLedger File>Transfer option. 

 
Any scouts or adult members you may have already entered will be overwritten by the 
TroopLedger import. 
 
If your unit uses both programs, TroopMaster is considered the “master” database. 
Accordingly, new scouts/adults and updated personal data are normally imported into 
TroopLedger from TroopMaster.  
 

3.9 Transfer Data to TM-Traveler 
 

If you’ve purchased TroopMaster Traveler (our Palm or Pocket PC add-on program), this 
dialog lets you transfer data between the two databases. There are two options for doing this. 
You will normally use the Sync button, which syncs the TroopMaster and TM-Traveler 
databases. To replace the TM-Traveler database, click the Download button. A third option 
allows you to erase the handheld database, if necessary. 
 
a. Sync. Clicking this button will copy your current TroopMaster data to the TM-Traveler 

interface file on your hard drive. When prompted, sync your handheld computer with your 
PC. When that’s complete, click the Click Here When HotSync Is Complete button and 
TroopMaster will upload new data entries from the handheld and then do the following: 

 
1)  Place newly credited merit badges under the appropriate rank(s) for each scout. 
 
2)  Validate any new Boards of Review that have been credited. 
 
3)  Perform automatic crediting of rank requirements based on newly entered activity 

attendance, service project hours, etc. 
 

When that is complete, TroopMaster will offer to download these changes to the TM-
Traveler interface file so that you can sync them back to your handheld. 

 
If you are using a Palm, then when you click the “Sync” button in TroopMaster, it changes 
the settings in your HotSync Manager. In order for those changes to take effect, TroopMaster 
must close your sync manager and restart it. This could take up to 30 seconds. It does this 
again when you are finished syncing. 
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If, since the last sync, you changed the same area for the same member or the same 
activity both on the handheld and in the main TroopMaster program, the data from the 
handheld will overwrite the change that you made in the main program. In this regard, 
the following is a list of the separate areas within each data group: 
 
 - Activities: activity data, scout attendance, adult attendance 
 - Adults: personal data, training, special awards 
 - Scouts: personal data (includes patrol assignment, leadership position(s), and  
         swimming level), parental data, special awards, Boy Scout ranks, Varsity awards, 
     Venturing awards, Sea Scout awards, merit badges, partial merit badges 
 - MBCs – All member data (i.e., no separate areas) 
 
For example, if you credit a scout with a merit badge on the handheld and credit him 
with “Scout Spirit” in the main program, there’s no conflict because those are separate 
areas of his data. On the other hand, if you updated an adult’s phone number on the 
handheld and updated his address in the main program, the address change will be lost.  

 
When you run a sync operation on your handheld computer, you are not transferring 
data directly to/from the TroopMaster database. Instead, you are transferring data 
to/from an intermediate database file. It is extremely important that you understand 
this. Before running a sync operation on your handheld computer, always bring up the 
TroopMaster Transfer Data to TM-Traveler dialog and click the Sync button to ensure 
that the intermediate database file matches the current TroopMaster database. 

 
b. Download. The Transfer Data to TM-Traveler dialog also has a Download to Handheld 

button. This option is useful if for some reason you want to transfer data from TroopMaster to 
your handheld without loading any of changes you’ve made on the handheld back into 
TroopMaster. 

 
c. Erase. If the database on the handheld is old or damaged, use this option to erase it. You can 

then use the “Sync” or “Download” options to transfer new data. Another reason to do this 
occasionally is that the size of your handheld database grows over time. Replacing the 
database would in effect compact it. 

 
Please read TM-Traveler User’s Manual, which can be accessed through the TroopMaster 
Help menu. 
 

3.10 Notepad 
 

Often you need to make notes of “things to do” or for many other purposes. This option 
provides rapid access to the Windows Notepad. A “TroopMaster Notes” file has already been 
created for you. You can use that or you can create as many others as you like.  
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3.11 Create New Archive 
 

The archive created during program installation will store up to 250 scouts and 500 adult 
members. If that fills up, use this option to create a new archive. New archives are 
automatically numbered by the program. They are created under the main program DATA 
folder and they cannot be renamed or relocated. 

 
3.12 Create TroopLedger Import Files 
 

TroopLedger cannot import data directly from the TroopMaster database so you must use 
this option to create a set of data transfer files. These can be created on a diskette, a zip 
cartridge, hard drive folder, etc. To complete the data transfer, start TroopLedger, select the 
File>Import option, and point it to the location where you saved these files. 

 
3.13 Delete Empty Archives 
 
   This option will remove any archive folders that have no scouts or adults. 
 
3.14 Data Access Password 
 

This option allows you to change your Data Access Password. To do so, you must enter one 
of the valid passwords defined by the database administrator on the Database 
Management/Passwords dialog. 

 
3.15 Database Management/Passwords 

 
Everyone who uses TroopMaster must have a Data Access Password. The default password 
assigned by the system is 'admin'. If you are going to be the database administrator, use this 
password dialog to define an administrative-level password. If not, then enter the Data 
Access Password provided to you by the database administrator. 
 
Only users who have the administrator password are allowed to access the Database 
Management/Passwords dialog, and the administrator password is the first one listed on this 
dialog. You can optionally use this dialog to define other data access passwords and to assign 
responsibility for updating specific area(s) of the database based on those passwords. A 
button on this dialog also enables you to create a Data Encryption Password to further protect 
your data from unauthorized access (3.15b).  
 
If you are not the system administrator, the word “Satellite” will be displayed on the Main 
Menu next to the unit number.  
 
To change the database administrator password, just enter the new one in the first slot on this 
dialog. However, please remember that once you do that you will no longer be able to restore 
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data from a backup made while the old password was in effect, so you should immediately 
make a new backup of your database. 

 
 
You can use this dialog to hide sensitive data, such as dates of birth and social security 
numbers, from certain users. Data items that can be protected are listed on the right-hand side 
of this dialog. For each password, check the items, if any, that you want leaders with that 
password to be able to access. Any items not checked will be hidden from those leaders on 
displays and reports. The database administrator always has access to all of the data items. 
 
All users can optionally hide selected data items on reports (para 3.17e). 

 
Please keep a copy of the passwords you define in a safe place. If you forget the database 
administrator password, we can help you recover it. However, there is a small service charge 
if you need for us to analyze the backup file to determine your password. Please visit our 
website at http://www.troopmaster.com/password/ for more information on password 
recovery. 

 
For obvious reasons, certain sensitive data items must be included on reports that go to 
your council office. These include the Annual Recharter, the Additional Enrollment, the 
Unit Advancement Report (4403), the Eagle Application Assistance, and the Tour Permit 
Assistance reports. Similarly, dates of birth are required for the Birthday List. If any 
fields marked for protection are needed for one of these reports, a leader who does not 
have access to those fields will not be allowed to run that report.  
 
a. Defining a Satellite. To define a satellite, enter a Data Access Password and select the 

functional area(s) you wish to assign to that satellite. The available areas are as follows: 
 

-  Activities (including scout/adult attendance)  
-  Advancement (including scout training and special awards) 
-  Duty to God (this award applies to LDS units only) 
-  Fundraisers (including scout/adult sales) 
-  Order of the Arrow/Mic-O-Say (scout and adult) 
-  Adult Members (including training, special awards, and leadership) 
- Merit Badge Counselors 
-  Points of Contact 
-  Scout Members (including parental data, vehicles, leadership, swimming levels) 

 
To create a “read only” copy of the database, enter a password but don’t check any of the 
functional areas. The satellite will be able to view the data and print reports, but will not be 
allowed to make changes. 

 
If you are using the family links, you must take care when defining your satellites. 
These links provide a way to tie family members together between four of the functional 
areas: scouts (and parents), adult members, merit badge counselors and points of 
contact. Since these four areas are “linked”, you must assign all four areas to the 
master system or to a single satellite. If you decide to divide responsibility for these 
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areas among two or more leaders, you must first disable the family links. The Database 
Management dialog has a radio button that allows you to do that. 

 
 
 
 
TroopMaster DotNet. TroopMaster DotNet (para 3.16), an add-on product that enables 
you to maintain a centralized database on an FTP site. This allows multiple leaders to 
access and update the database. DotNet allows you to assign different function areas to 
different leaders. With DotNet, you can assign responsibility for the same functional area 
to more than one leader while also retaining update authorizations yourself.  
 
The nine functional areas of the database are listed in para 3.15 above. Once DotNet has 
been enabled (para 3.16), the Database Management/Passwords dialog allows you check 
more than one checkbox in each of the functional area columns. This allows the database 
administrator to retain control of all nine functional areas while at the same time giving 
selective update authority to other leaders. You can mix and match the functional areas to 
specified passwords any way that you like. 
 
Under the DotNet option, the database administrator can change the update authorizations 
and/or the passwords at any time. New authorizations will apply to the affected DotNet 
user(s) the next time they log on. If a password is changed, the affected user(s) will be 
prompted for the new password the next time they log on. 

 
b. Data Encryption Password - Whenever you use TroopMaster to backup your database 

(para 3.1), email your database (para 3.4), or upload the database to an FTP site through 
DotNet (para 3.16), your database is compressed into much smaller backup files (*.bak). 
While the compressed files are always encrypted after being created, anyone who gains 
access to one of the files and has a copy of TroopMaster can decrypt and decompress the 
file unless you define an encryption password. Therefore, we strongly encourage you to 
create a unique Data Encryption Password for your unit.  

 
To do that, click the Data Encryption Password button. A good password should be at 
least eight characters long and should contain both letters and numbers. Once you have 
created this password, no one can decrypt or decompress your backup files without having 
this password. 
 

Please keep a copy of the password in a safe place. If you lose your password, visit our 
website at http://www.troopmaster.com/password/ for more information on password 
recovery. 

 
3.16 TroopMaster DotNet 
 

TroopMaster DotNet is an add-on feature that enables you to maintain a centralized database 
on an FTP site. This allows multiple leaders to access and update the database. DotNet is not 
a standard part of the TroopMaster program so it must be purchased separately. DotNet 
comes with an FTP site provided by Troopmaster Software. To enhance security, the address 

 38

http://www.troopmaster.com/password/


of our FTP server is not released nor are the actual user ID’s and passwords needed to log in. 
Access to your FTP site is redirected and processed internally by the software.  

 
You’re not required to use the FTP site on our server but if you choose to use a different 
server, user support will be limited. The reason for this is that because of the wide variety of 
server types and associated operating systems, it is very difficult for us to analyze a DotNet 
problem if your site is on another server. 
 
The DotNet interface is controlled through a dialog on the “File” menu. When you initialize 
your web database, TroopMaster compresses the data and archive files from your hard drive 
into smaller files (TM4Data.bak and TM4Archive.bak) and posts those to your FTP site. 
Thereafter, whenever you open the program, TroopMaster will automatically download the 
database backups, de-compress the files, and save them to the standard TroopMaster DATA 
and ARCHIVE folders on your local hard drive. While you are working in TroopMaster, you 
will be working with this local copy of your database so you will not experience any Internet 
delays in program response times. In fact, you can even disconnect from the Internet until 
you exit the program. 
 
When you exit TroopMaster, the data and archive files will again be compressed and 
uploaded to your FTP site so the next person to log on will have access to the most current 
data. If you disconnected from the Internet after starting TroopMaster, you must re-connect 
before exiting. 
 
a. Procedures. Select the File>TroopMaster DotNet menu option. Then, check the 

“Activate TroopMaster DotNet” checkbox and enter the server, user ID, and FTP 
password needed to access your FTP site. Please remember that your user ID and 
password are case-sensitive. We recommend that you use the default port (21) but you 
can change that if you like. 

 
Next, enter the path on your FTP site where the data will be stored (e.g., /data). This 
folder must already exist on the site. If you’re using the FTP site on our server, the web 
data path is always just a forward slash (/). By default, TroopMaster uses “Passive” mode 
transfers, and this mode is required for users with certain types of firewalls. However, if 
you want the FTP site to establish the data connection to your PC, uncheck this box. 
 
If you wish, you can use passwords to restrict the functional area(s) of the database that 
certain DotNet users are authorized to update as well as to make some users “read only”. 
To do that, click the Database Management button (para 3.15).  
 
While the compressed database files are always encrypted before being uploaded to the 
FTP site, anyone who gains access to the files and has a current copy of TroopMaster can 
decrypt and decompress the files unless you define a unique encryption password for 
your troop. To do that, click the Data Encryption Password button (para 3.16b). 

 
Troopmaster Software strongly encourages you to create an encryption password. Once 
you do that, no one without that password can view any of the data from the web 
database or from a database backup file, no matter how they obtain a copy of the file. 
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If you have scout/adult photos, select upload/download options for handling those. On 
both startup and shutdown, you can choose to always transfer photos, never transfer 
photos, or have the program prompt you regarding the transfer. If you do transfer your 
photos, those will also be compressed into smaller files (TM4DataPhoto.bak and 
TM4ArchivePhoto.bak) but these files will still be quite large, so routinely downloading 
and uploading the photos is not recommended. There’s no need to transfer photos unless 
they change. 
 
Occasionally, someone may want to log on without locking the database against updates 
by other users; e.g., just to print a report. To accommodate that, there is a “Prompt for 
read-only” option on startup. If you take this option, you will be able to view any part of 
the database but you will be prevented from making changes. 
 
If you would like the system to prompt you before downloading files from your DotNet 
site, select the Prompt to Download on Startup option. The program will then prompt you 
on startup with an option to either download the DotNet files or to start using the local 
files on your hard drive. This option is useful if you need data quickly or if the web 
database becomes damaged. However, you will be placed in “read only” mode so that 
you don’t accidentally make changes that would get overwritten the next time you logged 
onto DotNet. 

 
There may also be times when you’ll want to exit the program without unlocking the web 
database. If so, select the “Prompt to upload/unlock database on exit” option. For 
example, if you’d like to take data to meetings on a laptop computer and make updates, 
you could choose to leave the web database locked until you come back home and upload 
your changes. This not only prevents other users from making changes while you are 
gone, it allows you to log back on later without overwriting your changes with the older 
data from the FTP site. 

 
Each DotNet user enters their own name, phone number and email address in the fields 
provided. This information is used to let other unit leaders know who is updating the data 
in the event that they try to log on at the same time. 

 
Please make sure that the contact information entered is unique for each computer that will 
be connecting to DotNet. If you enter the same contact information on multiple computers 
and to login to DotNet on both machines at the same time, the system will not report the 
database currently being locked since it appears to be the same user logging on. 

 
The Initialize Database button is normally used only by the database administrator to 
post the unit database to your FTP site for the first time, but it can be used again in the 
event the web database gets damaged or if you just want to replace the database for some 
reason. Your database is automatically saved to your FTP site each time you exit the 
program, so you should not execute this option on a regular basis. 

 
The Unlock Database button is available as an override option in case a user either 
forgets to or for some reason cannot unlock the FTP database normally. 
 
TroopMaster keeps a log file of the last 20 users who have accessed the web database in 
“update” mode and the date/time they logged in. To review it, click View Log File.  
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The Delete DotNet Database button will delete all of the data on your DotNet FTP site. 
 

If your web database and/or the database “status” file become damaged, you can delete and 
replace the damaged files with data from your local hard drive by clicking the Delete DotNet 
Database button then the Initialize Database button. 

 
 
 

If the web database becomes damaged (which can happen if the upload process gets 
interrupted), it must be reinitialized. By viewing the log file, you can determine who last 
accessed the database. The web database should then be initialized from that leader’s 
computer, assuming that his database isn’t also damaged. We also recommend that each 
DotNet user routinely make a database backup when exiting TroopMaster. Doing that gives 
you another recovery option; i.e., you can compare the dates/times of the various backups 
and reinitialize using the most recent one.  
 
b. Restrictions. Once someone with a data access password that allows updates has logged 

onto DotNet, the database is locked and all other unit leaders will be prevented from 
logging on to make changes. This is true regardless of whether the leader who logged on 
is authorized to update the entire database or just one or two functional areas. 

 
If another leader with an update password tries to access the files while they are locked, 
he will see a message stating that the database is locked. The message will include the 
name of the leader using the files and the time that this leader logged on. At that point, 
the leader attempting to access the files will have the choice of either exiting the program 
or logging on in “read only” mode. If the leader chooses the “read only” option, he can 
view any of the dialogs and reports but will not be allowed to make any changes. 
 

There is a small time delay in sending the “locked” signal to your FTP site. Although 
extremely unlikely, it is not completely impossible for two leaders to be logged on for update 
at the same time. However, TroopMaster rechecks the locked status when you exit the 
program. If someone else is logged on or was logged on and has since logged off, the 
problem will be brought to your attention at that time. 

 
Users who are “read only” or who are restricted to only being able to update certain 
functional area(s) can still view any part of the database. The only exceptions are if the 
database administrator has chosen to protect certain sensitive data items, such as dates of 
birth or social security numbers. These restrictions, if any, are also based on Data Access 
Password assignments (para 3.15). 
 
Logging on in “read-only” mode does not lock the web database for other users and when 
a “read only” user exits TroopMaster, the local database is not uploaded to the FTP site. 

 
c. Use With TM-Traveler. If you also have the TM-Traveler add-on, you can continue to 

use that but keep in mind that when you sync to Traveler, you then have copies of scout 
and adult records that are no longer centralized. For example, this means that if you make 
a change to a scout’s advancement record on Traveler and before you sync that change 
back to the web database, some other leader changes that same area of a scout’s or an 
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adult’s records, you will overwrite the other leader’s change when you sync back. This 
only affects members where two leaders have changed the same area of the same 
member’s records. If the other leader updates a different member or area, then there is no 
problem.  

 
 
 
In this regard, there are three different areas to a scout’s record: rank requirements, merit 
badges, and special awards. For example, if one leader credits a scout with a merit badge 
and another leader credits him with “Scout Spirit,” there’s no conflict. Similarly, it will 
not cause a problem if one leader updates an adult’s phone number while another credits 
him with a training course. Two different leaders can even mark attendance on separate 
copies of Traveler as long as they do that for two different activities.  
 
However, if a leader updates a member in the web database while another leader updates 
the same area of that member’s record in TM-Traveler, then the next sync operation will 
overwrite the web database change with the one from TM-Traveler. 

 
3.17 Preferences 
 

This dialog is used to adjust system-wide settings and to customize TroopMaster to your 
personal preferences. The dialog has five tabs: 

 
a. Default Settings. This tab lets you set default values for city, state, zip code, area code, 

and phone types. Setting these values will save you time whenever you add new scouts 
and adults to the system. If you are operating in a foreign country that does not use U.S. 
formatted zip codes and phone numbers, you should de-select the “U.S. phone/zip 
format” checkbox. TroopMaster processes overseas addresses, zip codes, and phone 
numbers differently than it does for stateside units. A list of countries and associated 
country codes is available through the Help button. This tab also has several button and 
checkbox options: 

 
(1) Display ‘Tip of the Day’ on Startup. To turn these tips off, uncheck this box. 
 
(2) Use Large Toolbar Buttons. This checkbox allows you to control the size of your 

toolbar buttons 
 
(3) Highlight links/ScoutNet Required fields. This check box will highlight any links or 

ScoutNet required fields in the system. 
 
(4) Omit Completed MBs from Selection Lists. Check this box to omit merit badges a 

scout has completed from badge selection lists in the individual advancement area. 
 
(5) Prompt for Merit Badge Counselor on Badge Completion. By default, when you 

credit a merit badge, TroopMaster presents a dialog for you to select the counselor 
who taught the badge. If you don’t need to track that, turn this checkbox off. 
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(6) Prompt for Data Backup on Program Exit. Because backing up your database is so 
important, TroopMaster will offer to perform a backup each time you exit the 
program. This turns the backup prompt off. 

 
(7) Save Location of Report Display Window. If this box is checked, TroopMaster 

remembers the size and location of the last report window displayed and uses those 
settings as defaults for the next report. If this box is unchecked, TroopMaster will 
bring up the report display window using the same location/size as the main 
application window. 

(8) Use Formal Name on Lists/Reports. TroopMaster always uses scout and adult formal 
names instead of nicknames on ScoutNET related reports. Check this option if you 
want the program to use formal names on all reports. 

 
(9) Include Area Code on Reports. If all of your scouts and adults share the same area 

code for all phone numbers, you can elect to omit area codes on reports. 
 
(10) Prompt for Data Access Password on Startup. If you want to prevent unauthorized 

people from accessing TroopMaster on your computer, check this box and you will 
be prompted for your data access password every time you start the program. 

 
If you forget your password, we can help you to recover it. Please visit our website at 
http://www.troopmaster.com/password/ for more information on password recovery 

 
(11) Include Mic-O-Say on Menus. Mic-O-Say is a program similar to Order of the 

Arrow for scouts in the Midwest. TroopMaster supports that but if you don’t need 
this feature, uncheck this box. 

 
(12) Automatically Monitor LDS Scout Groups (LDS only). Check this box if you are an 

LDS unit and you want TroopMaster to automatically move scouts to the appropriate 
member group (Troop, Team, or Crew) based on age. For example, when 
TroopMaster sees that a scout has turned 14, it will automatically move him from the 
“Troop” to the “Team” member group and check the “Varsity” checkbox on his 
Individual Advancement dialog. 

 
(13) Automatically check for newer version.  Check this box for to automatically check 

the internet for a new program update. 
 
(14) U.S. Phone/Zip Format. If you have a U.S. unit or your unit is outside of the U.S. but 

still uses U.S. formats, check this box. 
 

The ScoutNET overseas phone format allows up to five digits for the city code. This must be 
followed by a separator (hyphen or period) and then a phone number of up to seven digits. 

 
(15) Reactivate System Messages. There are a number of pop-up information messages 

that you can selectively turn off so that they are not displayed again. Click this 
button to reactivate any messages that you have turned off. 

 
b. Background. This tab lets you adjust your main menu background colors. You can also 

replace our camping scene bitmap, if desired. 
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c. Page Settings. This tab lets you adjust margin settings for reports and labels. You can 

also modify the label settings to accommodate most label sizes. Separate settings are 
available for mailing labels and award cards (see para 12.3c for more information on 
award cards). There is a Restore Defaults button in case you get yourself into trouble. If 
you want to increase the number of lines printed on each page, adjust the “Paper Saver” 
setting. In addition, there is a “Duplex Printing” option in case you want to print on both 
sides of the paper. TroopMaster can do this even if you don’t have a full duplex printer. 

 
d. Report Fonts. This tab lets you choose a font, style, point size, and color for each section 

of the reports. Just click the button for the section you wish to change. 
 
e. Hidden Fields. This tab allows you to block the display of sensitive data (e.g., dates of 

birth, phone numbers, and social security numbers) on reports. To hide a field, check the 
box next to it. Settings on this dialog are not stored in the TroopMaster database; i.e., 
these settings are stored on and only affect the operation of the computer on which the 
settings are made. For last and first names, you can optionally reduce the names to just 
initials on reports. Any other data item checked will not appear on the reports at all. Of 
course, if your Data Access Password does not allow you to access some of the protected 
data fields (para3.15), those will be blocked on displays and reports regardless of your 
settings on this tab. 

 
Some reports, such as mailing labels, the Eagle Honor Roll, and MBC/POC lists, are useless 
without names so member names are never reduced to initials on those reports.  

 
For obvious reasons, certain sensitive data items (such as driver’s licenses and dates of 
birth) must be included on reports that go to your council office. These reports include 
the Annual Recharter, the Additional Enrollment, the Unit Advancement Report (4403), 
the Eagle Application Assistance, and the Tour Permit Assistance reports. TroopMaster 
ignores the settings on this tab when generating those reports. Similarly, dates of birth 
are required for the Birthday List. 

 
3.18 Repair Database 
 

You will probably never need this option but it is available, just in case. The option will 
rebuild your index files and examine your other data files. If records are missing, they will be 
replaced with blank records. TroopMaster will report any errors it finds. However, the repairs 
that can be made are very limited. If records have been overwritten by blanks or “garbage,” 
the repair process will not be able to fix it. 

 
This is an emergency procedure. If your database is damaged, your best option is to 
restore your data from a good backup. Before running this option, backup your existing 
data in case the repair process fails. Please do not overwrite any previous backups.  
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CHAPTER 4. UNIT 

 
4.0 Overview 
 

This area allows you to enter the basic information on your unit (e.g., address, sponsor, 
meeting place, etc.). This is also where you can define your patrol names, make patrol 
assignments, and credit unit/patrol awards. 

 
4.1 Unit General Information 
 

This information is needed by TroopMaster to generate the Annual Recharter report, the Unit 
Advancement Report (4403), and your unit’s return address labels. ScoutNET-required data 
fields are marked with green field labels. Most of the fields are self-explanatory. A brief 
description of the other areas follows: 

 
a. Unit/Level. If your unit is not a Boy Scout Troop, select the correct level. If your unit 

operates under the auspices of the Church of Jesus Christ of Latter-Day Saints, check the 
“LDS” checkbox and TroopMaster will apply the special LDS rules when it validates 
your Annual Recharter report. 

 
The “LDS Unit” checkbox also activates several features not otherwise available. For 
example, TroopMaster will create Troop, Team, and Crew member groups (para 4.4). Also, 
the “Duty to God” (DTG) award becomes available. You can access the data entry dialog for 
this award through a button on the Individual Advancement dialog. In addition, two “Duty to 
God” report options are added to the Reports>Duty Tto God menu. However, these new 
menu items will not be visible until the next time you start the program. (Note: Deactivating 
this checkbox will not cause scouts to lose credit for DTG award requirements.) 

 
b. Council/District. Enter your council name and number (#) and also the name of your 

district. 
 
c. Website. If your unit has a website, enter the URL. Clicking the Website button will then 

take you directly to your site. 
 
d. Special Needs. If yours is a “special needs” unit, select the appropriate type and click the 

Description button to provide details. 
 
e. Meeting Place. Enter the name, address and phone number of your unit’s primary 

meeting location and phone number. 
 
f. Vehicles. If you have unit vehicles, enter the details here and TroopMaster will include 

these vehicles as options for your adult leaders on the Tour Permit Assistance report. 
 
g. Mail Recipient. This information is used by TroopMaster to produce your return address 

labels. Your unit type/number (e.g., “Troop 123”) will automatically be included on the 
labels, so you don’t need to enter that. 
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h. Original Charter/Expiration. Enter the date on which your unit was originally chartered 
and the date that your current charter expires. 

 
i. Chartered Organization. Enter the name, address and phone number of your chartered 

organization. 
 

A remarks field is available to record information for which there is no specific field. Entries 
in this field will not be included in the recharter report. 
 
If you wish to include a photo of your unit, click the Unit Photo button. This photo will be 
printed on the Unit General Information report. 

 
4.2 Patrol Assignments 
 

This option lets you set or change your patrol assignments. The “List currently displays” 
drop-down box allows you to display the names of all scouts in the unit or just those in a 
specific patrol. There are several ways to assign scouts to patrols: 

 
1) Highlight the names of one or more scouts, highlight the desired patrol, and click the 

Assign button. 
 
2) Highlight the names of one or more scouts and double-click the desired patrol. 
 
3) Highlight the desired patrol and double-click the names of the scouts being assigned to 

that patrol. 
 
4.3 Patrol Names 
 

This display lets you define up to 24 patrols. Patrols will always be printed on reports in the 
same order as listed on this dialog. Since you may be adding more patrols later, you may 
wish to space out your entries accordingly. 

 
TroopMaster internally stores each scout’s patrol assignment by number, not by name. 
Therefore, if you rearrange the patrols on this dialog, you must also reassign your scouts 
through the Patrol Assignments dialog. 

 
4.4 Group Members 

    
The group members feature allows you to create reports on subsets of your unit; i.e., instead 
of including all of your members, this allows you to choose which members you want to see 
on a report. This feature replaces the “flags” option that was used in earlier versions, and it is 
much more flexible because you can create and name as many member groups as desired. 
Scouts, adult leaders, MBCs, and/or POCs can be added to any group. 
 
Many of the TroopMaster reports provide a “Select Member Groups” option (available 
through “Filtered Selection”) that allows you to select one or more groups for inclusion on 
the reports. If you do that, only the members of the selected group(s) will be included. For 
example, you could create a group of your troop committee members and then print a phone 
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list or general purpose worksheet that includes only those members. Or you could create a 
group of scouts and adults who will be attending a specific camping trip and then generate 
mailing labels just for those members.  

 
If you generate a report that is not applicable to certain members of a group, those members 
will not be included. For example, if you generate an adult leader phone list from a group 
that contains adults and POCs, the POCs would be excluded. 

 
Member Groups can be used in conjunction with activities in numerous ways. For example, 
if you create a group consisting of scouts/adults who will attend summer camp, you can use 
this group to create permission slips, rosters, advancement reports, a photo directory, etc. 
When summer camp is over, you can select this group from the Edit/Review Activity dialog to 
credit attendance. 

 
If the “LDS Unit” box is checked on the Unit General Information dialog, TroopMaster will 
automatically create member groups for your troop, team and crew (e.g., LDS_Troop) the 
next time you start the program, and it will assign each existing scout to the appropriate 
group based on age. You will need to assign your adults to the appropriate group(s) 
manually. Thereafter, each time you add a new adult or scout to the system, you will be 
asked to indicate the group to which the new member is assigned. For adults, you can 
designate more than one group. Scouts will automatically be moved up to the next group as 
their ages change but you can manually adjust the scouts/adults assigned to the three groups, 
as needed. 

 
a. Create a New Group. First, enter a “Description”. Then, highlight the desired names and 

click Add. Use the “Display” drop-down list to adjust the list of names from which to 
select. When finished, click the Save button and enter a name (e.g., “Troop Committee”) 
for the new group. 

 
 You can use an existing group as the starting point for creating a new group. Just select 

the existing group from the drop-down list, enter a new description, and then add or 
delete names, as desired. When finished, click Save, and enter a new group name. Be 
sure to enter a new name or you will overwrite the existing group. 

 
b. Modify a Group. Select the desired group from the drop-down list and then add or delete 

names, as desired. When finished, click Save. 
 
c. Delete a Group. Select the desired group from the drop-down list and click Delete. 

 
You can print copies of the groups you’ve created through Reports>Other. 

 
4.5 Patrol Awards 
 

This option lets you credit awards for any of your patrols. Select the desired patrol and for 
each award, enter an award name and completion date; then, click Add. To remove an 
erroneous award, highlight it and click Remove. 
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4.6 Unit Awards 
 

This option lets you credit unit awards. For each award, enter an award name and completion 
date; then, click Add. To remove an erroneous award, highlight it and click Remove. 
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CHAPTER 5. SCOUTS 
 
5.0 Overview 
 

In addition to adding and deleting scouts from your unit, this area lets you enter, review, and 
edit information on your scouts, such as personal data and leadership assignments. Other 
options include swimming levels, school grade promotion, archive and retrieval from 
archive, and import of graduating Cub Scouts. 

  
5.1 Scout Management 
 

This dialog allows you to add new scouts to the unit and to edit/review data on existing 
scouts. The Add New and Personal Data buttons access the same tabbed dialog for data 
entry. Additional buttons allow you to access the other areas of each scout’s records. If you 
need to delete or archive a scout, use the Del/Archive button on this dialog or on the scout 
personal data dialog. 

 
a. Personal Data. Most data fields are self-explanatory. Green field labels denote data items 

that are required for the BSA ScoutNET reports (para 12.11g). A brief description of each 
tab follows. 

 
(1) Personal #1. In addition to name and address, this tab has fields for date of birth 

(DOB), BSA Person ID number (from the membership card), social security number 
(SSN), school grade and Cub history. A separate mailing address field is available if 
the scout's mailing address is different from his street address. If you want to attach a 
photo of the scout, click the Photo button and browse to the appropriate JPG, GIF, or 
BMP file. Driver’s license data can be entered for Venturing scouts over age 18. 

 
The email address field can be used for the scout’s email address but you really 
should regard this as the primary family address for scout-related correspondence. 
TroopMaster allows bulk emailing of individual scout reports. If you want those 
reports sent to this address, check the associated checkbox. 

 
Many units requested the data field for social security number but collecting SSN’s 
raises Privacy Act issues. You should consult an attorney before doing so. 

 
The scout’s formal first name will be used on reports that go to council, but normally his 
nickname will be used on all other displays and reports. If desired, you can elect to use 
formal names throughout the program through an option on the File>Preferences dialog.  

 
The “Joined Unit” date is used when computing attendance percentages and also when 
computing service stars. If the scout has had breaks in service, enter the date he began his 
current service here and enter periods of prior service on the “Prior Service” tab. 
TroopMaster examines current service, prior service, and leadership history when computing 
service stars, being careful not to double credit overlapping periods of service. Completed 
service stars are included on the Court of Honor report. There’s also a Service Years report. 
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If all or most of your scouts have the same city, state, area code, etc., enter those on the 
Preferences dialog and TroopMaster will use your entries as the defaults. 

 
To email a scout, just click the button next to his email address. 

 
(2) Personal #2. This tab lets you record medical information including the last date for 

each class of physical exam. The “Special Needs” field is there in case the scout has a 
special condition that should be recorded. If so, you should click the Description 
button to more fully describe the condition. Family vehicle information will appear 
on the Unit Vehicles and Tour Permit Assistance reports. 

 
Special needs codes and the corresponding descriptions are included in your Annual 
Recharter report for ScoutNET. 

 
(3) Parents. ScoutNET-required fields are marked with green field labels but you need 

only enter data on one parent. If the parent is going to be an adult leader, merit badge 
counselor, and/or a POC, use the “links” to create record(s) in the associated area(s). 
Please see Chapter 15 for more information on family links. The “Guardian” 
checkbox indicates that this adult has legal authority for the scout—most parents are 
also guardians under the BSA definition of this field. 

 
Many units requested the data fields for social security numbers but collecting SSN’s 
raises Privacy Act issues. You should consult an attorney before doing so. 

 
You must enter data in all of the required fields for at least one parent. Parents who have data 
entries in all of the required fields will be included in the Annual Recharter report. 

 
TroopMaster allows bulk emailing of individual scout reports. If you want those 
reports sent to this address(es), check the associated checkbox.  
 

(4) Alt Relative Data. This tab allows entry of information on an additional relative or 
other adult when needed due to divorce, separation, etc. Inclusion of alternate relative 
information is an option on several reports. 

 
(5) Prior Service. If the scout has had breaks in service, enter the “From-To” dates of the 

scout's prior service and the associated levels, unit numbers, and council numbers. 
Prior service is one of the items considered when computing service stars for the 
Court of Honor report. Cub Scout service is not creditable toward Boy Scout service 
stars—it should be entered on the “Personal #1” tab.  
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(6) Remarks/Other. This tab provides a place for you to enter information for which there 
are no pre-defined data fields. In addition to a remarks field, there are eight user-
defined fields: four text fields and four checkboxes. You can enter your own label for 
any of these fields through the Define Field Labels button. For example, you might 
redefine one of the text field labels as “School” or use one of the checkboxes to 
indicate “Fees Paid”. TroopMaster has a special report for user-defined data fields. 

 This tab also has four fields through which you can link external files, such as a Word 
document, to the scout. To do that, just click the browse button and select the desired 
file. Use the Define Field Labels button to label each field. Once you have done that, 
you can click on the field label button to open the file. To remove a file, just erase the 
path/file name. 
 
Field labels you define for any scout will be used for all of your scouts. 
 

When you click OK, TroopMaster will save your data entries.  
 
If you are in the “Add” mode, TroopMaster will present a pop-up list of your patrols so that 
you can assign the new scout to a patrol, if desired. When you close the Patrol Assignments 
dialog, TroopMaster will clear the scout entry dialog so that you can add another scout, if 
desired. Since city, state, and zip code are often the same or similar for all scouts in a unit 
those fields will not be cleared. Click Cancel when you have finished adding scouts. 

 
If the “LDS Unit” box is checked on the Unit General Information dialog, then whenever 
you add a new scout, TroopMaster will ask you to assign him to the troop, team, or crew 
Member Group (para 4.4). 

 
If you are entering the brother of another scout in your unit, use the Link Sibling button to 
link the scout to his brother. Please see Chapter 15 for more information on family links. 
Sibling(s) to whom the scout is linked are displayed in a drop-down list under the scout’s 
“Nickname” field and you can switch to any sibling’s record by selecting his name from the 
list. To remove an existing link, uncheck the “Link Sibling” checkbox. 
 
If you are in “Edit” mode, several additional buttons are available. Quick access buttons will 
take you directly to the advancement, training, O/A, or leadership assignment dialogs for the 
scout being displayed. Previous and Next buttons enable you to page to the next or previous 
scout in the unit. 

 
Note that when you click the Next or Previous buttons, TroopMaster leaves you on the same 
tab. This provides a powerful method of reviewing and editing data on your scouts. For 
example, to review medical information, go to the “Personal #2” tab for the first scout, make 
any desired changes, and then click Next to move to the next scout. 

 
To archive or delete a scout, click the Del/Archive button. A pop-up window gives you the 
option of archiving the scout before he is deleted.  

 
If you delete/archive a scout who is over 17, you will be given the option of creating a record 
for him in the adults file and transferring his activity attendance to his new adult record. If 
you delete a scout without archiving him, you will permanently erase all of his data. 
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b. Advancement. This button will take you to the selected scout’s Individual Advancement 
dialog. Please see Chapter 6 for more information on entering advancement data. 

 
c. Special Awards. Click this button to enter or review the scout’s special awards. These are 

also covered in para 6.15. 
 
d. Leadership. This dialog handles the scout’s current leadership position(s) as well as any 

previous positions in which he has served.  
 

(1) Current Positions. To assign a scout to a position, select it from the drop-down list 
containing a menu of defined leadership positions. If you need to assign the scout to a 
position that is not on the menu, click the Define Positions button and add it. You can 
assign two current leadership positions to each scout. To remove a scout from a 
previously entered position, select the blank position from the drop-down list and 
enter the date he vacated the position. The first position has a “Credit toward 
leadership requirement” checkbox. The default value is taken from the setting on the 
Define Leadership dialog. 

 
TroopMaster monitors and automatically credits the “Position of Responsibility” 
requirements for Star, Life, and Eagle (see Appendix B). In doing so, only the first 
leadership position is considered. Therefore, if you assign two positions to a scout, you 
should use the more important of the two for the first position.  

 
Suppose that a scout is assigned to a position but is not doing a good job and you don’t want 
him to get any credit for the “Position of Responsibility” requirement. If you turn the 
“Credit” checkbox off, TroopMaster will not apply the position toward automatic credit. If 
the rank requirement has already been credited, you will need to erase the completion date. 

 
When a scout changes leadership positions, the vacated position is automatically moved to 
his leadership history list. The “Effective Date” of the new position is used as the closeout 
date of the old position.  

 
(2) Leadership History. This area allows you to enter previous positions (maximum 15) 

in which the scout served. To add a position to the list, select it from the drop-down 
menu and enter the “From-To” dates. If the position was creditable toward the 
“Position of Responsibility” requirement, check the “Credit toward leadership 
requirement” checkbox. Then, click Add. To remove a position from the list, 
highlight the position and click Remove. Leadership history is used in conjunction 
with current service and prior service when computing service stars for the Court of 
Honor report. 

 
A scout's leadership history is included on his Individual History report. If a scout serves in 
more than 15 positions, the oldest one is dropped when a new one is added to this list. 
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In computing automatic credit of the “Position of Responsibility” requirement, 
TroopMaster considers the scout’s current position #1 plus the creditable positions on 
his leadership history list. Remember that only positions that he has held since his 
previous promotion are counted toward completion of this requirement for his next 
rank. Valid positions for each rank are listed in the Boy Scout Handbook. 

 
e. Training. Click this button to enter or review training courses for the selected scout. For 

more information on scout training, see para 6.16. 
 

f. Order of the Arrow (O/A). Click this button to enter or review O/A data on the selected 
scout. See Chapter 11 for more information. 
 

g. Mic-O-Say. Click this button to enter or review Mic-O-Say data (Chapter 10) on the 
selected scout.  
 

5.2 Define Leadership 
 

Use this dialog to add leadership positions to the list of system-defined positions. Positions 
listed here will appear in the drop-down menu presented whenever you assign a scout to a 
position. To define a new position, enter a position name and if it will usually be counted 
toward the “Position of Responsibility” requirements, click the “Credit” checkbox. Then, 
click Add. User-defined positions are flagged with asterisks. 

 
5.3 Define Special Awards 
 

Use this dialog to define the scout special awards commonly presented by your unit. These 
entries will appear on an awards menu that is presented whenever you credit a scout with an 
award. However, you can credit scouts with awards that are not on the menu by using the 
“Other” option (para 6.15). 

 
5.4 Define Training 
 

Use this dialog to define the training courses commonly attended by your scouts. These 
entries will appear on a course menu that is presented whenever you credit a scout with 
completing a course. However, you can credit scouts with courses that are not on the menu 
by using the “Other” option (para 6.16). 

 
5.5 Patrol Assignments 
 

This option takes you the same Patrol Assignments dialog described in the “Unit” Chapter 
(para 4.2). 

 
5.6 Promote to Next School Grade 
 

The scout personal data includes a “Grade” field. At the end of the school year, you can 
promote all of the scouts in the unit through this dialog.  
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5.7 Swimming Levels 
 

Swimming level information should be updated every year when your members are re-
qualified. The “List currently displays” drop-down box allows you to display the names of all 
members in the unit or just those assigned to a specific patrol or swimming level. There are 
several ways to assign members to the appropriate swimming levels: 

 
1) Highlight the names of one or more members, highlight the desired level, enter a date, 

and click the Assign button. 
 
2) Highlight the names of one or more members, enter a date, and double-click the desired 

level. 
 
3) Highlight the desired level, enter a date, and double-click the names of the members 

being assigned to that level. 
 
5.8 Retrieve from Archive 
 

If a scout you archived later returns to your unit, you can retrieve his data through this 
option. See Chapter 13 for more information on use of the archive. 

 
5.9 Receive Cub Scouts from PackMaster 
 

This option lets you import scouts who are graduating from a Cub Scout pack that is using 
the PackMaster program from Troopmaster Software, Inc. The pack representative should 
give you a transfer diskette containing the graduating scouts and, optionally, adults. The 
import feature will add the new scouts and adults to your unit and transfer their personal data. 
If earned, Arrow of Light will be added to each scout's special awards file.  

 
You cannot import from a backup of the PackMaster database. The pack leader must use 
PackMaster’s Graduate to Boy Scouts option. The file name will be “graduate.txt”. 

 
This same feature is accessible through the File>Import Cub Scouts menu option. 

 
5.10 Receive Scouts From Another Unit 
 

You can electronically receive scouts from another unit using TroopMaster if that unit 
created a set of transfer files (para 5.11). Enter the path to the transfer file and click OK. The 
file name will be TM4Transfer.bak. This function will import virtually all of the data on each 
scout except for fundraiser data and attendance at specific activities. However, it will store 
each scout’s total attendance (i.e., total nights camped, total miles hiked, etc.) in the 
Activities>Set Prior Totals area (para 7.3). 

 
If the other unit also transferred adults, see para 8.1g. 
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5.11 Transfer Scouts to Another Unit 
 

If some of your scouts/adults are moving to another unit which is also using the current 
version of TroopMaster, this option will create a set of transfer files that will save the other 
unit leader from having to enter the members manually. Running this option will not delete 
the members from your unit. Enter the target location (usually a diskette) for the transfer 
files. Then, highlight all of the transferring scouts and adults and click Transfer Members.  
 
You must transfer all of the departing members before leaving this dialog. Each time 
you use this dialog, TroopMaster creates a new set of transfer files. Previously created 
transfer files, if any, will be erased. 

 
The data in the transfer file is compressed but it is not encrypted. Encryption is not 
possible because the receiving unit will be using a different encryption password. Since 
the file contains personal data, you should protect it carefully. 

 
Because the file formats are very different, you cannot transfer scouts to a unit that is using a 
earlier version of TroopMaster. 

 
This same dialog is accessible through the Adults>Adult Members menu.  

 55



CHAPTER 6. ADVANCEMENT 
 
6.0 Overview 
 

You will initially enter all of your advancement data through the Individual Advancement 
dialog. Select the desired scout from the list box on the left and Troopmaster will retrieve the 
scout's advancement records. You can then select any area for data entry or review. Radio 
buttons allow you to control which type of awards (i.e., Boy Scouts, Venturing, etc.) are 
displayed in the list box. Checkboxes on the right allow you to determine the type(s) of 
reports on which you want each scout included. For example, if you have a crew, the 
checkboxes would let you include all crew members on Venturing reports while limiting the 
Boy Scout reports to just those members working on Boy Scout advancement. 
 
Select the desired awards group and the associated awards will appear in the list box. If 
applicable, the badge toward which the scout is currently working is automatically 
highlighted. After selecting the desired option, you can then “page” sequentially to any of the 
other advancement dialogs in the selected group. In addition, quick access buttons allow you 
to jump directly to the scout’s personal data, leadership, training, or special awards dialogs.  
 
You can view a more complete description for any requirement on any of the award/badge 
dialogs just by clicking with your mouse on the requirement. 
 
For requirements that have sub-requirements, such as the “electives” requirements for Sea 
Scout awards and most of the requirements for the Bronze Outdoor/Ranger awards, clicking 
on a requirement will display a list of checkboxes for tracking the associated sub-
requirements. 

 
The “Inactive” checkbox allows you to turn off automatic credit (see Appendix B) of the 
Star, Life, and Eagle “Participation” requirements.  

 
The Merit Badges-Completed dialog (para 6.9) lets you enter all of a scout’s completed merit 
badges on one dialog and have TroopMaster place them under the appropriate ranks for you 
based on BSA rules. If you would prefer to manually place the badges on the various rank 
dialogs, check the “Manual MB Placement” checkbox. 

 
In “Manual MB Placement” mode, TroopMaster will still monitor your entries to ensure that 
a sufficient number of Eagle-required badges are entered for each rank. However, the 
program will not stop you from entering a merit badge under the “wrong” rank. For example, 
even if a scout still needs Eagle-required badges for Star, TroopMaster will not stop you from 
entering an Eagle-required badge under Life. In selecting manual mode, you assume most of 
the burden for ensuring that the scout advances according to BSA rules. 

 
If “Manual MB placement” has not been selected, a merit badge you credit via group 
advancement or the individual rank dialogs will be placed exactly the same as if you had 
entered the badge on the Merit Badges-Completed dialog.  
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TroopMaster has a feature that allows you to disable the Eagle-required merit badge rules for 
disabled scouts. Please see Appendix D. 

 
6.1 Date Entries 
 

Dates can be entered for all requirements including those that TroopMaster automatically 
monitors and credits. “Boards of Review” dates and most award completion dates are 
reviewed for accuracy. For example, a Board of Review should not be entered unless all 
other requirements for the rank are complete. TroopMaster will alert you to errors it detects. 

 
In addition to the standard date entry formats accepted throughout TroopMaster, several 
additional options are available in the advancement area. For example, if you don’t know the 
specific date on which a scout completed his “Patrol Cook” requirement, just type a C as the 
first character of the date field, and TroopMaster will enter the word “Complete” as the date. 
Similarly, enter an N (“N/A”) for requirements that are not applicable to a specific scout 
(e.g., a requirement that BSA added after the scout completed a rank).There are several other 
date entry options and shortcuts (para 2.6) to make date entry easier and save you time.  

 
Actual dates (MM/DD/YY) are required for completion dates for all advancement awards, 
including Boards of Review.  

 
6.2 Merit Badges 
 

If “Manual MB placement” has not been selected, TroopMaster will automatically place 
newly credited merit badges under the appropriate rank based on the badges the scout has 
already earned and BSA advancement rules. Automatic badge placement works the same 
way regardless of whether you credit badges via the senior rank dialogs, the Merit Badges-
Completed dialog, or Group Advancement. When appropriate, previously credited merit 
badges will be relocated based on the type and completion date of the new badge being 
credited. 

 
The methodology that TroopMaster uses for its badge placement function is explained in 
Appendix C and we strongly recommend that you read that. The badge placement function 
works even if the scout completed his ranks under earlier BSA advancement rules. 

 
For Star, Life, and Eagle, a note at the top of each dialog will tell you how many of the 
remaining open slots must be filled with badges from the Eagle-required list. TroopMaster 
will not let you credit a non-Eagle badge toward a rank if all remaining merit badges for that 
rank must be Eagle-required badges. 

 
The automatic merit badge placement function never adjusts or relocates merit badges 
credited under completed ranks. If you need to do that, you’ll need to temporarily 
demote the scout to a rank below the one you wish to adjust. If you only need to modify 
the date on one of the merit badges, you can do so without demoting the scout by 
double-clicking on the badge. 

 
You can have TroopMaster omit merit badges that a scout has already completed from the 
badge selection lists (para, 3.17). 
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To change a date for any of the previously entered badges, double-click the entry and enter 
the new date in the pop-up window. 
 
Whenever you credit a merit badge or edit an existing one, you can optionally indicate which 
counselor taught the badge. Select the counselor from the list of counselors in the 
TroopMaster database, or manually enter the name and BSA ID number of the counselor. If 
you don’t need to use this counselor option, you can turn that off through File>Preferences. 

 
To remove a previously entered badge, go to the Merit Badges-Completed dialog or to the 
associated rank dialog, highlight the badge, and click Remove. 

 
Outdated merit badges, such as Signaling, are still included on the menus in case a scout 
earned or started the badge before it was dropped. Outdated badges are marked with a pound 
sign (#). 

 
If BSA releases a new merit badge, you can add that to your system by installing the latest 
program update patch (para 1.6 ). 

 
6.3 Reported/Presented Flags 
 

Sometimes a scout does not tell you about a merit badge or advancement award he earned 
until after the Unit Advancement Report (4403) has already been submitted to the council 
office. Also, some scouts miss the Court of Honor and you need a way of reminding yourself 
to present their awards at the next Court. 

 
For merit badges, rank badges, and advancement awards, TroopMaster tracks whether the 
award has been reported to the council office. For these awards and special awards, it also 
tracks whether or not each award has been presented (see Note below) to the scouts at a 
Court of Honor. The reported/presented flags are shown on the rank dialogs with “R/P” 
checkboxes and on the Special Awards dialog by a “Yes/No” column in the list box. 
 
Whenever you generate a Court of Honor report (para 12.3c), TroopMaster will optionally 
include awards earned prior to the “From” date of the report if the “Presented” flags are not 
checked. When it is finished generating the report, TroopMaster will offer to set the 
“Presented” flags for all the awards on the report. If a scout misses the Court, you should 
retrieve his records and clear the appropriate “Presented” flags. 
 
When you generate the Unit Advancement Report (4403) for your council (para 12.3c), 
TroopMaster will optionally include any badges earned prior to the “From” date if the 
“Reported” flags are not set. When it is finished generating the report, TroopMaster will offer 
to set the “Reported” flag for all of the badges included on the report. 

 
We recognize that badges and awards are generally given to a scout as soon as he earns them. 
The term “Presented” in TroopMaster refers to the act of officially recognizing the scout at a 
Court of Honor. 
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6.4 Scout, Tenderfoot, 2nd/1st Class Ranks 
 

Requirements for these ranks follow the BSA advancement rules in effect at the time the 
software was released.  

 
If you don’t have or don’t wish to enter dates for all of the requirements for these ranks, just 
enter the Board of Review date and TroopMaster will blanket-fill the remaining requirements 
with the word “Complete.” 

 
In January of 1999, BSA added several new requirements to these early ranks, and in 2001 a 
subsequent new requirement was added to Tenderfoot. We anticipate that another new 
requirement to 1st Class will take effect in 2006. If a scout completed one or more of these 
ranks before the rules changed, enter N/A next to the new requirements.  
 
In January of 2002 BSA dropped what had been requirement 9c (Demonstrate water 
survival) for 1st Class, and the existing requirement 9d moved up to become the new 9c. This 
version of TroopMaster omits the earlier 9c requirement.  
 
TroopMaster automatically tracks and credits the 2nd/1st Class activity requirements if you 
are recording unit activities in that area of the program. Only those activity types that you 
have marked as valid are considered. In addition, the camping minimum must be met. 
TroopMaster also automatically credits the 2nd Class service project requirement based on 
service project activities. 

 
See para 6.3 for a description of the “R/P” flags. 

 
6.5 Star Rank 
 

This rank requires six merit badges including at least four from the required list for Eagle. If 
you are in automatic badge placement mode, TroopMaster will place these badges for you. 
TroopMaster also monitors the “Participation”, “Position of Responsibility” and “Service 
Project” requirements and will automatically enter completion dates for these as soon as they 
are satisfied. Please see Appendix B for more information on auto-crediting of requirements. 
 
In accordance with guidance from BSA, TroopMaster will count any of the 15 merit badges 
on the Eagle-required list toward the four that are required for this rank, even if two or more 
of the badges are from the same Eagle-required category. The categories are not a factor until 
a Life scout begins working toward Eagle. Please see Appendix C and also the Star rank 
requirements in the Boy Scout Handbook. 

 
If you are in manual badge placement mode, TroopMaster will ensure that you enter at least 
four Eagle-required badges under this rank. If the scout has earned more than two non-Eagle 
merit badges, enter two here and apply the others to the next higher rank where they will fit. 
However, 12 of the 21 merit badge slots under Star, Life, and Eagle are reserved for the 12 
Eagle-required merit badge categories. 

 
See para 6.3 for a description of the “R/P” flags. 
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6.6 Life Rank 
 

This rank requires five more merit badges, including three more from the Eagle-required 
merit badge list. However, if the scout earned more than four Eagle-required merit badges for 
Star, he will need less than three here (total of 7 from the current Eagle-required merit badge 
list). TroopMaster also monitors the “Participation”, “Position of Responsibility” and 
“Service Project” requirements for you and will automatically enter completion dates for 
these as soon as they are satisfied. Please see Appendix B for more information on auto-
crediting of requirements. 
 
In accordance with guidance from BSA, TroopMaster will count any of the 15 merit badges 
on the Eagle-required list toward the total of seven Eagle-required badges that are required 
for this rank, even if two or more of the badges are from the same category. The categories 
are not a factor until a Life scout begins working toward Eagle. Please see Appendix C and 
also the Life rank requirements in the Boy Scout Handbook. 

 
6.7 Eagle Rank 
 

When a scout earns Life, TroopMaster changes the way it counts Eagle-required merit 
badges. From this point on, only one badge from each of the 12 categories is counted as 
Eagle-required (see Appendix C and the Eagle rank requirements in the Boy Scout 
Handbook). TroopMaster also monitors the “Participation” and “Position of Responsibility” 
requirements for you and will automatically enter completion dates for these as soon as they 
are satisfied. Please see Appendix B for more information on auto-crediting of requirements. 

 
6.8 Palms 
 

This dialog provides a place to record advancement if a scout progresses beyond the Eagle 
rank. There are sufficient palms to credit advancement even if a scout earns all of the 
available merit badges. TroopMaster will display the next available palm whenever you 
select this dialog, but you can view any palm desired just by clicking the corresponding 
button. 

 
6.9 Merit Badges-Completed 
 

This dialog makes it very easy to enter any or all of the merit badges a scout earns. Highlight 
a badge, enter the completion date, and click Add. TroopMaster will automatically analyze 
the scout’s advancement records and place the new badge under the most appropriate rank. 
When appropriate, previously placed merit badges will be relocated. 
 
Whenever you credit a merit badge or edit an existing one, you can optionally indicate which 
counselor taught the badge. Select the counselor from the list of counselors in the 
TroopMaster database, or manually enter the name and BSA ID number of the counselor. To 
see who counseled a previously credited badge, double-click the badge. If you don’t need to 
record which counselor taught each badge, you can turn that off through File>Preferences. 
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The automatic merit badge placement function never adjusts or relocates merit badges 
credited under completed ranks. If you need to do that, temporarily remove the “Board 
of Review” date for that rank. 

 
6.10 Merit Badges-Partial 
 

Use this option to track up to 15 merit badges that the scout has started but not yet 
completed. To add a new badge to the list, select it from the drop-down menu and click Add. 
To update any badge on the list, highlight it. For each badge, you can enter a “Start” date as 
well as the most recent date on which the scout completed any of the requirements. There are 
also checkboxes for you to mark which requirements are complete and a “Remarks” field. 
When the scout completes the badge, highlight it, click Credit Badge, and enter the 
completion date in the pop-up window. 

 
You can also credit the badge from several other advancement dialogs. When you credit the 
scout with completion of one of these badges via this or any other dialog, TroopMaster 
automatically removes the badge from this list. To remove a badge manually, highlight it and 
click Remove Badge. 

 
The system merit badge requirements list is updated whenever you install a program update 
patch from our web site. These updates only affect scouts who begin a badge after the 
changes were made—scouts who have already started a badge can optionally finish the badge 
under the earlier badge requirements. 

 
After each badge, TroopMaster displays the publication year of the “Boy Scout 
Requirements” booklet that lists those requirements. If TroopMaster is not sure, it prints a 
question mark. You can manually set/change the year through the Modify MB Reqts button. 

 
If BSA revises the requirements for any of the merit badges and a scout is using a different 
set of requirements than the ones listed, highlight the badge and click the Modify MB Reqts 
button. In addition to requirement item number fields, the Partial Merit Badge Requirements 
dialog has a “Year” field in which you can enter the publication year of the associated “Boy 
Scout Requirements” booklet. If you modify any of the badge requirements on that dialog, 
TroopMaster will erase any credit that the scout currently has entered for the badge so you’ll 
need to re-check the boxes for the requirements he has completed.  

 
6.11 Advancement Remarks 
 

This dialog allows you to enter advancement remarks, such as a service project description. 
Remarks will be printed on the Individual Progress, Individual History, and Board of Review 
reports. The same set of advancement remarks is used for Boy Scouts, Varsity Scouts, and 
Venturers. 
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6.12 Varsity Awards 
 

For Varsity Scouts, TroopMaster tracks the Varsity Letter and the Denali Award. Both 
dialogs operate in generally the same manner; i.e., you enter completion dates for each of the 
requirements followed by an award completion date. If you prefer not to track the individual 
requirements, you can simply enter the award completion date and TroopMaster will blanket-
fill individual requirements with the word "Complete". 
 
TroopMaster will automatically monitor and credit the “advance a rank” requirements for the 
Varsity Letter and the Denali award plus the “Leadership” requirement for Denali. 
 

6.13 Venturing Awards 
 

For Venturers, TroopMaster tracks the five Bronze Awards, the Ranger Award, the Quest 
Award, the Trust Award, and the Gold/Silver Awards. Click the “Venturing” radio button to 
switch to this list. Because the Outdoor Bronze Award and the Ranger Award share the same 
list of core requirements and electives, these two awards share the same dialog, but there are 
separate "Earned" dates for each of the two awards. 
 
For some of the Trust Award requirements and for most of the requirements for the Quest 
award and the Bronze Outdoor/Ranger awards, clicking on a requirement will display a list 
of checkboxes for tracking the associated sub-requirements. Requirements with sub-
requirements are displayed in green. 

 
All of the Venturing award dialogs operate in generally the same manner; i.e., you enter 
completion dates for each of the requirements followed by an award earned date. If you 
prefer not to track the individual award requirements, you can simply enter the award 
completion date. 
 
One of the Bronze Awards should be designated as the Venturer's "primary" bronze award. 
This is the award that the Venturer plans to apply toward completion of the Silver Award. 
There is a checkbox on each of the Bronze Award dialogs for this purpose. If you don't 
designate one of the awards as primary, TroopMaster will automatically mark as "primary" 
the first award toward which you enter a requirement completion date. The reason for 
designating a primary Bronze Award is that TroopMaster will apply that award toward the 
Gold/Silver “Bronze Award” requirements. You can change which award is designated as 
primary at any time. 

 
6.14 Sea Scout Awards 
 

For Sea Scouts, TroopMaster tracks the Apprentice, Ordinary, Able, and Quartermaster 
awards. All of the Venturing award dialogs operate in generally the same manner; i.e., you 
enter completion dates for each of the requirements followed by an award earned date. If you 
prefer not to track the individual requirements, you can simply enter the award completion 
date and TroopMaster will blanket-fill individual requirements with the word "Complete". 
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TroopMaster will automatically monitor and credit the Swimming merit badge requirement 
for Ordinary and the Lifesaving merit badge requirement for Able if you credit those through 
the “Merit Badges – Completed” dialog. 
 
For the Ordinary, Able, and Quartermaster “Electives” requirements, clicking on a 
requirement will display a list of checkboxes for tracking the associated electives. Similarly, 
for the “16 hour” work requirements for Apprentice and Ordinary, clicking the requirement 
will display checkboxes you can use to credit each of the hours worked. 

 
6.15 Special Awards 
 

Each scout can earn up to 100 special awards. You can select from a menu of awards you 
defined on the Define Scout Awards dialog (para 5.3), or you can click Other and define a 
new award on the fly. After selecting the award, enter the completion date in the pop-up 
window. 

 
To change a date for any of the previously entered awards, double-click the entry and enter 
the new date in the pop-up window. 

 
As much as possible, you should credit awards by selecting from the menu. Then, when you 
print a list of scouts having or needing a special award, TroopMaster searches for the exact 
spelling (search is not case-sensitive). If you make frequent use of the “Other” option, make 
sure you spell the awards consistently or the “having/needing” reports will not be accurate. 

 
See para 6.3 for a description of the “Presented” column. To toggle the “Yes/No” status of an 
award, highlight the award and click the Presented button. 

 
6.16 Training Courses 
 

Each scout can be credited for attending up to 100 training courses. You can select from a 
menu of courses you defined on the Define Scout Training dialog (para 5.4), or you can click 
Other and define a new course on the fly. After selecting the course, enter the completion 
date in the pop-up window. 

 
To change a date for any of the previously entered courses, double-click the entry and enter 
the new date in the pop-up window. 

 
As much as possible, you should credit courses by selecting from the menu. Then, when you 
print a list of scouts having or needing a training course, TroopMaster searches for the exact 
spelling (search is not case-sensitive). If you make frequent use of the “Other” option, make 
sure you spell the courses consistently or the “having/needing” reports will not be accurate. 
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6.17 Group Credit 
 

This powerful capability makes it easy to credit advancement, awards, or training earned by a 
group of scouts at the same time. For example, if you start a merit badge class, you can 
update the partial merit badges for those scouts without having to retrieve their advancement 
records one at a time. Similarly, when the class is complete you can use group advancement 
to credit all of the scouts who earned the badge. Early rank requirements, special awards, and 
training courses as well as Varsity, Venturing, and Sea Scout requirements can be credited in 
the same manner. For LDS units, there’s also a Duty to God award option. 
 
Regardless of the item being credited, TroopMaster will automatically retrieve each of the 
scouts' records and make the required entries. If it encounters any problems, TroopMaster 
will credit as many scouts as possible and then present a results window showing the scouts 
on whom it had difficulties. For example, if a scout already had credit for a merit badge, he 
will be listed under “Duplicates”. If TroopMaster reports errors for a scout, a more serious 
problem was encountered. You should retrieve that scout's records and attempt to credit the 
item manually to see what the problem was. 

 
a. Early Rank Requirements. This option can be used to credit any of the requirements for 

1st Class and below. Select the requirements and enter the completion date. Then, select 
the scouts to be credited. Select multiple scouts or requirements by holding down the 
CTRL key and clicking the desired names or items, or by holding down the SHIFT key 
and clicking an entry at the end of contiguous group of names/items. Click Process to 
credit the requirements. 

 
b. Merit Badges. This dialog can be used to credit completed merit badges and also to add 

or update partial merit badges (i.e., badges in progress) for your scouts. Select the desired 
badge from the drop-down list and then select the appropriate scouts as described in para 
6.17a. Then: 

 
(1) Completed Merit Badges. Check the “Completed” radio button, enter the completion 

date, and click Process to credit the badge. TroopMaster will add the badge to each 
scout’s advancement records.  

 
For scouts who are in automatic badge placement mode, TroopMaster will place the new 
badge in the same manner as if you had entered it on the scout’s Merit Badges-Completed 
dialog.  

 
If you attempt to credit a completed merit badge for a scout who is in manual badge 
placement mode, TroopMaster will alert you and ask if you wish to place the badge 
anyway. If you answer “Yes”, TroopMaster will place the badge using the same 
guidelines as though the scout were in automatic badge placement mode. Existing 
badges may be relocated, as appropriate. 
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(2) Partial Merit Badges. Enter the date that the scouts last made any progress toward the 
badge. If any of the requirements are complete, check the corresponding checkboxes. 
Lastly, click Process. TroopMaster will examine each scout’s partial merit badges. If 
the badge is not already there, TroopMaster will add it. If the badge is already one of 
the scout’s partially completed badges, TroopMaster will update the badge with the 
new information. 

 
If you are updating an existing badge in progress, you do not need to recheck requirements 
that were previously marked as completed in the scouts’ records. For example, if the only 
thing new is that the scouts have completed requirement #6, you just need to check that one 
checkbox. 

 
If a scout is working on a merit badge using a different set of advancement rules than the 
ones in the current system list, you cannot use the group credit feature to update his records. 

 
c.  Varsity Awards. This option can be used to credit any of the requirements for the Varsity 

Letter or Denali Award. Select the award from the drop-down list. Then, select the 
requirements and enter the completion date. Then, select the scouts to be credited as 
described in para 6.17a. Click Process to credit the requirements. 

 
d.  Venturing Awards. This option can be used to credit any of the requirements for any of 

the Venturing awards. Select the award from the drop-down list. Then, select the 
requirements and enter the completion date. Then, select the scouts to be credited as 
described in para 6.17a. Click Process to credit the requirements. 

 
e.  Sea Scout Awards. This option can be used to credit any of the requirements for any of 

the Sea Scout awards. Select the award from the drop-down list. Then, select the 
requirements and enter the completion date. Then, select the scouts to be credited as 
described in para 6.17a. Click Process to credit the requirements. 

 
f. Duty to God. This option is only available to LDS units. Select the certificate and then 

the requirements area (e.g., Spiritual Development). Then select the specific requirements 
and enter a completion date. Lastly, select the desired scouts and click Process. 

 
g. Special Awards Earned. Select the desired award from the menu of awards you defined 

on the Define Scout Awards dialog, or type an award name in the “Other” field. Enter a 
completion date and then select the desired scouts as described in para 6.17a. Click 
Process to credit the award. 

 
h. Training Completed. Select the desired course from the training menu you defined on the 

Define Scout Training dialog, or type a course name in the “Other” field. Enter a 
completion date and then select the desired scouts as described in para 6.17a. Click 
Process to credit completion of the course. 

 
Since it is legal to credit some special awards and training courses more than once, 
TroopMaster will credit duplicates as long as the completion date is different. 
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6.18 Eagle Honor Roll 
 

This dialog lists all of your Eagle Scouts, past and present. Whenever you promote a scout to 
Eagle, TroopMaster will offer to add him to this list. To add a prior Eagle manually, just 
enter his name, the date he earned Eagle, and click Add. You can view the list sorted by 
name or date. To change an Eagle rank date, double-click the entry. 

 
6.19 Duty to God 
 

If the “LDS Unit” checkbox is checked on the Unit General Information dialog, this option is 
available through a button on the Individual Advancement dialog. The Duty to God dialog 
has a separate tab for each of the three certificates, and TroopMaster will automatically 
display the certificate appropriate to the scout’s age. 
 
For each certificate, you can elect to display any of the seven areas of requirements. As the 
scout completes these requirements, check them off within the list box. TroopMaster will 
monitor your entries and when a sufficient number of requirements have been completed for 
a given area, you will be prompted for a completion date. When all of the dated requirements 
are complete, TroopMaster will automatically enter a completion date for the certificate. 
When all three certificates are complete, TroopMaster will credit the scout with Duty to God 
and add the award to the scout’s special awards list. 

 
For LDS units, Duty to God is also an option on the Group Credit menu. 
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CHAPTER 7. ACTIVITIES 
 
7.0 Overview 
 

TroopMaster will track attendance of your scouts and adult leaders at campouts, hikes, 
meetings, service projects, and up to 20 user-defined activity types. Up to 2000 activities can 
be tracked. Activities can be entered in advance (this allows you to produce a unit calendar) 
or you can enter the activity and attendance at the same time. TroopMaster also provides a 
Set Prior Totals dialog so that you can credit scouts and adults for nights camped, miles 
hiked, etc., that they completed before joining your unit. 

 
7.1 Activity Management 
 

This dialog allows you to add new activities to your database and to review/edit any of your 
existing activities. Use the Add New button to enter new activities separately or click the 
Generate Schedule button to add groups of recurring activities, such as weekly meetings or 
monthly campouts (para 7.7). To remove an activity, highlight it and click Delete. 
 
When you review existing activities, you can view all of them or you can narrow the review 
down to activities of a specific level (troop, crew, team, etc.) and/or type (camps, hikes, 
meetings, etc.) 
 
a. Add New Activity. Standard items include activity type, date, start/end times, amount, 

(e.g., nights camped, miles hiked, hours worked, etc.), location, and remarks. The 
“Activity Type” field provides a drop-down menu of types you defined on the Define 
Activity Types dialog. Click the Define Types button to access this dialog. Click the 
Description button to enter a text description of the activity. 

 
To generate permission slips (para 12.16b) or a tour permit (para 12.1h) for the activity, 
click the respective button at the bottom of the dialog. Associated fields for the 
permission slips will be preloaded for you. 
 
To schedule an email reminder click the ‘Schedule email reminder’ button. For more 
information on scheduling emails see para 3.6.  

 
If this is a significant activity (e.g., summer camp, a ski trip, etc.), you should create a 
Member Group (para 4.4) of scheduled attendees. Once you’ve done that, you can use the 
group to generate reports for the activity, including permission slips, plus you can use it 
again to credit attendance after the activity is over (para 7.1.b(2)). 

 
If the activity was a campout or a hike, a “Backpacking” checkbox is available: This item is 
used to generate the Backpacking Summary report (para 12.1e) and when determining O/A 
Eligibility (para 12.9c). Backpacking should always be entered as a both a camp and a hike. 
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If the activity was a campout, two additional checkboxes are available: “Summer Camp” and 
“Cabin Camp”. These items are important because TroopMaster uses these in computing 
“Nights Remaining” for the Scouts Needing Camping MB report (para 12.3l), and when 
determining O/A Eligibility (para 12.9c). 

 
The “Credit toward 2nd/1st Class” check box lets you decide whether or not to count each 
activity toward automatic credit (see Appendix B) of the 2nd/1st Class activity requirements. 
For example, if you hold a camp and a hike on the same day, you may only want one of the 
two to be credited toward these requirements. TroopMaster initially uses the default value 
from the Define Activity Types dialog (para 7.4). 
 
b. Edit/Review Activities. This option is most often used to mark attendance but it also 

enables you to review or change any previous entries. Note that in “Edit/Review” mode, 
you can move to the next or previous activity via the buttons provided. 

 
To review activities of a single level and/or type, select those on the Activity Management 
dialog before clicking Edit/Review. The Next and Previous buttons will then let you “page” 
through activities of the selected level and type. 

 
The Delete button should only be used to remove activities that were canceled or 
entered in error. If you need to clear out old activities to make room for new ones, use 
the Delete Activities dialog (para 7.6). Otherwise, attendance totals for the activities will 
be lost. Attendance totals at activities removed through the Delete Activities dialog are 
automatically added to scout and adult amounts in the “Set Prior Totals” area. 

 
(1) Combined Activities. Sometimes two or more activities are held in conjunction with 

one another. For example, you may have held a campout that included hiking and a 
service project. To save you from having to enter all of the information including 
attendance three times, TroopMaster provides a Combined button. The campout was 
probably entered in advance because you would have wanted it to be included on 
your unit schedule.  

 
First, retrieve the campout and enter the scout/adult attendance. When finished, click 
Combined and TroopMaster will save your attendance entries, switch you to “Add 
new activity” mode, and erase only the “Type” and “Amount” fields. Next, change 
the type to “Hiking” and enter the length in the “Miles” field. If you don’t want the 
scouts getting double credit for the 2nd/1st Class activity requirement, clear that 
checkbox. Adjust the attendance, if necessary, and click Combined again. Lastly, 
make the service project entries and click OK. TroopMaster will save the information 
on all three activities. 

 
(2) Crediting Attendance. Crediting attendance is very flexible. For example, there are 

several ways to list your scouts and adults while marking attendance. This is 
controlled through the “List Currently Displays” field. The default list is “All Scouts” 
but you may prefer to mark scout attendance by patrol. To record adult attendance, 
select the “All Adults” option. 
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To mark attendance, select the applicable members by holding down the CTRL key 
and clicking the desired names, or by holding down the SHIFT key and clicking a 
name at the end of a contiguous list. Then, enter an appropriate “Attendance Marker” 
field and click Apply. Scouts and adults can be credited for attending the same 
activity. 
 
If you created one or more Member Groups for scouts/adults who were scheduled to 
go on this activity, click the Credit Member Group button and select the groups that 
apply. Troopmaster will then mark all of the group members as attending. If someone 
missed the activity, clear his attendance before clicking OK. 

 
Marking attendance is even easier if you enter an attendance marker and then double-click 
the names of the scouts and adults who attended. 

 
If you accidentally credit the wrong person, double-click the name again to erase the entry. 

 
The “Attendance Marker” is very flexible. Using a letter (e.g., X) to mark attendance 
gives the scouts credit for the entire activity amount (e.g., night camped, miles hiked). 
On the other hand, numbers have special meaning. For campouts, a numeric 
attendance marker overrides the “Nights” field. For example, if a scout only stayed for 
the first night of a two-night campout, change his attendance marker from X to a 1 
(one), and he will just get credit for one night. If he came for the day but did not spend 
the night, enter a zero. Numbers can also be used for other activity types. This lets you 
make individual entries for things like service project hours worked, miles hiked, etc. 

 
Non-numeric entries must be a single character. Numeric entries can be four digits. 
TroopMaster will also track tenths. For example, when crediting service hours you might use 
a marker of 2.6 hours. 

 
An asterisk (*), if entered in the attendance column, indicates that the individual did not 
attend but was excused. Excused absences are not considered when computing attendance 
percentages for the Unit Participation Summary report. 

 
Use non-numeric entries to record things other than simple attendance. For example, an entry 
of E on a campout could indicate the scout attended and had an equipment inspection. 

 
7.2 Activity Calendar 
 

This dialog is a very handy desk reference calendar that’s integrated with your scheduled 
activities. Dates with scheduled activities are boxed with the color of the box indicating the 
activity type. A legend is displayed at the bottom. If there are two or more activities 
scheduled for the same date, the box background changes to black.  

    
Click a boxed date to view details on the associated activity or click an open date to add a 
new activity. To change the associated color of one of the activity types, click on its entry in 
the legend and then click on the colored box next to that type..  
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If you position your mouse over a date, TroopMaster will display a short summary of the 
activity(s) scheduled for that date. 

 
TroopMaster also has a Unit Calendar report (para 12.1j). 

 
7.3 Set Prior Totals 
 

This option helps ensure that the grand totals for each scout and adult are accurate. Use this 
dialog to enter nights camped, miles hiked, service project hours, etc., that the scout/adult 
completed before joining your unit. For the Unit Activity Totals report and the Individual 
History reports, TroopMaster will add these entries to the amounts in your active database. 
Prior totals can optionally be included on the Individual Participation and Participation 
Summary reports. 

 
Because there are no dates associated with your entries, “prior” entries are not included on 
any activity reports that use “From-To” dates. For the same reason, “prior” camping is not 
considered when computing O/A eligibility. 

 
7.4 Define Activity Types 
 

TroopMaster tracks scout and adult participation in as many as 24 different types of 
activities. Since camping, hiking, meetings, and service projects are the most commonly used 
types, these are pre-defined for you and cannot be changed. You can create additional 
activity types to satisfy the specific needs of your unit. For example, you might want to track 
outings, canoeing, unit committee meetings, etc. 

 
For each new type, enter a name (which must be unique) and, if desired, a field label to be 
used for the activity “amount” field. If you want the activity type to be counted toward 
automatic credit (see Appendix B) of the 2nd/1st Class activity requirements, enter a check 
mark in the field provided. To set or change the associated color for an activity type, click the 
box to the left of the type name and then choose a color from the pop-up palette. Colors are 
used on the Activity Calendar dialog (para 7.2). 

 
TroopMaster automatically monitors and credits the activity requirements for the 2nd/1st 
Class ranks. The checkbox setting in the “Credit toward 2nd/1st Class” column on this dialog 
will be used as the default value when you create activities of this type, but you can adjust 
that if desired for any specific activity. 

 
If you change an activity type name on this dialog, TroopMaster will offer to change the 
name on all of the exiting activities that were assigned to the old type. 

 
If you define minimum attendance percentages for selected activity types, then when you run 
the Participation Summary report (para 12.1g) and select the “Attendance Percentages” 
option, TroopMaster will flag scouts who failed to meet these minimums. 
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If you create an activity type of “Driving”, you can use the attendance feature to keep track 
of how many miles each of your adults has driven in support of your unit. At the end of each 
year, you could then print Individual Participation reports for those adults, who could use 
them for tax purposes. 

  
Sea Scout units should define an activity type of “Cruises” with an amount label of “Nights”. 

 
7.5 Define Activity Levels 
 

Use this option to add new activity levels to the system. For example, you might want to 
have an activity level for each of your patrols. To add a new level, enter the name and click 
Add. To remove an existing level, highlight it and click Remove.   

 
7.6 Delete Activities 
 

This option enables you to clear out your files when you reach the system limit of 2000 
activities. Activities can be deleted by “From-To” period and by activity types/levels. This 
flexibility allows you to selectively clear activities like old meetings from your files while 
retaining more important activities, such as camping and hiking. For deleted activities, 
TroopMaster will total the amounts (e.g., nights camped, miles hiked, etc.) for each member 
and add those to his Activities>Set Prior Totals amounts. 

 
To avoid having unwanted amounts being added to scout/adult “prior” totals, delete 
erroneous activities through the Activity Management dialog or by displaying the activity and 
clicking Delete. 

 
7.7 Generate Schedule 
 

This option makes it easy to create a schedule of weekly, bi-weekly, or monthly activities 
and add those to your activities file. For example, let’s suppose you want to create a schedule 
of weekly meetings. Select type “Meeting” from the drop-down list. Then, check “Include on 
calendar” since you definitely want your meetings on your unit calendar. Meetings don’t 
count toward completion of the 2nd/1st Class activity requirements, so leave that checkbox 
blank. Enter an amount (usually zero unless you’re using some type of point system), your 
meeting location, and remarks, if desired.  

 
Then, enter the date of the first scheduled meeting in the “From” field and the date of the last 
meeting in the “To” field. Select the “Weekly” option. Lastly, click Generate and 
TroopMaster will automatically create a full schedule of meetings based on the weekday of 
the first meeting date, and it will display the generated dates in the list box. 
 
Before saving these meetings to your activities file, check the list for holidays, etc. For 
example, if there will be no meeting during Christmas week, highlight that date and click 
Remove. When all of the remaining dates are correct, click Save and TroopMaster will add 
all of the scheduled meetings to your activities file. 
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CHAPTER 8. ADULTS 
 
8.0 Overview 

 
In addition to adult members of your unit, TroopMaster allows you to track points of contact, 
and merit badge counselors. 

 
8.1 Adult Members 

 
This area allows you to track adult members of your unit. Because some units want to be able 
to track attendance for adults who are not strictly unit leaders, there is a checkbox to indicate 
which adults should be included on adult leader reports. 

 
a. Adult Management. This dialog allows you to add new adults to the unit and to 

edit/review data on existing adults. The Add New and Personal Data buttons access the 
same tabbed dialog for data entry. Additional buttons allow you to access the other areas 
of each adult’s records. If you need to delete or archive an adult, use the Del/Archive 
button on this dialog or on the adult personal data dialog. 

 
(1) Personal Data. A brief description of each tab follows.  

 
(a) Personal #1. In addition to name and address, this tab has fields for date of birth 

(DOB), social security number (SSN), and driver’s license number/state. Green 
labels denote fields that are required for ScoutNET reports (para 12.11g), but the 
fields are only mandatory for adults who have been or will be assigned leadership 
positions. A separate mailing address field is available if the adult's mailing 
address is different from his street address. If the new adult was a Boy Scout, 
enter the highest badge earned. If he is an Eagle Scout, enter the date he earned 
his Eagle. If you want to attach a photo of the adult, click the Photo button and 
browse to the appropriate JPG, GIF, or BMP file. You can create family links to 
parents, merit badges counselors, and POCs. Please see Chapter 15 for more 
information on family links.  

 
Many units have requested the data field for social security number but collecting 
SSN’s raises Privacy Act issues. You should consult an attorney before doing so. 

 
The adult’s formal first name will be used on reports that go to council, but normally his 
nickname will be used on all other displays and reports. If desired, you can use formal names 
throughout the program--see the File>Preferences option.  

 
The “Became Leader” date is used in conjunction with “prior service” and leadership history 
entries to compute service stars for the Court of Honor report. If the leader has had breaks in 
service, enter the date he began his current service in this field and enter previous periods of 
service on the “Prior Service” tab.  

 
The “Joined Unit” date is used when computing attendance percentages. 
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The “Highest Badge Earned” field is considered when computing O/A eligibility. To be 
eligible, adults who are under 21 must have reached at least the 1st Class rank. 

 
If all or most of your adults have the same area code, enter that on the Preferences dialog and 
TroopMaster will use it as the default for all phone number fields. 

 
To email an adult, just click the button next to his email address. 

 
(b) Personal #2. This tab lets you record medical information including the date for 

each class of physical exam. The “Special Needs” field is there in case the adult 
has a special condition that should be recorded. If so, you should click the 
Description button to more fully describe the condition. The vehicle and 
insurance fields are provided in case the adult does not have a son in the unit. 
Data entered in these fields can be included on the Unit Vehicles report and the 
Tour Permit Assistance report. If this adult is linked to a specific parent, you may 
also choose to link the vehicle information between the two records as well. 
 

Special needs codes and the corresponding descriptions will be included in your Annual 
Recharter report for ScoutNET. 

 
(c) Prior Service. If the leader had breaks in service, enter the date he began his 

current service in the “Became Leader” field on the “Personal #1” tab. Enter the 
“From-To” dates of previous service on this tab. For each line entry, there are also 
fields for level, unit number, and council number. Prior service is used in 
conjunction with current service and leadership history when computing service 
stars for the Court of Honor report. 

 
(d) Remarks/Other. This tab provides a place for you to enter information for which 

there are no pre-defined data fields. In addition to a remarks field, there are eight 
user-defined fields: four text fields and four checkboxes. You can enter your own 
label for any of these fields through the Define Field Labels button. For example, 
you might redefine one of the text field labels as “Hobbies” or use one of the 
checkboxes to indicate “Fees Paid”. TroopMaster has a special adults report for 
the user-defined data fields. 

 
This tab also has four fields through which you can link external files, such as a 
Word document, to the adult. To do that, just click the browse button and select 
the desired file. Use the Define Field Labels button to label each field. Once you 
have done that, you can click on the field label button to open the file. To remove 
a file, just erase the path/file name. 
 
Field labels you define for any adult will be used for all of your adults.  

 
When you click OK, TroopMaster will save your entries. If you are in “Add” mode, 
TroopMaster will clear the display so that you can add another adult, if desired. Since 
city, state, and zip code are often the same or similar for all adults in a unit, those 
fields will not be cleared. Click Cancel when you are finished adding adults. 
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If the “LDS Unit” box is checked on the Unit General Information dialog, then whenever 
you add a new adult, TroopMaster will ask you to assign the new member to the troop, team, 
and/or crew Member Group(s), as appropriate (para 4.4). 

 
If you are in “Edit/Review” mode, several additional buttons are available. Quick 
access buttons will take you directly to any adult’s awards, training, leadership and 
O/A dialogs. Previous and Next buttons allow you to “page” through your adults. 
 
To archive or delete an adult, click Del/Archive. A pop-up dialog gives you the 
option of archiving (Chapter 13) the adult before he is deleted. 

 
(2) Special Awards. Each adult can earn up to 100 awards. Select from a menu of awards 

you defined on the Define Adult Awards dialog (para 8.1d), or click Other and define 
a new award on the fly. Enter a completion date in the pop-up window. To modify the 
completion date of an award, double-click the award and enter a new date in the pop-
up window. 

 
As much as possible, you should credit awards by selecting from the menu. The reason for 
this is that when you print a list of adults having or needing a special award, TroopMaster 
searches for the exact spelling (search is not case-sensitive). If you make frequent use of the 
“Other” option, make sure you spell the awards consistently or the “having/needing” reports 
will not be accurate. 

 
See para 6.3 for a description of the “Presented” column. To toggle the “Yes/No” status of an 
award, highlight the award and click the Presented button. 

 
(3) Adult Leadership. This dialog handles the adult’s current leadership assignment(s) 

and leadership history.  
 

(a) Current Positions. To assign a leader to a position, select it from the drop-down 
menu of leadership positions. If the desired position is not on the menu, click the 
Define Positions button and add it. You can assign up to four current positions to 
each leader.  

 
To remove a leader from a previously entered position, select the blank position 
from the drop-down list and enter the date he vacated the previous position. 
 

When a leader changes leadership positions, the vacated position is automatically moved to 
the leadership history list. The “Effective Date” of the new position is used as the closeout 
date of the old position.  

 
When you assign a leader to the Patrol Advisor position, you can optionally select a patrol 
name from the pop-up menu. If you do, that leader will be printed with his patrol on the 
Patrol Roster. Patrol Advisors are listed as Assistant Scoutmasters on the Annual Recharter 
report. 
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(b) Leadership History. This area allows you to enter previous positions (maximum 
15) in which the adult served. To add a position to the list, select it from the drop-
down menu. Enter the “From-To” dates and click Add. To remove a position 
from the list, highlight the position and click Remove. 

 
Leadership history is included on the adult’s Personal Data report. If a leader 
serves in more than 15 positions, the oldest one is dropped when a newer one is 
added to the list. Leadership history is used in conjunction with current service 
and prior service when computing service stars for the Court of Honor report. 

 
(4) Training. Each adult can be credited with up to 100 training courses. Select from a 

menu of courses defined on the Define Adult Training dialog (para 8.1e) and then 
enter a completion date in the pop-up window. To modify the completion date of a 
course, double-click the course and enter a new date in the pop-up window. 

 
(5) Order of the Arrow (O/A). Click this button to enter or review O/A data on the 

selected adult. See Chapter 11 for more information. 
 

(6) Mic-O-Say. Click this button to enter or review Mic-O-Say data on the selected adult. 
See Chapter 10 for more information. 

 
b. Group Credit. This feature makes it easy to credit special awards or training completed 

by a group of adults at the same time. For example, if several of your adults complete 
CPR, you can update their training records without having to retrieve them one at a time. 
If TroopMaster reports errors for an adult, you should retrieve that adult’s records and 
attempt to credit the item manually to see what the problem was. 

 
(1) Special Awards Earned. Select the desired award from the menu of awards you 

defined on the Define Adult Awards dialog, or type an award name in the “Other” 
field. Enter a completion date, select the desired adults, and then click Process to 
credit the award. 

 
(2) Training Completed. Select the desired course from the training menu you defined on 

the Define Adult Training dialog. Then, enter a completion date, select the desired 
adults, and then click Process to credit completion of the course. Click the Help 
button to view a list of courses BSA requires for an adult to reach “trained” status. 

 
c. Define Adult Leadership. TroopMaster comes with a menu of adult leadership positions. 

Use this dialog to define additional ones, if needed. Your entries will appear on a 
positions menu that is presented whenever you assign a position to one of your adults. 
User-defined positions are flagged with an asterisk on this dialog, and they are always 
treated as “Committee Member” on the Annual Recharter report. 

 
d. Define Adult Special Awards. Use this dialog to define the most common special awards 

presented by your unit. Your entries will appear on an awards menu that is presented 
whenever you credit an adult with an award. However, you can credit awards that are not 
on the menu by using the “Other” option (para 8.1a(2)). 
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e. Define Adult Training Courses. TroopMaster comes with an extensive menu of official 
BSA training courses. Use this display to define additional courses or edit existing 
courses, if needed. Your entries will appear on a training course menu that is presented 
each time you credit an adult with a course.  

 
TroopMaster internally tracks training by course code so please ensure that you enter 
the correct BSA course code for any courses you add. If there is no official course code, 
you’ll need to define one but choose something BSA is not likely to use later (e.g., XX1). 

 
Although BSA does not publish training expiration periods for any of their courses, many of 
the local councils have done so for certain courses. Expiration periods you enter here will be 
used by the software to determine which adults need retraining. 

 
f. Retrieve from Archive. If an adult you archived later returns to your unit, you can 

retrieve his data through this option. See Chapter 13 for more information on use of the 
archive. 

 
g. Receive Adults From Another Unit. You can electronically receive adults from another 
unit using TroopMaster if that unit creates a set of transfer files (see below). Enter the path to 
the transfer files and click OK. This function will import virtually all of the data on each 
adult except fundraiser data and attendance at specific activities. However, it will store each 
adult’s total attendance (i.e., total nights camped, total miles hiked, etc.) in the Activities>Set 
Prior Totals area (para 7.3). 

 
If the other unit also transferred scouts, see para 5.10. 

 
h. Transfer Adults To Another Unit. If some of your scouts and adults are moving to 

another unit that uses TroopMaster, this option will create a set of transfer files that will 
save the other unit leader from having to enter the scouts and adults manually. Running 
this option will not delete the scouts and adults from your unit.  

 
First, enter the target location (usually a diskette) for the transfer files. Then, highlight all 
of the transferring scouts and adults and click Transfer Members.  

 
You must transfer all of the departing members before leaving this dialog. Each time 
you use this dialog, TroopMaster creates a new set of transfer files. Previously created 
transfer files, if any, will be erased. 

 
This same dialog is accessible through the Scouts menu.  

 
8.2 Merit Badge Counselors (MBCs) 
 

This menu option allows you to add new counselors to the unit and to edit/review data on 
existing counselors. The Add New and Edit/Review buttons access the same data entry 
dialog. You can assign merit badges to each counselor by highlighting the desired badges and 
clicking Add. The MBC dialog has fields for tracking counselor training as well as original 
certification and recertification dates. You can also create family links to the parents, adults, 
and POCs files. Please see Chapter 15 for more information on family links.  
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To assign a badge quickly, just double-click the badge name. 

 
To remove a counselor, click Delete on either the MBC Management dialog or the individual 
counselor dialog. You will be asked to confirm the request before the counselor is removed. 

 
8.3 Points of Contact (POCs) 
 

This provides a powerful tool for tracking information on people who are important to the 
operation of your unit but who are not necessarily adult members. District leaders are 
obvious examples, but the list also includes parents with specific skills or interests that could 
be helpful to the unit. 

 
a. POC Management. POCs are people whom you need to call upon from time to time but 

who are not necessarily members of the unit. This menu option allows you to add new 
POCs to the database and to edit/review data on existing POCs. The Add New and 
Edit/Review buttons access the same data entry dialog. Most data fields are self-
explanatory, but the “Category” and “Skills/Interests” fields provide special flexibility on 
reports.  

 
Because the types of people entered as POCs are frequently diverse, it is helpful to be 
able to group them into categories. You can define up to 20 different categories on the 
Define POC Categories dialog (see below). Then, when you add a new POC, simply 
assign him to a category from the drop-down list. The POC List report includes options to 
select a specific category or to group your POCs by category. You can create family links 
to the parents, adults, and merit badge counselors files. Please see Chapter 15 for more 
information on family links.  
 
The “skills/interests” fields are designed to handle parent resource information, but you 
will probably think of additional uses. You can enter up to 20 skills/interests for each 
POC. The POC List report includes options to search for POCs with specific 
skills/interests. TroopMaster comes with an extensive list of skills/interests but you can 
define others as needed. 
 

To remove a POC, click the Delete button on either the POC Management dialog or the 
individual POC dialog. You will be asked to confirm the request before the POC is removed. 

 
To review POCs assigned to a specific category, select the category on the POC 
Management dialog before clicking “Edit/Review”. The Next/Previous buttons will then 
take you to the next/previous POC in that same category. 

 
b. Define POC Categories. You can make your reports more flexible and useful if you 

group your POCs into categories. For instance, you could create categories for District 
Leaders, Religious Leaders, Troop Resources, etc. Then, when you add a new POC to 
your database, you can assign him/her to the appropriate category. 

 
c. Define Skills/Interests. Use this dialog to add new skills/interests to the system-defined 

list or to remove existing ones. 

 77



CHAPTER 9. FUNDRAISERS 
 
9.0 Overview 
 

TroopMaster will track information on any type of fundraiser that involves sales. You can 
track sales of individual products, dollar amounts due, and payments made by your scouts 
and adults. To help you get started, a popcorn sale is pre-defined. The popcorn prices listed 
are not official prices--please adjust those as necessary.  

 
9.1 Create/Edit Fundraiser 
 

This dialog is used to create a new fundraiser or modify an existing one. You enter a unique 
name for the fundraiser and the name/retail price of up to 24 products to be sold. You can 
optionally enter a wholesale price for each item (if you do, TroopMaster will use this to 
compute profit) and you can specify if the fundraiser allows unsold items to be returned. If 
you check the “Fundraiser in Progress” checkbox, TroopMaster will use this fundraiser as the 
default when you credit scout payments or generate reports. 

 
The Delete button lets you completely remove an old fundraiser. For annual fundraisers, like 
popcorn sales, the Erase Sales button lets you clear out the old sales and payment 
information so that the new sale can be started. The existing products and prices are retained, 
but all existing sales and payments are deleted. 

 
Be sure to print any desired reports before erasing sales or deleting a fundraiser. 

 
If you would like to retain fundraiser information from previous years, you could use the 
current year as part of the fundraiser name (e.g., “Popcorn 2008”). You can then create a new 
fundraiser called “Popcorn 2009” for the following year. However, the database is limited to 
50 fundraisers. 

 
9.2 Sales & Payments 
 

This dialog lets you enter product sales and payments made by each scout or adult. These 
include total quantities sold for each of the items in the fundraiser and, if allowed, any returns 
on those items. You can also enter the date and amount of each payment made be the 
member. The dialog also shows the “Total Paid”, “Total Amount Due”, and “Balance” for 
each member. In addition, there’s a field where you can designate each member’s prize or 
commission. 
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CHAPTER 10. Mic-O-Say 
 
10.0 Overview 
 

Use this option to record Mic-O-Say membership information on scouts and adults.  
 

Mic-O-Say is a program similar to Order of the Arrow for scouts in the Midwest. 
TroopMaster supports this program but if you don’t need this feature, uncheck the associated 
checkbox on the File>Preferences dialog and TroopMaster will remove these options from 
your menus the next time you start the program. 

 
The Mic-O-Say program varies somewhat between councils and, as much as possible, this 
feature was designed to handle those differences. Accordingly, there may be options that are 
not applicable to your tribe; for example, not all tribes have a “She-She-Be” council 

 
10.1 Adult Mic-O-Say 
 

In addition to date fields for Foxman, Brave, Warrior, and Honored Woman, TroopMaster 
has checkboxes to indicate membership in the Tribal Council and/or She-She-Be Council. 
TroopMaster also tracks up to six prior leadership levels. Whenever you enter a new level for 
an adult, TroopMaster automatically adds his previous position to his level history. 

 
10.2 Scout Mic-O-Say 
 

Mic-O-Say information on scouts is tracked in the same manner as for adults. 
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CHAPTER 11. ORDER OF THE ARROW 
 
11.0 Overview 
 

Use this option to record O/A membership information on scouts and adults.  
 
11.1 Adult O/A 
 

In addition to date fields for Election, Call Out, Ordeal, Brotherhood, and Vigil, TroopMaster 
provides fields for Vigil name, O/A leadership position, and remarks. TroopMaster also 
tracks up to six prior leadership positions. Whenever you enter a new leadership position for 
an adult, TroopMaster automatically adds his previous position to his leadership history.  

 
Special O/A Eligibility and O/A Membership reports are available. 

 
11.2 Scout O/A 
 

O/A information on scouts is tracked in the same manner as for adults. 
 

Special O/A Eligibility and O/A Membership reports are available. 
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CHAPTER 12. REPORTS 
 
12.0 Overview 
 

All system reports are included under this option. The reports are divided into 17 functional 
groups, each of which is described below. All reports are initially sent to the screen. Because 
“a picture is worth a thousand words,” only a brief description of each report is provided 
below. 
 
Most reports have several and often many different generation options. For example, the 
Individual Progress report lets you choose specific scout(s), all scouts in the unit, or all 
scouts whose advancement has changed since the last time you printed their reports. You can 
also elect to include an advancement summary and/or a list of partial merit badges. 
 
For each report, select the desired options and click OK. Displayed reports can be printed, 
emailed, or saved to a disk file.  

 
Many reports allow use of the “filtered selection” option for scouts, adults, etc. For more 
information on the use of this option and the associated “member groups” option, please see 
para 2.12 and para 4.4. 

 
See File>Preferences (para 3.17) for information on adjusting your page settings, mailing 
labels settings, fonts, colors, display scrolling, etc. 

 
All reports are initially displayed on the screen and the display is very flexible. For example, 
there’s a drop-down list at the top of the display dialog that allows you to zoom in or out on a 
report (you can also do this through the left/right mouse buttons). You can even elect to 
display two pages at the same time. The left/right arrow buttons on the dialog allow you to 
page the report, or you can use the Page Up/Down buttons on your keyboard. 
 
A tools button lets you modify the format settings for the report currently being displayed 
(you can permanently change the settings through File>Preferences). Other buttons allow 
you to print the report, email it, or save it to disk. If you elect to save the report to a disk file, 
the report is generated and written to a file you specify using any of three optional formats:  

 
(1) PDF - Select this format if you want to save your report as a PDF file. 
 
(2) Web Page (HTML) - select this format if you want to be able to review the report with 

your web browser. Most reports will display in your browser almost identically to the 
way they appeared in TroopMaster. However, matrix-style reports will lose their vertical 
and horizontal line separators. 

 
(3) Rich Text - Select this option if you plan to review and/or edit the report with your word 

processor. Most reports will display in your word processor almost identically to the way 
they appeared in TroopMaster. However, matrix-style reports will lose their vertical and 
horizontal line separators. 
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(4) Plain Text - Select this option if you plan to review the report with a simple text editor, 

such as Windows Notepad. Reports saved in plain text will lose most of their formatting; 
i.e., special fonts, point sizes, bold column headers, etc., will be dropped. Just the text 
itself will be saved to the file. 

 
TroopMaster remembers your current working folder and will use it as the default, but you 
can change that if you wish, and you can use any name you like for the report file.  
 
Several reports (e.g., Merit Badge Matrix, Attendance Matrix) are produced in a spreadsheet 
format with column headers at the top of the report. The default settings will print the column 
headers vertically to make them easier to read. However, if you are saving your report to disk 
or emailing it, you will need to specify the “Horizontal” table headers option when producing 
these reports. HTML, Rich Text, and plain text do not support vertical text. 

 
If you choose to email a report, TroopMaster will create a new message and attach the report 
in any of the three optional formats (i.e., PDF, HTML, Rich Text, or plain text) described 
above. It will then bring up the Send Email dialog (para 3.5) so that you can choose the 
recipients before sending it.  

 
You can easily email an entire set of individual member reports, one message/report per 
member. For example, you could generate a set of Individual Progress reports on all of your 
scouts and then email them to the scouts using almost the same procedure you use for 
sending a single report. However, in this case, when TroopMaster brings up the Send Email 
dialog, each of the scouts will already be listed in the “To” list box, and you will not be able 
to change the recipient list. When you click Send, TroopMaster will automatically create a 
separate message for each scout and attach that scout’s report to his individual message. For 
more information on sending email messages from TroopMaster, please see para 3.5. Since 
in this case there are multiple messages, the “Display message prior to sending” checkbox is 
deactivated. Therefore, if you want to add or change the text of the message itself, you must 
do that on this dialog before clicking Send. The email addresses that TroopMaster will use 
for each scout is based on the checkbox settings you’ve selected on the scout’s personal data 
dialog (para 5.1a(1) and para 5.1a(3)).  

 
12.1 Activities 
 

These options include all of the reports related to your unit activities, including camping, 
hiking, service projects, and user-defined activity types. 

 
Activity reports can be generated with or without specifying a date range. If no dates are 
specified, all activities of the selected type(s) will be included on the report. If only a “From” 
date is entered, activities on or after that date will be included. If only a “To” date is entered, 
activities on or before the “To” date will be included. 

 
Entries you may have made on the Set Priors dialog are not included on activity reports that 
use “From-To” dates because TroopMaster has no way of knowing when the “priors” were 
done. “Prior” amounts are included on the Unit Activity Totals report and can also be 
included on the Individual Participation and Individual History Reports. 
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a. Individual Activity Report. Select one or more activities and TroopMaster will print all 

activity information, including attendance and the text description, if any. 
 

b. Activities by Type. This report provides detailed tracking of a specific activity type. It 
lists all of the activities of the requested type for the specified time period and then 
optionally includes attendance matrices for scouts and/or adults. 

 
If you request an attendance matrix, the report is limited to a maximum of 63 activities. 
On the matrix, the date of each activity is listed vertically at the top of each column. The 
total attendance for each activity is listed vertically at the bottom of each column. 
Individual totals are shown on the right-hand side of the report along with an optional 
grand total. 
 
For camping and hiking, you can limit the report to backpacking activities through a 
checkbox at the bottom of the dialog. 

 
c. Activities List. This report chronologically lists all unit activities (calendar and non-

calendar) for the specified time period. You select the activity type(s) to be included and 
either activity amounts or attendance percentages. The total number of activities of each 
type is shown at the bottom. If desired, you can also include the text description of each 
activity. 

 
Whenever you enter or change attendance for an activity, an attendance percentage is 
computed based on the number of scouts attending divided by the number of scouts in your 
unit on the date you marked/changed attendance. That means that you’ll still get the same 
attendance percentage for an activity even if most of the original attendees later leave the 
unit. NOTE: For activities that were converted from data in a previous version of 
TroopMaster, the attendance percentage for each activity is based on the number of attendees 
divided by the number of scouts who were in your unit on the date the data was converted. 

 
d. Attendance Matrix. This report serves two purposes: (1) a data collection form to record 

attendance at unit activities, and/or (2) a report for viewing previously recorded 
attendance at activities. You can generate the report for scouts and/or adults and 
optionally include each member’s phone number. Other options allow you to include 
attendance totals for each column and to specify a report title. 

 
If you select more than one activity type on this report, you should also select the 
“Include activity type” option. This will make the report more meaningful. 

 
e. Backpacking Summary. Based on a time period you specify, this report lists backpacking 

totals for each scout/adult, including total nights camped and total miles hiked. In 
generating the report, TroopMaster looks for camps and hikes in your activity database 
for which the “Backpacking” checkbox is checked. The number of “Events” on this 
report is based on the number of camps for which the “Backpacking” box is checked. 
Backpacking should always be entered as a both a camp and a hike. 
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f. Individual Participation. This option generates a separate report for each scout/adult 
selected. Specify an optional time period and select the activity type(s) to include, and 
TroopMaster will list all qualifying activities that the selected scout(s) or adult(s) 
attended. Optional totals are provided at the bottom of the report. Attendance percentages 
and ratios are based on the number of activities of that type that the member attended 
versus the number that the member could have attended. If desired, you can limit the 
camps/hikes included to just backpacking events. If no dates are specified for this report, 
you can optionally include amounts listed in the Set Priors area.  

 
g. Participation Summary. This is actually a group of six reports, three for your scouts and 

three more for your adults. You can select amount totals, attendance ratios, or attendance 
percentages on one or more activity types. For each scout/adult, TroopMaster will print 
two figures (separated by a slash) for each of the selected type(s). The first figure is the 
total number of activities of that type that the scout/adult attended. The meaning of the 
second figure varies based on the report option you chose: 

 
(1) Amount Totals. The second figure is the total number of nights camped, miles hiked, 

service project hours worked, etc., for that activity type. For activities like meetings, 
the total amount is usually zero. 

 
(2) Attendance Ratios. The second figure is the total number of activities of that type that 

the scout/adult could have attended.  
 
(3) Attendance Percentages. The second figure is the first figure divided by the total 

number of activities of that type that the scout/adult could have attended, expressed as 
a percentage. In computing percentages for each scout, TroopMaster always ignores 
activities that were held before he joined your unit but you can optionally exclude 
activities that were held prior to his most recent date of rank—some units use this 
figure when evaluating his participation level for his Board of Review. If you’ve 
defined minimum percentages for your activity types (para 7.4), TroopMaster will 
flag scouts who failed to meet those minimums with asterisks.  

 
Unless you select the “ratios” option, you can elect to include a summary block at the 
bottom of the report. If you select “Amount Totals”, the summary can optionally show 
the total number of activities of each type and the total amount (e.g., 6 campouts for 12 
nights) that the unit held, or the total amounts by activity type for all of your scouts (e.g., 
the total number of nights that all of your scouts camped). If you select the “Attendance 
Percentages” option, the summary will show the total number of activities for each type 
that the unit held and the average attendance percentage for your members. 

 
If a scout/adult missed an activity but was either excused (para 7.1b(2)) or was not yet a 
member of your unit (based on his “Joined Unit” date), that activity will not be 
considered in his attendance ratios or his attendance percentages. 
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If you select the “Amount Totals” option, you can also include “Prior Totals”. If you do, 
any amounts that the member has entered in the Activities>Set Prior Totals area will be 
added to the amounts in your active database. This will be indicated by a plus sign next to 
the number of activities attended. For example, if a scout attended 7 campouts for a total 
of 14 nights but he also has 10 nights in the “Set Prior Totals” area, he would have 
“7+/24” in his “Camping” column. 
 

h. Tour Permit Assistance. This option makes it easy to produce a report that contains 
virtually all of the data needed for a Tour Permit. Your council may allow you to sign the 
official BSA tour permit form (to satisfy the legal requirements) and simply attach the 
TroopMaster report (to provide the details). You will enter the needed information on 
three tabs: 

 
(1) General Info. The fields on this tab are taken directly from the official form. Select a 

leader and an assistant from the drop-down list of your adult members. Enter the 
departure and return dates, the numbers of scouts/adults going, and the type of trip. If 
swimming/boating or climbing/rappelling are involved, list the leaders and their 
associated certificate dates. 

 
(2) Itinerary. For each leg of the trip, enter departure/destination points and the number 

of miles. If that leg involves an overnight stop, enter the location and indicate whether 
reservations have been made. Then, click Add Waypoint and TroopMaster will add 
it to the end of the list. If you need to insert a waypoint, highlight the immediately 
preceding waypoint before clicking Add. If you need to adjust the sequence of a 
waypoint, highlight it and click Move Up or Move Down. To delete a waypoint, 
highlight it and click Remove. TroopMaster automatically keeps a running total of 
mileage at the bottom of the dialog but you can manually enter a total, if desired. 

 
(3) Transportation. Use this tab to select your drivers/vehicles and to select the mode(s) 

of transportation to be used. The “Driver” drop-down list contains all of the adults 
and parents who have vehicle information in their records. When a driver is selected, 
the “Vehicle” drop-down list contains that person’s vehicle(s) plus the unit vehicle (if 
any). Select each driver and vehicle, enter the number of passengers, and click Add 
Vehicle. To delete an entry, highlight it and click Remove.  

 
TroopMaster will save any information entered for a Tour Permit Assistance report until you 
click the New Tour Permit button. This allows you to get started on your tour permit well 
before the date it must be submitted. The New Tour Permit button erases all existing entries. 

 
i. Unit Activity Totals. For the activity type(s) selected, TroopMaster lists grand totals for 

scouts or adult leaders. The totals include all activities in your active database plus any 
“prior” amounts (para 7.3) for each type. If you include “Camping” but you just want tent 
camping totals, un-check the “Include cabin camping” box. 

 
For all activity types, the figures represent the total “Amount” for each type (i.e., nights 
camped, miles hiked, etc.). These figures do not represent the total number of activities 
attended. For example, the amounts for meetings are usually zero. 
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j. Unit Calendar. This report includes all of your scheduled calendar activities for the 
specified type(s) and time period. This report can be generated either as a list-type report 
with activities grouped by month, or in a one-page-per-month, “wall-calendar” format. 

 
If your unit has a “theme of the month,” limit the report to the appropriate time period 
and enter the theme in the field provided. TroopMaster will include your theme as a sub-
header on the report. 

 
12.2 Adult Members 
 

Reports specific to your adult members are in this area. Reports that can also include scouts, 
such as the Annual Recharter report, Medical/Special Needs report, custom reports, and 
reports related to activity attendance, are on other reports menus. You can include all of your 
adult members on these reports, limit them to just unit leaders or just non-leaders, or use a 
filtered selection (para 2.12). 

 
a. Individual Personal Data. This report lists all of the personal data on a selected adult. It 

also includes special awards earned and training courses completed. 
 
b. General Purpose Worksheet. This extremely flexible worksheet can be used for a 

multitude of purposes. For example, you could use it as a data collection worksheet by 
giving it a title and defining one or more column headers. Optionally, you can choose to 
include selected items from the adults data file, such as dates of birth or current 
leadership positions. You can specify 5-column or 10-column options, but if you need a 
large text column, one of the options on the database drop-down list is “Use rest of line”. 
If you select that option, that column will extend to the edge of the report. 

 
If you think you might use the same worksheet again, click the Save button and assign it 
a file name. Then, the next time you need the worksheet, just select it from the drop-
down list. If there’s a saved worksheet that you no longer need, select it from the list and 
click Delete. 

 
c. Having/Needing Awards/Training. This is a group of four reports that provide lists of 

adults who either have or need a specific training course or special award. Choose an 
award or course name from the menu or type a name in the “Other” field.  

 
When you request the “Needing Training” report, you can optionally include adults whose 
training is old. To do that, click the “Include adults who need retraining” checkbox and enter 
a date in the “Earlier than” field. The report will then include all adults who’ve never had the 
training plus those whose completion dates are earlier than the date you specify. 

 
BSA has not established expiration periods for any training courses but if your local council 
has, you can enter those through the Adults>Adult Members>Define Training option. If you 
do, adults whose training has expired will be flagged with a pound sign on Adults Having 
Training reports. If you check the “Include adults who need retraining” box on the Adults 
Needing Training report, TroopMaster will automatically compute an expiration date for the 
“Training earlier than” date field. For example, if the course has a 2-year expiration period 
and you run the report on 7/2/09, TroopMaster will enter a date of 7/2/07. 
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 For Adults Needing Training, you can optionally choose to contact, either through email 
or postal mail, the adults who need the training. If you do, then when you close the 
report, TroopMaster will display either the Send Email dialog or the Adult Mailing 
Labels dialog, as appropriate. If you send the message or print the labels, only the adults 
who were listed on the report will be included. 

 
d. Leader Phone List. This report lists your adults' names, addresses, phone numbers, and 

leadership positions. Email addresses can optionally be included. O/A members are 
flagged with asterisks. 

 
e. Training List. For each adult, this report lists all of the training courses completed and the 

associated completion dates. It also shows email addresses and home phone numbers. 
 
f. Training Matrix. This option generates a spreadsheet report of selected adults along with 

the completion status for each of the selected training courses. This report makes it easy 
to see which adults need specific training courses. Training completion is marked with an 
“X”. If an adult’s training has expired (para 12.2c), the course is marked with a pound 
sign (“#”). 

 
g. Training Status Details. For each of your adults who holds a leadership position, this 

report shows the position, effective date, and training status with respect to the training 
courses required to be fully trained for that position. If an adult holds more than one 
position, he will be listed once per position. A legend at the bottom explains the meaning 
of the training status codes. The report also shows the percentage of the unit leaders who 
are trained and the percentage partially trained.  

 
 BSA “grandfathered” some courses so, for example, an adult who completed 

ScoutMastership Fundamentals (S21) will be marked as trained regardless of whether any 
of the newer courses have been completed. 

 
h. User Defined Fields/Remarks. This option provides a powerful way of producing special 

reports on your adults. TroopMaster lets you select any or all of the user defined fields 
from the adult personal data display (para 8.1a(1)(d)). The report then lists each of your 
adults and the selected data item(s). 

 
Use this option to produce reports that are not otherwise available in TroopMaster. For 
example, you could define a field for hobbies and then print a “Leader Hobbies” report. 

 
12.3 Awards/Advancement 
 

These are the most versatile and powerful reports in the system. All individual and unit-level 
reports related to scout awards and advancement are contained in this area. 

 
a. Advancement Status Report. This report provides a complete and very concise summary 

of the advancement status of your unit. For each scout, TroopMaster will print a one-line 
list of requirements remaining for his next rank. Requirements are heavily abbreviated 
but you can include a legend at the bottom of the report. Scouts can optionally be 
grouped by patrol, by rank, or by early/senior ranks. You can even select a specific patrol 
or rank. 

 87



b. Board of Review Report. This report is designed for scouts who are ready for a Board of 
Review (Tenderfoot through Eagle Palms) based on today’s date or on a future date that 
you specify. Scouts who still need “Scout Spirit” and/or “Scoutmaster Conference” can 
also be printed, since those items are often completed on the same night as the Board. 
The report provides all of the information needed by the board members, including a list 
of specific requirements completed, advancement remarks, prior rank advancements, and 
merit badges earned to date. The report also includes a certification block in which to 
record the results of the board. If the scout is ready for more than one board (e.g., 
Tenderfoot and 2nd Class), two reports will be printed.  

 
c. Court of Honor Report/4403. This report provides everything you need to set up your 

Court of Honor (except the cookies-we’re still working on that!). Report options include 
rank badges, merit badges, special awards, O/A recognition, training, and service stars. In 
addition to the required “From-To” dates, there are three options related to the use of the 
“Reported/Presented” flags (para 6.3) that govern which awards will be included on the 
report. Included awards can optionally be grouped by recipient or by award type/name. 

 
There are three main sections of this report: the Court of Honor itself, the Awards 
Summary, and the Unit Advancement Report (4403). Each of these sections can be 
selectively turned on or off. 

 
(1) Court of Honor. This section lists your scouts and qualifying awards based on your 

selection criteria. Following the list of scout awards, TroopMaster includes a list of 
special awards and service stars earned by your adults. 

 
(2) Awards Summary. This section provides a “shopping list” of awards you need to 

support the Court. You can optionally include award item numbers for your council 
store. 

 
(3) Unit Advancement Report (4403). This section is a facsimile of the BSA Form 4403. 

The BSA National Council has authorized local council offices to accept computer-
generated substitutes for the Form 4403. If you select the “Print three copies” option, 
TroopMaster will label them as “Council”, “District,” and “Unit” copies. Sign the 
council and district copies and submit them to your council office. 

 
If your council office is on-line with the ScoutNET computer system, select the 
“ScoutNET” option and, in addition to the paper report, TroopMaster will also create 
an ASCII delimited file on diskette, which you can then submit to your council. The 
council will be able to import your advancement data from this diskette directly into 
ScoutNET. The council will still want a signed copy of the paper report certifying its 
accuracy. 

 
The ScoutNET electronic file is in a special format for use with the ScoutNET system. If 
you open this file manually to view its contents before submitting it to your council 
office, please do not save the file when you are finished viewing it. Many spreadsheet 
programs (e.g., Excel) will save the file in a slightly different format even if you have 
not modified the file. These changes will render the file unusable by ScoutNET. 
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If your local council office requires you to report the names of the counselors who 
taught the badges listed on the Form 4403, check the “Include MB Counselors 
Certification Worksheet” option. TroopMaster will then generate an addendum report 
that lists each badge earned along with the name and BSA ID number of the 
associated counselor. 

 
If you select the “Print labels for MB/rank cards” option, TroopMaster will print stick-on 
labels for the ranks and merit badges. You can attach these labels to the award cards instead 
of having to fill them out by hand. Signatures are still required. The default label size is for 
Avery 5160’s but you can adjust that, if desired. The Avery 6570’s are more appropriately 
sized for the cards, and that’s one of the options on the “Page Settings” tab of the 
File>Preferences dialog. Since the 6570’s are much smaller, you should also go to the 
“Report Fonts” tab and reduce your mailing label point size to 8 or 9. 
 
Award Cards - If you select the “Print Award Cards” option, TroopMaster will print award 
cards on perforated card stock available from Troopmaster Software for the ranks, special 
awards and merit badges. TroopMaster will include all of the information on the scout and 
award so that all you will need to do is sign the cards.  
 
Click ‘Award Card Settings’ to align your cards, to select the type of cards to be printed, and 
to select an image for each card. For instructions on aligning your cards please go to 
http://www.troopmaster.com/cards. Since we can not provide you with specific BSA artwork 
we have given you the ability to select your own images for each card type. To activate an 
award card type, check the box for that award and then select an appropriate image file to be 
used on the card. This can include scanned images that you have saved to your hard drive or 
any other type of images that you would like to use for that award card. If you already have 
an image selected for an award but would like to change your image to another image simply 
click on the image you would like to replace. 
 
Many images you may find on the web (or other places) are copyrighted material. You 
should check to make sure that any images you choose to incorporate are either 
copyright free or you should obtain the necessary rights to use these images. 

 
To get an end-of-year summary of all the awards earned by your scouts, run this report using 
a “From-To” period for your whole charter year and check the “Awards summary only” 
checkbox. If you have archived scouts who left the unit during the year, go into the archive 
and print another report for the same time period. Add the totals from the two reports to get 
your grand totals! 

 
If you would like to transfer the award information to a spreadsheet or database management 
system, check the “Create tab-delimited export file” option. After the report has been 
generated, TroopMaster will create and save an awards file to a location you specify. The 
data can then be easily imported from that file into another software package. 

 
After you have printed or saved the report, TroopMaster will ask if you want to update 
the “Reported/Presented” flags for all awards included on the report. When you 
generate the final copy of the report for submission to your council, you should update 
the R/P flags.  
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If you choose to update the ‘Reported’ flags, TroopMaster will remember the time period 
used. The next time you display this dialog, TroopMaster will use the “To” date of the 
previous report (plus one day) as the default “From” date for the next report. 

 
If you check the “O/A recognition” option, TroopMaster will lists scouts and adults who 
completed Ordeal, Brotherhood, or Vigil during the time period of the report. Since these are 
recognition only, they won't be included on the Awards Summary. 

 
The scout equipment catalog has service stars for years 1-10, 20, 30, 40, 50, 60, and 70, so 
intermediate years are not included on the Awards Summary. For recognition purposes, they 
are still included on the main report. 

 
d. Individual History Report. This is one of the most flexible reports in the system, allowing 

you to choose exactly what data to include. For example, you can select any or all of the 
rank badges (including Palms). There are numerous other options, such as including O/A, 
special awards, training, leadership history, etc. If you want to save paper, select the 
“Omit details on completed ranks” option and TroopMaster will list only the completion 
dates for completed ranks. You can generate reports for all scouts, selected scouts, or a 
single scout. Optionally, you can group the reports by patrol or rank. 

 
TroopMaster automatically monitors changes you make to each scout's advancement records. 
One of the options allows you to print this report for all scouts whose advancement has 
changed since their reports were last printed/emailed. 
 
Whenever a scout leaves the unit, select the “Include signature block” option and print two 
copies. Sign the verification block on both copies. Then, give one copy to the scout to carry 
with him to his next unit and put the other copy in a permanent history file. If the scout is 
transferring to another unit that is using TroopMaster 2008 or newer, you can also transfer 
his data electronically (para 5.11) 
 
e. Individual Progress Report. This report provides an easy-to-read summary of 

requirements for the rank toward which the scout is currently working. If Eagle-required 
merit badges are needed, this report will tell you how many and which ones. If he hasn’t 
completed his “Service Project” requirement, the report shows how many more hours are 
needed. The “Position of Responsibility” and 2nd/1st Class “Activities” requirements are 
handled in a similar manner. The report optionally includes a list of prior rank 
advancements and an alphabetized list of merit badges earned to date. Advancement 
remarks and partial merit badges can also be included. Optionally, you can group the 
reports by patrol or rank. 

 
We recommend that you send out copies of this report at least quarterly so that the scouts 
and their parents can review them. A complete alphabetized set can be obtained using the 
“All Scouts” option. These can be mailed home using the mailing labels capability, 
emailed (para 12.0), or distributed at Courts of Honor. Letting scouts see their current 
status also provides an unexpected side benefit. After reviewing their reports, scouts 
frequently come and tell you of awards or requirements they completed some time ago 
but forgot to mention! 
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TroopMaster automatically monitors changes you make to each scout's advancement records. 
One of the options allows you to print this report for all scouts whose advancement has 
changed since their reports were last printed. 

 
f. Merit Badges Earned. This report normally lists all of the merit badges a scout has earned 

but you can limit the report to a specific time period, if desired. Badges can be sorted 
alphabetically, chronologically or grouped by rank. If you request more than one scout, 
you can print each scout on a separate page or print a sequential listing. If desired, you 
can include the names of the counselors who taught each of the badges. 

 
g. Merit Badge Matrix. This report lets you select a set of merit badges and produce a 

spreadsheet-type report that lists your scouts and whether or not they have completed 
each of the selected badges. The report will also show you if a scout is currently working 
on any of the badges. A quick selection button lets you highlight all of the Eagle-required 
merit badges, or you can manually select desired badges.  

 
This report can be very helpful when planning for summer camp. 

 
h. Partial Merit Badges List. This report lets you review your partial merit badge data in two 

different ways. The first option groups the badges by scout; i.e., the scout's name is 
printed followed by the badges on which he is working. The second option lists the merit 
badges and for each badge, lists the scouts who are working on it. Several other options 
control the level of detail to include. 

 
 If a scout starts a merit badge under one set of requirements and then BSA changes the 

requirements, the scout can optionally finish the badge under the old requirements. In 
order to handle that, TroopMaster has a Modify MB Reqts button on each scout’s 
Partial Merit Badges dialog (para 6.10). The Partial Merit Badge Requirements dialog 
has a “Year” field in which you can enter the publication year of the associated “Boy 
Scout Requirements” booklet for each badge. In addition to listing requirements 
remaining for each badge, this report also shows the publication date of the booklet that 
the scout is using. If TroopMaster is not sure, it prints a question mark. 

 
i. Partial Merit Badge Matrix. This report lets you select a specific badge and produce a 

spreadsheet showing which requirements have been completed by the scouts working on 
it. If a scout is working on the badge using a different set of requirements than the ones in 
TroopMaster’s system list, he will not be included in the matrix but he will be listed 
under the matrix along with a list of the requirements he has remaining for the badge. 

 
You can add or update a partial merit badge for a group of scouts all at once through the 
Advancement>Group Credit>Merit Badges option. 

 
j. Rank Badge Matrix. This is a spreadsheet-type report that lists your scouts and for each 

scout shows the dates he completed each of his ranks. Optionally, you can include “time-
to-rank” averages that show in months/tenths the average time it took for scouts in the 
matrix to advance to each of the ranks. This report can also be grouped by patrol. Please 
see Appendix F for an explanation of how the average times are computed. 
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k. Rank Badge Summary. This report lists all of the rank advancements earned during a 
specified time period, grouped by badge. If you don’t enter a time period, all rank 
advancements are included. 

 
l. Scouts Having/Needing. This is actually a group of several different reports. In addition 

to providing lists of scouts having or needing a specified merit badge, special award, or 
training course, you can also get lists of scouts who have not yet completed their “Service 
Project” or “Position of Responsibility” requirements. 

 
If you request a list of scouts needing a specific merit badge, special award, or training 
course, TroopMaster will print all scouts who have not yet earned the specified item. For 
merit badges, the report will indicate whether or not the badge can be applied to each 
scout's next rank, and whether or not the scout has started the badge. These reports are 
very useful in organizing a merit badge or special award class and in planning campouts. 

 
The Scouts Needing Camping MB is a special report. The badge requirements state that a 
scout needs 20 nights of camping, not including cabin camping. Also, the 20 nights can 
include no more than one week of summer camp. TroopMaster considers all of these factors 
in computing “Nights Remaining” for each scout. Therefore, a scout could have over 20 
nights total camping but still have nights remaining on this report. 

 
The Scouts Needing World Conservation Award is a special report that shows the status of 
each scout regarding completion of merit badges required for this award (i.e., Citizenship in 
the World, Environmental Science, and either Fish & Wildlife or Soil & Water). 
TroopMaster also provides a World Conservation Application report option (para 12.3s). 

 
The Service Project report lists 1st Class and Star scouts and scouts below 2nd Class who 
have not completed their service project requirements. This report is useful in planning 
service projects and can also be given to Life scouts when they begin planning their 
Eagle projects. Because of the special nature of Eagle projects, Life scouts are not 
included. If you are tracking service project hours in the activities area of the program, 
this report will tell you how many hours each scout still needs to complete the 
requirement. 
 
The Position of Responsibility report provides a list of all 1st Class, Star, and Life scouts 
who have not yet completed this requirement for their next rank. A “Days Remaining” 
column shows how much time each scout still needs. An asterisk will be printed next to 
the name of each scout who is currently serving in a valid position for the requirement.  

 
When you have unit elections, give a copy of this report to the new senior patrol leader so 
that he can assign these scouts to staff positions. 

 
When you request the “Needing Training” option, you can choose to include scouts whose 
training is old or expired. To do that, click the “Include scouts who need retraining” 
checkbox and enter a date in the “Earlier than” field. The report will then include all scouts 
who have never had the training plus those whose completion dates are earlier than the date 
specified. 
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m. Scouts Not Advancing. This report lists all scouts who have not advanced since the date 
or time period you specify. Scouts are sorted from the oldest rank advancement to the 
most recent, providing a prioritized list of scouts who need to be counseled. Eagle scouts 
are not included. Optionally, you can group the scouts by patrol. 

 
n. Target Eagle. This option will produce a spreadsheet report on all scouts working on the 

upper ranks (Star, Life and Eagle). If desired, you can also include scouts below First 
Class. For each scout, the report shows which requirements have been completed toward 
the three ranks. The last column of the report shows the number of months remaining 
before each scout turns 18. 

 
You can create the TroopMaster equivalent of the BSA advancement wall chart by 
generating this report in landscape format (the default) and including scouts below First 
Class. Then, generate the Target 1st Class report with Tenderfoot, 2nd Class, and First Class 
selected and the “Include scouts who have completed selected requirements” box checked. 
Lastly, paste the two reports together. 
 
o. Target First Class. This report provides a spreadsheet-type status of the scouts below 1st 

Class and where they stand on early rank requirements. Dialog buttons let you quickly 
select the Citizenship/First Aid, Outdoor Skills, and/or Physical Fitness/Personal 
Development skill groups. The column header buttons will highlight all of the 
requirements in their respective columns. You can also manually select requirements with 
your mouse. Up to 64 requirements can be included on a single report. You can print the 
requirement definitions and the number of scouts needing each requirement at the bottom 
of the report. You can also optionally include scouts who have completed all of the 
selected requirements (see hint above). 

 
p.  Merit Badge Applications/Blue Cards. Use this option to generate the “blue cards” that 

you must give to scouts when they start work on a merit badge. Highlight the names of 
the scouts who are starting a badge and then select the badge from the drop-down list. If 
the counselor who will teach the badge is in your database, select him from the drop-
down list; otherwise, select “To be determined”. Lastly, enter the badge starting date and 
click Add. If you make a mistake, highlight the scout and click Remove. 

 
 You can repeat this process as many times as needed until you’ve selected all of the 

scouts and badges for which you need applications; i.e., you don’t have to run this option 
separately for each badge that will be taught. The list box at the bottom of the dialog lists 
all of the scouts you’ve selected and the badge each scout will start. Scouts who are 
starting more than one badge can be listed more than once. 

 
 While TroopMaster cannot print on the actual BSA “blue cards (Form #34124), you can 

print the applications on paper or blank card stock, such as Avery 5390’s. If needed, you 
can adjust margins, card sizes, spacing between cards (gutter spacing), etc. 

 
 When all of your scouts/badges are listed, click OK. TroopMaster will print one side of 

the sheets and then stop and wait for you to reinsert the paper or card stock into your 
printer. You must reinsert the pages in the correct order and using the correct alignment; 
otherwise, the back sides of your applications will not match the front. 
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We recommend that you practice generating a few applications on plain paper so that you 
can learn the proper way to reinsert the pages on your printer. 

 
 
q. Eagle Application Assistance. When a scout is ready for his Eagle Board of Review, this 

report will help him complete the application. It prints all of the available information in 
the same order as it appears on the application. Your council will expect the scout to 
submit the official application, not this assistance report. 

 
r. Palm Application Assistance. This option generates a facsimile of the BSA Palm 

Application for Eagle scouts who have finished all of the requirements for one of the 
Palms. Your council may accept this facsimile in lieu of the official application. 

 
s. World Conservation Application. This option generates a facsimile of the World 

Conservation Award Application for scouts who have finished all of the requirements for 
this award. Your council may accept this facsimile in lieu of the official application. 

 
t. Eagle Honor Roll. This report will produce a list of Scouts who have earned Eagle with 

your unit. Whenever a scout is promoted to Eagle, you will be asked if you want to add 
the scout to the Eagle Honor Roll. You can enter Eagle scouts manually using the 
Advancement>Eagle Honor Roll option. 

 
12.4 Duty to God 
 

These reports are available only if the “LDS Unit” box is checked on the Unit General 
Information dialog. 
 
a.  Duty to God Certificate. It allows you to get an individual report on any scout for any of 

the three certificates. If you select the “Default Certificate” option, TroopMaster will 
generate the appropriate certificate for each of the selected scout(s) based on each scout’s 
age. Eleven year olds will automatically be excluded. 

 
b.  Duty to God Progress Matrix. This very flexible report lets you see the status of selected 

scouts against any of the requirements for any certificate. The data is presented in a 
spreadsheet format. The matrix is limited to 65 columns so you cannot include all seven 
groups of requirements for any given certificate. However, you can select all of the 
“Duties and Activities” items, or all of the “Personal Goals”, or a selected combination of 
the two. You can also include a legend that provides a detailed description of each 
requirement. We recommend that you use the troop, team, and crew Member Groups 
when selecting scouts for this report. Doing that allows you to limit a specific matrix 
report to just the scouts working on that certificate. 

 
12.5 Fundraiser 
 

This set of reports provides you with full details on all sales and payments associated with a 
particular fundraiser. 
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a. Individual Sales. This report provides details on all items sold by a selected scout or 
adult, including the total dollar amounts associated with those sales. It also lists any 
payments the member has made, and it calculates the balance due, if any. If desired, you 
can include a signature block for the member to acknowledge receipt of the products. 

 
b. Payment Summary. For each scout or adult, this spreadsheet-type report shows payments 

made, total amount due, and outstanding balance, if any. Unit totals are listed at the 
bottom of the report. Optionally, you can include member phone numbers, email 
addresses, and payment dates. Scouts can be grouped by patrol. 

 
c. Sales Matrix. This produces a spreadsheet-style report that shows the quantity sold by 

each member for each item in the fundraiser. It also calculates total sales by member and 
by item. The latter figures tell you how many items of each type you will need to fill the 
orders. If you include scouts and adults, TroopMaster will optionally calculate total unit 
sales. If you entered wholesale prices for each of the items, TroopMaster will also 
compute your unit’s profit. Scouts can be grouped by patrol. 

 
12.6 Labels/Envelopes 
 

TroopMaster lets you print mailing labels and envelopes for your scouts, adult members, 
POCs, and merit badge counselors. Scout labels are available in six different formats. You 
can also print custom mailing labels as well as unit return address labels. Optionally, you can 
include adult leader labels whenever you request scout labels. For scouts, you can also 
include labels for alternate relatives and/or group the labels by patrol. For scouts and adults, 
TroopMaster normally uses mailing address if the member has one; if not, it uses street 
address. However, you can elect to always use street addresses. 
 
TroopMaster also provides a “Custom Fields” option for scouts/adults that lets you print 
labels with the member’s name plus selected items from the database. Choose the member 
type (scouts or adults). Then, select the desired data items from the drop-down lists and click 
OK. 

 
You can adjust label alignment via the Page Settings tab on the File>Preferences dialog. 

 
When printing envelopes, in addition to setting the envelope size within TroopMaster, you 
must also use your printer Properties dialog to set the envelope size and print orientation for 
your printer itself. There’s a button for this on the TroopMaster Print dialog. 

 
When printing scout/adult labels, you can choose to print only one label per household. For 
this feature to work, you must first create links between related members in your database. 
For more information on family links, see Chapter 15. 

 
The “Custom Labels” option lets you print labels for special mailings. You specify the 
name/address to be printed and the number of copies. For example, you could use this feature 
to print personal return address labels for your Christmas cards! 

 
12.7 Merit Badge Counselors 
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Reports in this group help you manage and more effectively utilize your MB counselors. 
 

a. Individual Personal Data. This is a single counselor report that includes all of the data on 
a selected counselor, including the badges he teaches. 

 
b. Cross Reference. This report consists of two parts. The first is a numbered, alphabetical 

list of your counselors that includes addresses, phone numbers and/or email addresses. 
The second is an alphabetical list of merit badges with the corresponding numbers of the 
counselors who teach them. The two listings together provide a cross-reference for 
locating counselors for any specific merit badge. This report provides the same 
information as the “Grouped by Badge” report below, but it uses less paper. 

 
c. Detailed Listing. This report lists all of the data on each of your counselors, including the 

badges they teach. 
 
d. Grouped by Badge. This is the easiest report for locating a counselor for a specific merit 

badge. Badges are listed alphabetically with the associated counselors’ names under each 
badge. Optionally, you can include addresses, phone numbers and/or email addresses. 

 
e. Merit Badges with No Counselor. This lists all of the badges for which you have no 

counselor. Outdated badges are excluded. 
 
f. Specific Merit Badge. For this report, you specify a badge and TroopMaster lists all of 

the counselors who teach it. You can include addresses, phone numbers and/or email 
addresses. 

 
g Training Status. This report lists your counselors along with their phone numbers and 

completion dates for MBC Orientation Training and Youth Protection Training (YPT). 
By default, fully trained counselors are excluded but you can elect to include them, if 
desired. Email addresses are optional. 

 
If desired, you can treat counselors as untrained if their YPT training has expired. To do 
that, check the “Include counselors who need YPT retraining” box and enter an “earlier 
than” date. For counselors who completed YPT earlier than that date, TroopMaster will 
treat their training as expired, and their training completion dates on the report will be 
flagged with pound signs (#). 

 
12.8 Mic-O-Say 
 

Mic-O- Say is a program similar to Order of the Arrow for scouts in the Midwest. Please see 
Chapter 10 for more information. 

 
a. Adult Individual Member. This report includes all of the data from the Mic-O-Say 

member dialog for the selected adult.  
 
b. Scout Individual Member. This report includes all of the data from the Mic-O-Say 

member dialog for the selected scout. 
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c. Mic-O-Say Membership. This report lists all of the Mic-O-Say members in your unit. It 
includes dates for Foxman, Brave, Warrior, and Honored Woman, as well as Mic-O-Say 
leadership levels and remarks. Optionally, you can include Foxmen who have not 
attained Warrior status. Other options allow you to include scout and/or adult dates of 
birth and to list members by Mic-O-Say group. 

12.9 Order of the Arrow 
 

This group includes all of your O/A reports. 
 

a. Adult Individual Member. This report includes all of the data from the O/A member 
dialog for the selected adult. 

 
b. Scout Individual Member. This report includes all of the data from the O/A member 

dialog for the selected scout. 
 

c. O/A Eligibility. This report lists all of your scouts and adult leaders who are not O/A 
members. You can optionally include only members who are currently eligible (i.e., meet 
all O/A eligibility criteria), or you can include all non-O/A members and view each 
member’s current status toward eligibility. 

 
To be eligible, scouts and adults under 21 must have earned at least the 1st Class badge. 
All scouts and adults must have experienced 15 nights camping during the two-year 
period prior to the election. The 15 nights must include one, but no more than one, long-
term (five or six nights) camp. In accordance with the O/A Guide for Officers and 
Advisers, the balance of the 15 nights must consist of overnight, weekend, or other short-
term camping. Camping nights from the Set Prior Totals area are not counted since 
TroopMaster has no dates associated with them. Optionally, cabin camping can be 
counted toward eligibility—there’s a checkbox that allows you to do that. By default, 
TroopMaster counts camps lasting five nights or longer as “Long term” but it you want 
backpacking to be counted as “short-term” regardless of length, check that box. 
 
If desired, you can generate the Unit O/A Election report as an addendum. Use this to 
record the results of the vote, and submit the signed report to your O/A Lodge.  

 
d. O/A Membership. This report lists all of the O/A members in your unit. It includes dates 

for O/A Election, Ordeal, Brotherhood, and Vigil, as well as O/A leadership positions 
and remarks. As an option, you can list all recently elected scouts and adults who have 
not yet completed their Ordeal. Other options allow you to include scout and/or adult 
dates of birth and email addresses. 

 
12.10 Points of Contact 
 

There are two reports available. 
 

a. Individual Personal Data. This report includes all of the data from the POC dialog for the 
selected individual. 
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b. POC List. The standard report lists all of your POCs sorted by name or position and 
optionally grouped by category. However, if you select “Filtered Selection” from the 
“Include” pull-down list, this can be one of the most flexible reports in the system.  

 
 
Through the filtered selection options (para 2.12), you can list information on your POCs 
alphabetically, grouped by category, or for a specific category. POCs can be sorted by 
name or position. You can even search for specific skills or interests and have 
TroopMaster look for a match on any or all of your entries. If desired, POC remarks can 
be included. 

 
12.11 Scout/Unit General 
 

This group includes a wide variety of rosters, phone lists, and general information reports. 
 
a. Individual Personal Data. This report lists all of the personal data on a selected scout. A 

blank report is available for data collection (see Reports>Forms). 
 

b. Scout Leadership History. This report allows you to produce a list of all of the leadership 
positions in which each scout has served, including his current position(s). This is useful 
at election time to see which positions each scout has not yet experienced. 

 
c. Scout Leadership Roster. This report lists all of your scouts who currently hold a 

leadership position. It groups the scouts into three sections on the report. The first section 
contains the main unit leaders (i.e., SPL, ASPL). The second section lists all of the Patrol 
Leaders and Asst Patrol Leaders. The last group contains all other scouts who have a 
position of responsibility. You can optionally include a list of vacant leadership positions. 

 
d. Scout Training List. For each scout, this report lists all of the training courses completed 

and the associated completion dates. It also lists email addresses and home phone 
numbers. 

 
e. User Defined Fields/Remarks. This option provides a powerful way of producing special 

reports on your scouts. TroopMaster lets you select any or all of the user-defined fields 
from the scout personal data dialog. The report then lists each of your scouts and the 
selected data items. 

 
Use this option to produce reports that are not otherwise available in TroopMaster. For 
example, you could define fields #1 and #2 for hobbies and special interests and then print a 
“Hobbies and Special Interests” report. 

 
f. Birthday List. This report groups your scouts and adult leaders by birth month and shows 

the age each scout will be on his next birthday. Adults’ ages and years of birth are not 
listed (you’re welcome!). 

 
g. Council Recharter/Annual Recharter. If your council office is on-line with BSA’s 

ScoutNET computer system, this option allows you to generate your annual recharter 
report and write that report to an ASCII delimited file on diskette, which you can then 
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submit to your council office. The council will be able to import your data from this 
diskette directly into ScoutNET. TroopMaster will also print an associated paper report 
with signature blocks for you to certify the accuracy of your submission. Both the 
diskette and paper report must be submitted. 

 
Most of the data used to generate the report is obtained from the Unit General 
Information dialog and the scout/adult personal data dialogs. You will enter the rest of 
the necessary information using two other dialogs: 

 
(1) Recharter Information. This is the basic information needed to generate the report. It 

includes the old charter expiration date (obtained from the Unit General Information 
dialog) and the new expiration date, as well as your meeting day, frequency, and time. 
Some units have an official number that is different from the one they commonly use, 
so you can change the number here, if necessary. The unit term is usually 12 months, 
unless the unit is new or the council is restructuring their recharter alignment. The 
“Pricing” figures list the costs that were in effect when this version of TroopMaster 
was released. These can be adjusted as changes occur. This dialog includes 
checkboxes for Leader Trained, Quality Unit, 100% Boys Life, and Bulk Mailing. If 
your council prefers to have mailing addresses on the paper report, you can optionally 
select that. Both street addresses and mailing addresses are always included in the 
electronic transfer file. 

 
Some councils require an additional $1.00 for insurance. However, insurance is not part of 
ScoutNET, so you must handle that through your local council separately  

 
When you have completed your entries on this dialog, click Next to proceed. 

 
(2) Recharter Selection. This dialog is used to select the scouts and adults who will be 

chartered and to indicate each member’s charter status. For example, highlight the 
names of the scouts you plan to register and click the Paid button. Other charter 
status buttons allow you to mark members as Transfer, Multiple, or Non-
registering. Please consult your BSA unit renewal instructions for specific guidance 
on each of these status codes. To clear an entry for a specific member, highlight the 
name and click Clear Charter Code. Radio buttons allow you to switch the selection 
list between scouts and adult leaders. 

 
Only adults who have been assigned at least one leadership position are included on the 
selection list. If an adult is assigned to multiple leadership positions, he will appear in the list 
more than once unless the positions have the same two-character BSA position code. This 
allows you to choose the position(s), if any, in which the adult will be chartered. 

 
BSA recharter rules require that you charter adult leaders in certain key positions based on 
the type of unit being chartered, but you rarely have to charter all of the adults in your unit. 
Please read Appendix E. If you have questions, consult your Unit Commissioner. 

 
One of the key adult leader positions is "Executive Officer" and you must select this person 
for rechartering. This position used to be called "Institutional Head" (hence the position code 
of “IH”). The Executive Officer does not have to pay. He is always chartered as a "Multiple". 
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Please do not use the “Non-registering” status code for adults who are not being registered. 
Usually, you should just skip over adults whom you don’t plan to register (i.e., leave their 
charter status blank). “Non-registering” is for rare cases where you have an adult whom 
you’re not going to register, but for whom you want to send data anyway.  
Boy’s Life status can be adjusted on the fly by highlighting the scout or adult and clicking 
the column header button. The default setting is taken from the “Boy’s Life” checkbox on 
each scout/adult personal data dialog. However, your recharter selections are always saved 
for 60 days so if you start your recharter and later update the “Boys Life” checkbox on a 
scout/adult personal data dialog, the setting on the recharter selection list will not change. 

 
When you are finished, click OK on the Recharter Selection dialog to generate the 
report. TroopMaster will automatically review all of your data to ensure that your unit 
meets BSA recharter standards. If any discrepancies are encountered, an error 
message will pop-up before the report is displayed. The report cover sheet includes a 
specific list of errors encountered. This makes it easy to see problems you need to 
correct in order to meet BSA standards. 

 
If you checked the "LDS Unit" checkbox on the Unit General Information dialog, 
TroopMaster will apply LDS rechartering rules when it validates your recharter report. For 
example, under LDS rules, Boy Scouts must be age 11-13, Varsity Scouts must be 14-15, and 
Crew Members must be 16-20. This usually means that you must create a separate recharter 
report for each group, making sure that you select the appropriate set of adults/scouts for 
each report. For example, when you charter the crew you must include a Venture Crew 
Advisor. If you charter the same adult on more than one report, he should be marked as 
"Paid" on one and "Multiple" on the others. You can use the “Display” drop-down options to 
limit the selection list to your troop, team, or crew Member Group. 

 
When you are satisfied with the results, print the paper report and then click Close. 
TroopMaster will then save the recharter transfer file to a diskette to give to your council. 
Remember to sign the printed report and submit that with the diskette. 

 
There are two fields that appear on the paper report that cannot be set from within the 
program: “Unit Status” and “On Time Unit”. These fields are not part of the ScoutNET data 
transfer file that is written to diskette, and you should leave them blank on the paper report. 
Your district leader will make these entries. 

 
The official ScoutNET printed report does not contain all of the data contained in the 
electronic transfer file. If you would like to see a printed copy of other data being 
transmitted, check the “Print copy of transmittal file” checkbox, and TroopMaster will 
produce a separate unit report. Please do not submit this internal report to your council 

 
To help you through your annual recharter period, recharter selections you make are retained 
for 60 days after your last change to the selections. Your selections are discarded after 60 
days or when you run the Additional Enrollment report. 

 
 
 

 100



 
 
 
 
h. Council Recharter/Additional Enrollment. Use this report to submit data to your council 

on new scouts and adults who join your unit mid-year. This option will create an ASCII 
delimited file similar to the Annual Recharter report. Your council will be able to import 
the data from this diskette directly into ScoutNET. TroopMaster will also print an 
associated paper report for you to verify the accuracy of your submission. Both the 
diskette and paper report must be submitted. If your council prefers to have mailing 
addresses on the paper report, you can optionally select that. Both street addresses and 
mailing addresses are always included in the electronic transfer file. 

 
i. Email List. This report produces a list of email addresses for your scouts, parents and 

adults. If you include scouts, you can optionally also include email addresses for parents 
and/or alternate relatives. 

 
j. General Purpose Worksheet. This extremely flexible worksheet can be used for a 

multitude of purposes. For example you could use it as a data collection worksheet by 
giving it a title and defining one or more column headers. Optionally, you can choose to 
include selected items from the scouts data file, such as date of birth or current leadership 
position. You can specify 5-column or 10-column options, but if you need a large text 
column, one of the options on the database drop-down list is “Use rest of line”. If you 
select that option, that column will extend to the edge of the report. If you include scouts 
on the report, you can group them by patrol or rank. 

 
If you think you might use the same worksheet again, click the Save button and assign it 
a file name. Then, the next time you need the worksheet, just select it from the drop-
down list. If there’s a saved worksheet that you no longer need, select it from the list and 
click Delete. 

 
k. General Purpose Matrix. This option produces a spreadsheet-type report similar to the 

General Purpose Worksheet. You can define up to 65 column headers for this report, 
which makes it very useful for making a checklist of items for your scouts and/or adults. 
Just assign the report a title and then define as many column headers as you like. For each 
column, enter the header text and click Add. If you need to adjust the sequence, highlight 
the header that you need to relocate and click Move Up or Move Down. If you also want 
to have columns with no predefined header, set the “Number of columns” field to the 
total number of columns desired. Scouts if included can be grouped by patrol or rank. 

 
If you think you might use the same matrix again, click the Save button and assign it a 
file name. Then, the next time you need the matrix, just select it from the drop-down list. 
If there’s a saved matrix that you no longer need, select it from the list and click Delete. 

 
l. Medical/Special Needs. This report lists your scouts and/or adults and any medical and/or 

special needs data that you entered for them on the “Personal #2” tab of their personal 
data dialogs. Medical information includes doctor’s name and phone number, emergency 
contact, health insurance, dates/classes of physical exams, etc. You can also include 
information on medications, allergies, etc. The “Special Needs” option relates to 
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conditions such as learning disabilities, visual/hearing impairments, emotional 
difficulties, etc.  

  
m. Photo Directory. If you have scanned and entered photos for your members, this option 

will produce a photo directory on your scouts and/or adults. This can be especially useful 
to help new leaders familiarize themselves with your scouts. You can choose to include 
phone numbers, patrol assignments and/or leadership positions. You can also group your 
scouts by patrol. 

 
We recommend that you take a Photo Directory with you on campouts so that if someone 
gets lost, you can show the search team his picture. Using the Group Members option (para 
4.4), you can limit the directory to just those scouts and adults who are attending. 

 
n. Physical Exam Status. This report lists your scouts and/or adults along with dates for all 

three classes of physical examinations. Physicals that have expired (based on a date you 
specify) will be flagged with an asterisk. Remember that Class 2 physicals are not 
applicable to adults over age 40. They must complete a Class 3 physical. 

 
Enter a future date to see who will need physicals for a planned activity, such as summer 
camp. 
 
o. Service Years. This report shows the service year status of your scouts/adults. For scouts 

and adults, TroopMaster computes service based on the “Joined Unit” date or “Became 
Leader” date, respectively, adjusted by “Prior Service” and leadership history entries. 

 
p. Swimming Levels. This report is useful whenever you schedule an activity that involves 

swimming. The report lists your scouts and for each shows age, rank, patrol, and 
swimming level (non-swimmer, beginner, or swimmer). Swimming levels are assigned 
via the Scouts>Swimming Levels menu option. Optionally, you can include a column on 
the report where you can assign a “buddy” to each scout or enter recertification levels and 
dates. Scouts can be grouped by patrol or swimming level. 

 
BSA requires swimming levels to be recertified each year so we recommend that at the 
beginning of the year, you reset all scouts to “non-swimmer” status. Then, use this report 
with the “Recertified” option to record the results and date of each scout’s recertification. 
The report then becomes a data collection tool for updating the swimming levels in your 
database. 
 
q. Unit General Information. This report contains all of the information from the Unit 

General Information dialog (para 4.1). 
 
r. Unit/Patrol Awards. This report produces a list of all awards earned by your unit and/or 

individual patrols. 
 
s. Unit Phone List. This report lists your scouts and their home or mailing addresses, phone 

numbers, and email addresses; parents' names, phone numbers, and email addresses; and, 
optionally, alternate parents' names, phone numbers, and email addresses. You can also 
include adult leaders on this report. 
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t. Unit Roster. This extremely flexible roster provides a list of your scouts with ranks, 

patrol names, and leadership positions. You can print the roster alphabetically, sorted by 
birthday, grouped by patrol, or grouped by rank. You can optionally include the scouts’ 
addresses and parents’ names, dates of birth, email addresses, and all phone numbers 
(home phone is always included).  

 
If you group the report by patrol, you can choose to include patrol advisors and/or print 
the patrol leaders and assistants first. 
 

u. Unit Vehicles. This report lists the vehicle information (e.g., make/model, insurance, etc.) 
on the vehicles entered on the scout and/or adult personal data dialogs.  

 
If you’ve defined a Member Group for scouts and adults who plan to attend a specific 
activity, you can select that group through the “Filtered Selection” option and thereby limit 
the report to just those members. 
 

12.12 Varsity 
 

These reports let you track your Varsity awards at the unit and individual team member 
levels. 

 
a. Individual History. This option will generate individual reports for selected team 

members showing requirement completion dates for both the Varsity Letter and the 
Denali Award. If desired, the reports can be grouped by squad. 

 
b. Award Matrix. This option generates a spreadsheet-type report that lists your team 

members and shows which award requirements each member has completed. You can 
run the report for either the Varsity Letter or the Denali Award. Optionally, you can 
group the report by squad and/or include a requirements legend at the bottom. 

 
12.13 Venturing 
 

These reports let you track your Venturing awards at the unit and individual scout levels. 
 

a. Individual History. This option will generate individual reports for selected crew 
members showing requirement completion dates for selected Venturing award(s). 
Options include each of the bronze awards plus the Quest, Gold, and Silver awards. If 
you check the “Only include bronze awards for which some requirements are complete” 
box, TroopMaster will only include bronze awards toward which a specific crew member 
is working. The “Always include primary bronze” box ensures that each scout’s primary 
bronze award (para 6.13) is included on the report regardless of the other options 
selected.  

 
b. Award Matrix. This option generates a spreadsheet-type report that lists your crew 

members and shows which award requirements each member has completed. You can 
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run the report for Gold/Silver Awards, the Quest Award, or any of the bronze awards. A 
requirements legend can be included at the bottom of the report. 

 
c.  Outdoor/Ranger Details. Since both the Bronze Outdoor and Ranger awards have sub-

requirements, this report is provided so that you can see more details on these awards 
than is available on the individual history report. Under each basic requirement, this 
report provides a list of sub-requirements that have not yet been completed. 

 
d.  Quest Award Details. Since the Quest award has sub-requirements, this report is provided 

so that you can see more details than are available on the individual history report. Under 
each basic requirement, this report provides a list of sub-requirements that have not yet 
been completed. 

 
e.  Gold Award Details. This report provides more detail than is available on the individual 

history report. Under each basic requirement, this report provides a list of sub-
requirements that have not yet been completed. 

 
12.14 Sea Scouts 
 

These reports let you track your Sea Scout awards at the unit and member levels. 
 

a. Individual History. This option will generate individual reports for selected ship members 
showing requirement completion dates for the Apprentice, Ordinary, Able, and 
Quartermaster awards.  

 
b. Award Matrix. This option generates a spreadsheet-type report that lists your ship 

members and shows which award requirements each member has completed. You can 
run the report for Apprentice, Ordinary, Able, or Quartermaster. Optionally, you can 
include a requirements legend at the bottom. 

 
12.15 Custom 
 

This option allows you to create custom reports on your scouts and adults by choosing 
specific data fields to include on the report. For example, you may wish to generate a one-
line-per-scout phone list, including each scout’s name, home phone, cell phone, and email 
address. Or you can turn it into a two or three-line report and add items like current rank, date 
of rank, and leadership position. In addition to selecting which data fields to include, you can 
enter a report title. 

 
If you think you might use the same report again, click the Save button and assign it a file 
name. Then, the next time you need the report, just select it from the drop-down list. If 
there’s a saved report that you no longer need, select it from the list and click Delete. 
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12.16 Forms 
 

These forms are primarily to help with data collection but this area also includes permission 
slips. 

 
a. Data Collection Forms. To help you gather the data TroopMaster needs on your scouts, 

adults, merit badge counselors, and POCs, there are separate personal data collection 
forms on each group as well as an advancement (Individual History) form for your 
scouts. 

 
b. Permission Forms. This option makes it easy to print personalized permission slips for 

unit outings. We have developed a default permission form with verbiage that we believe 
will be useful to many units. However, you can change the wording for the body of the 
default form to meet the legal requirements in your area and the specific needs of your 
unit. You can also create and save multiple permission form “masters” for different types 
of activities. Each scout’s medical information can be included so that it’s available on 
the activity and so that its accuracy can be reviewed by the parents. 

 
Once you have reviewed/modified the body text for the form, select the scouts for whom 
you want to generate permission slips. You can select specific scouts, all scouts, or use 
the filtered selection option to select desired scouts. Whenever you generate permission 
slips, TroopMaster will print one slip per scout with each scout’s name on the form.  

 
Troopmaster Software, Inc. makes no guarantee that the wording we have provided is 
legally acceptable in your area, nor do we guarantee that it adequately protects your 
unit against liability lawsuits. It is your responsibility to adjust the wording as 
necessary to meet your needs and the legal requirements in your area. We strongly 
recommend consulting an attorney and your council office to ensure that the final 
wording you choose satisfies your legal needs. 

 
 

If you access this dialog through the Permission Form button on the Activity dialog, 
TroopMaster will preload the activity type, location, and departure/return times for you. 

 
If you create a Member Group (para 4.4) of scheduled attendees, you can select that group 
via the “filtered selection” option to highlight the names of the scouts for whom to print the 
permission slips. You can also use that group after the event to mark attendance. 

 
Previous versions of TroopMaster provided an option to print two permission forms on the 
same page if the verbiage was sufficiently concise. That is no longer possible. Not only have 
new data items been added but the permission forms can now be emailed to your scouts. 

 
12.17 Other 
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This is a group of miscellaneous lists and worksheets. In addition to a Merit Badge Book 
Inventory Worksheet, you can print lists of system-defined and user-defined menu items such 
as merit badge numbers, POC categories, special award names, training courses and 
leadership positions, and member groups. 
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CHAPTER 13. ARCHIVING 
 
13.0 Overview 
 

TroopMaster provides an archive for scouts and adults who leave your unit. The archive data 
is stored separately from your active unit data, but a scout or adult can be retrieved from an 
archive if he later returns to your unit. 

 
13.1 Creating an Archive 
 

An archive is initially created for you as a subfolder under the main program data folder 
(e.g., C:\Troopmaster Software\TroopMaster\Data\Archive1). Up to 250 scouts and 500 
adults can be stored in a single archive. If the initial archive fills up, create another via the 
File>Create New Archive option. 

 
You cannot change the names or locations of your archive folders. 

 
13.2 Archiving Scouts/Adults 
 

Scouts (adults) can be archived either from their individual personal data dialogs or from the 
Scout (Adult) Management dialogs. Click Del/Archive, check the “Archive” option on the 
pop-up window, and enter the date he left your unit. If you click OK, TroopMaster will 
archive the selected member and then delete him from your active unit files. If you’re 
archiving a scout who is at least 17 years old, TroopMaster gives you the option of also 
copying his pertinent data to your active adults file. 

 
Archiving a member saves his personal data, special awards, training, leadership history, 
Order of the Arrow/Mic-O-Say information, and attendance. The member's current 
leadership position(s), if any, will be closed out and moved to his leadership history file. In 
addition, the member’s “Joined Unit” date will be erased and his service with your unit will 
be added to his “Prior Service” area. If the member is a scout, all advancement data is also 
archived. Any data related to the member’s fundraiser sales is discarded. 

 
Archiving a scout or an adult saves a small file that can be used to restore the member’s 
attendance if he is later retrieved from the archive back into the active unit. The associated 
activities themselves are not archived, and activities/attendance cannot be reviewed or 
printed from the archive. 

 
13.3 Reviewing Your Archive 
 

To review your archive or print reports on archived scouts and adults, select the File>Open 
Archive Files option. TroopMaster remembers which archive was last accessed and will 
present that as the default. To remind you that you are in the archive, the words “Archive 
Files” will be displayed on the title bar. While in the archive, some options (e.g., activities, 
POCs, etc) are not available. However, you can add or review archived scouts/adults, edit 
data entries, print reports, etc. 
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Scouts/adults who left your unit before you purchased TroopMaster can be added directly to 
the archive via the “Add New” member options. 

 
13.4 Retrieving Members From the Archive 
 

If you need to retrieve an archived scout or adult back into your active unit files, go to the 
Scouts or Adult Members menu and select Retrieve from Archive. Select the name of the 
member you want to retrieve from the pop-up list and click Retrieve. 
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CHAPTER 14. MAKING BACKUPS 
 
14.0 Overview 
 

It is hard to overstate the importance of making backups. Maintaining your active database 
and archive requires a lot of work. Protect that work by following the procedures in this 
Chapter carefully. 

 
TroopMaster uses file compression technology for backups. Your active database and archive 
will be compressed into much smaller backup files. Don’t be alarmed at the speed of the 
backup and the small sizes of the backup files. You will not be able to read or open these 
files with any of your other software programs, nor will you be able to decompress them with 
any other program. These files can only be decompressed through the File >Restore 
Database menu option by someone who has a valid Data Access Password. If the backup 
was made using a Data Encryption Password, the leader doing the “restore” must also have 
that. 

 
14.1 Backing Up Your Unit Database 
 

Your unit database represents a major investment of your time. It is extremely important that 
you make frequent backups of this data. Don't let a hard drive failure force you to reenter 
most or all of your data from scratch. We recommend making a backup after each data entry 
session (don't wait until you get your whole unit entered before you make your first backup!). 
In addition, don’t always use the same backup diskette or folder. If your hard drive becomes 
corrupted, it is possible to damage your primary database and the backup before you 
recognize the problem. 

 
Because of this, we recommend that you maintain at least three different backups. Alternate 
between these backup diskettes or folders each time you backup your database. By 
alternating, you greatly increase your chances of being able to recover from a damaged file. 
 
Whenever you exit the program, TroopMaster will give you the option of automatically 
backing up your database. You can also request a backup through the File>Backup Database 
option. Unless your backup includes scout/adult photos, all of the backup files will fit onto a 
single diskette. 
 
The backup function always backs up both your active data and your archive(s). 

 
Photo files are large and they do not compress significantly. Therefore, if you select the 
“Include photos” option on a backup, the backup files probably won’t fit on a single 
diskette. If not, you’ll need to backup to a larger medium, such as a zip cartridge, a CD, 
or another hard drive folder. 
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14.2 Other Considerations 
 

TroopMaster comes with a site license for your entire unit so you are free to give copies to 
other leaders with your same unit. Regardless of whether or not other leaders will use this 
data, we recommend that you periodically give data backups to at least one other leader. By 
doing that, you will be able to recover even if you lose everything to a fire or flood. Also 
remember that database backups can be emailed through the File>Email Database menu 
option. In order to be able to restore the data, the other leader will also need a valid Data 
Access Password (para 3.15) and, if you’ve defined one, the Data Encryption Password (para 
3.15b). 
 
If your unit has the TroopMaster DotNet (para 3.16) add-on, you automatically have multiple 
copies of the database at multiple locations. 
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CHAPTER 15. FAMILY LINKS 
 
15.0 Overview 
 

Links provide a powerful way to tie related data records together for concurrent update of 
common data fields. You can link siblings together plus you can link parents to adult 
members, merit badge counselors, or POCs. You can also create links between adult 
members, merit badge counselors, and/or POCs, independent of the parent links. Once these 
database records have been linked, all common information between the records will be 
updated each time any of the linked records is updated. 

 
For example, if a parent is also an adult member and a merit badge counselor, linking the 
three records together will not only reduce initial data entry but also make it easier to 
maintain these records. 

 
You cannot link an adult leader directly to another adult leader, although TroopMaster will 
indirectly link them if they are parents of one of the scouts, and links are established between 
the adults and the parent records. For example, if John and Jane Jones are both adult leaders 
but they do not have a scout in the unit, there is no way to link their adult records. The same 
is true of MBCs and POCs, although, as described below, you can directly link an adult 
leader to an MBC and/ or POC record. 

 
 
15.1 Linking Siblings 
 

If the brother of an existing scout joins the unit, go to the Add New Scout dialog and enter the 
last name of the second brother. If the last name matches an existing last name of a scout in 
the system, TroopMaster will automatically offer to create a family link. Otherwise, click the 
Link Sibling button to display a list of scouts. In either case, select the brother from the pop-
up list. TroopMaster will then create a link between the two records and copy the common 
household information from the existing brother’s record to the dialog being displayed. 

 
Common data fields for brothers include home phone, addresses, parent information, and 
alternate relative information. Existing sibling links are displayed in the “Siblings” drop-
down list box on the “Personal #1” tab of this dialog. 

 
15.2 Linking Parents and Adults 
 

You can link parents and adult records together from either the adult personal data dialog or 
from the “Parents” tab on the scout personal data dialog. You can create a link from the 
“Parents” tab whether or not the adult member record already exists. Click the “Link to” box 
and from the pop-up dialog, select an existing adult member or click Create New to create a 
new adult record.  
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If you create the link from the adult personal data dialog, you can only link to an existing 
parent. If the adult does not exist in the “parents” area, enter the scout/parent data first and 
then create a new adult member record from the “Parents” tab. 
 
If you have linked and adult and a parent record within the system, you may also optionally 
choose to link the vehicle information between the two records. 

 
If you create a new link to an existing record, TroopMaster will always update the 
currently displayed dialog with data from the selected record. For example, if a person 
has been entered in both the “parents’ area and the “adults” area, going to the 
“Parents” tab on the scout personal data dialog and creating a link to the adult member 
will copy the data from the adult’s record to the scout personal data dialog. If the 
parent’s data is more current than the data in the adult record, you should go to the 
adult personal data dialog to create the link. 

 
15.3 Linking Parents and MBCs 
 

Linking parents with merit badge counselors is accomplished in the same manner as for 
parents and adult members. 

 
15.4 Linking Parents and POCs 
 

Linking parents with POCs is accomplished in the same manner as for parents and adult 
members. 

 
15.5 Linking Adults and MBCs 
 

You can link adults and merit badge counselors together from either the adult personal data 
dialog or the merit badge counselor dialog. From either area, you can choose to create a new 
record in the other file or you can link to an existing record. 

 
15.6 Linking Adults and POCs 
 

You can link adults and POCs together from either the adult personal data dialog or the POCs 
dialog. From either area, you can choose to create a new record in the other file or you can 
link to an existing record. 

 
15.7 Linking MBCs and POCs 
 

You can link merit badge counselors and points of contact together from either the MBCs 
dialog or the POCs dialog. From either area, you can choose to create a new record in the 
other file or you can link to an existing record. 

 
15.8 Quick Access Buttons 
 

Quick access buttons give you a way to move quickly to a linked record once a link has been 
established. This allows you to review information on the associated parent, adult, merit 
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badge counselor, or POC from any of the other areas. Just click the button next to the link 
checkbox. 

 
15.9 Breaking a Link 
 

To break any family link, uncheck the box next to the unneeded link. Links are automatically 
broken if you delete one of the members. 

 
Deleting one of the linked records breaks the link but it does not automatically delete the 
other record. For example, if you delete a scout whose parent is linked to an adult member 
record, the adult record will still exist. 

 
If an existing member is currently linked to more than one other area and you wish to break 
the links to that member, you should go to that member’s personal data area and break all 
existing links for that member. If any links are still active, TroopMaster will automatically 
regenerate the link that you have just broken because the remaining links still point to the 
same record(s). 
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APPENDIX A. SYSTEM LIMITATIONS 
 

TroopMaster will not let you exceed the following limits: 
 

General 
 
 - 24 patrols 

- 50 user-defined adult leadership positions 
- 300 adult training course definitions  
- 20 POC categories 
- 100 POC skills/interests definitions  
- 100 unit awards 
- 100 awards per patrol 
- 50 fundraisers 
- 24 sales items per fundraiser 

 
Adults 
 

- 500 adult members 
- 15 leadership history positions per adult 
- 100 special awards per adult 

 - 100 training courses per adult 
- 500 merit badge counselors 
- 500 points of contact (POCs) 
- 20 skills/interests per POC 

 
Scouts 
 
 - 250 scouts 

- 100 special awards per scout 
- 100 training classes per scout 
- 300 scout training course definitions  
- 136 merit badges per scout 
- 15 partial merit badges per scout 
- 15 leadership history positions per scout 

 
Activities 
 

- 24 unit activity types 
- 30 unit activity levels 
- 2000 total activities 

 
Other 
 

- 20 email message attachments 
- 100 vehicles per tour permit 
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APPENDIX B. AUTOMATIC MONITORING & 
CREDITING OF ADVANCEMENT REQUIREMENTS 
 

TroopMaster monitors several of the advancement requirements and will automatically enter 
a completion date in the scout’s advancement records for you when the requirement has been 
completed.  

 
(1) 2nd/1st Class Activities Requirements. For 2nd Class, a scout must attend five activities 

(not including troop/patrol meetings) of which at least two must be overnight campouts. 
For 1st Class, the required number is 10 activities, of which at least three must be 
campouts. TroopMaster will monitor scout attendance at activities and automatically 
credit both of these requirements when they are complete. The Individual Progress report 
shows the number of activities still needed by each applicable scout. 

 
(2) Participation Requirements. The Star, Life, Eagle, and Eagle Palm “Participation” 

requirements are based on the date a scout earned the previous rank, the number of 
months the scout must serve in that rank, and “Today's Date.” When TroopMaster sees 
that the scout has served the minimum time, it will automatically enter a completion date 
in the scout’s advancement records. The projected completion date is shown on the 
scout’s Individual Progress report. 

 
If desired, you can turn off automatic credit of this requirement by checking the “Inactive” 
checkbox on a scout’s Individual Advancement dialog. 

 
(3) Position of Responsibility Requirements. Automatic crediting of the “Position of 

Responsibility” requirements works the same way as “Participation” except that there are 
additional restrictions. First, the scout must be serving in a valid position for the next 
rank (see your Scout Handbook for a list of valid positions for each rank-the positions 
vary). Secondly, he must serve in this position while holding the previous rank. For 
example, if the scout is working toward Life, the Scout Handbook states “While a Star 
scout, serve actively for six months...”. Therefore, TroopMaster will key the completion 
date off of the date the scout assumed the position of responsibility or the date he became 
a Star scout, whichever is later. 

 
In tracking this requirement, TroopMaster considers the scout’s current position #1 
plus any creditable positions in the scout's leadership history area. A position is counted 
toward the requirement if the “Credit” checkbox is checked. The Individual Progress 
report shows the number of days remaining for applicable scouts. 

 
If you accidentally assign a scout to the wrong leadership position or use the wrong 
effective date, be careful when you correct the error. If you modify the position or date 
and enter a newer position date, the previous entry will be moved to the scout’s 
leadership history. If that happens, highlight the erroneous position on the history list 
and click Remove. Otherwise, the erroneous entry could be used toward automatic 
credit of the requirement. 
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(4) Service Project Requirements. The 2nd Class rank has a one-hour service project 
requirement and the Star/Life ranks each require six hours. TroopMaster will monitor 
scout attendance at service projects and automatically credit these requirements when 
they are complete. As with the “Position of Responsibility” requirement, the six hours of 
service needed for Star/Life must be completed since the date the scout earned the 
previous rank. The Individual Progress report shows the number of hours still needed by 
each applicable scout. 

 
When crediting activity attendance, TroopMaster will let you credit individual scouts with 
differing numbers of hours served. Just use the appropriate number (hours and tenths) as each 
scout’s attendance marker (para 7.1b(2)). 

 
TroopMaster never erases or replaces an existing date for the above requirements. Therefore, 
if you remove credit for a leadership position or for service project hours and the 
corresponding requirement has already been credited, you must manually erase the 
requirement completion date.  
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APPENDIX C. PROCESSING OF EAGLE-REQUIRED 
MERIT BADGES 
 

TroopMaster monitors entry of Eagle-required merit badges to help ensure that the minimum 
number has been earned before a scout can be credited with Star, Life, or Eagle. In doing 
this, TroopMaster complies with BSA rules as defined in the Boy Scout Requirements 
Booklet and the Boy Scout Handbook. If there are any uncertainties, we contact the BSA 
National Council to ensure that our interpretation of the rules is correct. Applying these rules, 
TroopMaster automatically places completed merit badges under the appropriate ranks for 
you. 

 
If you would prefer not to use the automatic badge placement feature, check the 
“Manual MB Placement” checkbox for the scout and you can then place each merit 
badge under any rank desired. On each rank dialog, TroopMaster will let you know 
how many of the remaining badges must be Eagle-required and it will prevent you from 
placing too many non-Eagle badges on a rank. However, the program will not stop you 
from entering a merit badge under the “wrong” rank. For example, even if a scout still 
needs Eagle-required badges for Star, TroopMaster will not stop you from entering an 
Eagle-required badge under Life. In selecting manual mode, you are assuming most of 
the burden for ensuring that the scout advances according to BSA rules. 

 
If “Manual MB placement” has not been selected, a merit badge you credit via group 
advancement or the individual rank dialogs will be placed in exactly the same manner as if 
you had entered the badge on the Merit Badges-Completed dialog.  

 
If you have one or more disabled scouts who are not required to earn the standard Eagle-
required badges, please see Appendix D. 

 
There is one other area that even many long-term Scouters do not fully understand because 
the rules are different for the Eagle rank than they are for Star and Life: 

 
(1) The Star rank requires four merit badges from the Eagle-required list and the Life rank 

requires three. The required list has 15 merit badges in 12 categories. Any of these 15 
merit badges may be counted as Eagle-required for Star and Life. (This rule is in the Boy 
Scout Handbook) 

 
(2) The Eagle rank requires a total of 21 merit badges, including one from each of the 12 

Eagle-required categories. 
 

Therefore, if a scout earns the Emergency Preparedness and Lifesaving merit badges, both 
can be counted as Eagle-required merit badges for Star/Life even though both badges are 
from the same category. However, the scout must still earn a badge from each of the other 11 
Eagle-required categories in order to earn the Eagle rank. 
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BSA has periodically revised the Eagle-required merit badge list, and the most recent 
changes became mandatory on April 1, 1999. All Boy Scouts are now advancing under this 
set of rules but most units have archived scouts who completed their ranks under a previous 
set of rules, and a few units still have active scouts who did so. In some cases, a scout may 
even have completed Star and/or Life under one set of rules and then Eagle under another. In 
order to accurately deal with all of this, the merit badge placement function in TroopMaster 
handles the last three sets of Eagle-required badge lists. This allows you, for example, to 
enter previous members of your troop directly into the archive and have TroopMaster accept 
your entries. The remainder of this Appendix explains the methodology we use in the 
automatic badge placement function.  
 
There are currently 15 Eagle-required merit badges divided into 12 categories, but the 
numbers of badges/categories and the content of the categories have changed over the past 
few years. The following categories have been valid for many years and are still valid under 
the 1999 rules: (a) Camping, (b) Citizenship in the Community, (c) Citizenship in the Nation, 
(d) Citizenship in the World, (e) Communications, (f) Emergency Preparedness or 
Lifesaving, (g) Environmental Science, (h) First Aid, and (i) Personal Management. The 
remaining categories vary according to time period: 

 
1) Prior to Sept 1994, there were two other categories:  

 
Safety 
Personal Fitness or Sports or Swimming. 

 
2) From Sept 1994 until Mar of 1999, there were three other categories:  

 
Safety  
Personal Fitness or Sports or Swimming 
Family Life. 

 
3) As of Jan 1999, these last three categories changed:  

 
Personal Fitness 
Cycling or Hiking or Swimming 
Family Life 
 

As you can see, badge lists #2 and #3 overlap between January and March of 1999. This 
means that during the three-month transition period to the new rules, a scout could have 
legally completed a rank using either badge list.  

 
If a scout completed all of the rank requirements except his Board of Review by March 31, 
1999, he could have gotten his Board of Review later and still used the pre-1999 rules. 
However, if any other rank requirement was still open on April 1, 1999, he must have 
completed the rank under the new rules.  

 
Cycling and/or Hiking could not be counted as Eagle-required badges for a rank if the Board 
of Review was earlier than January 1, 1999. 
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For a scout to earn the Life rank using badge list #3, he must have a total of seven Eagle-
required badges from the core list and list #3. For example, let’s suppose a scout earned Star 
under list #2 using Basketry, Archery, First Aid, Camping, Safety, and Sports as his merit 
badges. In order to earn Life using list #3, he would then have to complete five more Eagle-
required badges because Safety and Sports cannot be counted toward the needed total of 
seven. This is based on guidance we received from BSA National. 

 
As you can see, all of this can get very complicated. To help you out, TroopMaster handles 
as much of this for you as possible. The program has a powerful automatic merit badge 
placement function. TroopMaster will automatically monitor all of your entries in each 
scout’s advancement records to determine which badge list(s) are applicable to each scout. 
Using this information, TroopMaster then computes the best possible arrangement of his 
completed merit badges to expedite completion of his next rank. 
 
For example, if TroopMaster determines that the scout could legally complete Star under 
badge list #2 or #3, it will compare the number of list #2 badges he has to the number of list 
#3 badges. Whichever list gives him the most Eagle badges toward Star is the one it will use. 
If this comparison results in a tie, TroopMaster will go with list #3. However, TroopMaster 
will reevaluate the badge placement after every new advancement entry. For example, if you 
enter a service project completion date of 4/2/99, TroopMaster will abandon badge list #2 
and switch to badge list #3. 
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APPENDIX D. DISABLED SCOUTS 
 

TroopMaster includes a feature that allows you to disable the Eagle-required merit badge 
rules for selected scouts. If you have one or more scouts who are being allowed to complete 
alternative badges, bring up his Individual Advancement dialog and press ALT-D. This will 
open up a new “Disable Eagle MB rules” checkbox on this dialog.  
 
To turn off the Eagle-required merit badge rules, check this box. You will be asked to 
confirm the request. If you do, the standard Eagle-required status messages on the Star, Life, 
and Eagle dialogs for the scout will be replaced with the following message: “Eagle MB 
rules checking has been disabled.”  
 
TroopMaster will not perform any Eagle-required merit badge checks for a disabled scout. 
You will be able to enter any merit badge under any rank. Also, reports such as the 
Individual Progress report and the Unit Advancement Status report will only show how many 
total badges the scout needs for his next rank. It is up to you and your local council to ensure 
that the scout gets all of the badges needed for promotion to Eagle. 

 
If you want to restore Eagle rules checking for a scout, clear the “Disable Eagle MB rules” 
checkbox. TroopMaster will revert to automatic badge placement mode and will sort and 
reapply every merit badge the scout has earned. When it finishes placing the badges, any 
Boards of Review that are no longer valid will be erased and, if appropriate, the scout will be 
demoted. 
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APPENDIX E. RECHARTER GUIDANCE 
 

BSA recharter rules require that you charter adult leaders in certain key positions based on 
the type of unit being chartered. You rarely have to charter all of the adults in your unit 
although there are benefits (such as insurance, Scouting Magazine, etc.) available, so you 
should consider chartering more than the minimum. Another consideration is that BSA runs 
background checks on registered leaders. 
 
This appendix provides guidance on the required positions for each unit type. This 
information is current as of the date that this software version was released. 
 
You must charter a leader in each of these positions using a status of Paid, Multiple, or 
Transfer. The “Non-registering” status cannot be used. Except for the Executive Officer, a 
leader can only be chartered as “Multiple” if he was registered as “Paid” by another unit and 
that registration has not yet expired. The Executive Officer is the head of your Chartering 
Organization—you never have to pay for this person so he is always chartered as a 
“Multiple”. 
 
The required positions for all unit types are as follows: 
 
  Position    Position Code   
 
  Executive Officer   IH    
  Chartered Org Rep  CR 
  Committee Chair   CC 
  Committee Member  MC (two are required) 
 
The same leader can be chartered in more than one of the above positions. For example, the 
same leader can serve as the Executive Officer, Chartered Org Rep, and/or Committee Chair 
or Committee Member. However, the same leader cannot be chartered as both the Committee 
Chair and a Committee Member, nor can the same leader serve in one of the above positions 
and one of the positions listed below. 
 
The following additional positions are required based on unit type:   
  

1) Troop: Scoutmaster (SM) 
 

2) Team: Varsity Coach (VC) 
 

3) Crew: Crew Advisor (NL) 
 

4) Ship: Skipper (SK) 
 

Unless you’ve been granted an exception by your Scout Executive, you must also charter at 
least five scouts. Scouts must meet BSA age restrictions based on unit type and whether or 
not you‘re chartering as an LDS unit. However, the age restriction can be waived for a scout 
who has been designated as having “Special Needs” on his personal data dialog.  
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Chartering leaders in assistant positions (SA - Assistant Scoutmaster, VA – Assistant Coach, 
NA – Associate Advisor, MT – Mate) is always optional. TroopMaster processes patrol 
advisors as assistant scoutmasters. 
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APPENDIX F. AVERAGE TIME TO RANK FORMULA 
 

For each Rank Badge Matrix report, TroopMaster calculates the average amount of time it 
takes for a scout in that unit to advance from Scout to 1st Class, Star, Life, and Eagle. This 
appendix explains the formula used in these calculations.  
 
For each rank, TroopMaster first examines all scouts who have earned the rank and computes 
the average time it took them to do that (i.e., the “Base Average”). Then, it considers all 
scouts who have been scouts longer than the Base Average but who have not yet earned the 
rank. This time will be used to increase the average time for that rank via the following 
formulas: 

 
Base Average = (DF / NF)  
 
Average time to rank = ((DF + DS) / (NF + NE)) 
 
Where: 
 
DF = total days it took all scouts who have earned the rank to earn it 
 
DS = total days since joining Boy Scouts for scouts who are below the rank and 
whose service time exceeds the Base Average. For the purposes of this calculation, a 
scout is considered to have “joined” when he has completed the Scout badge 
requirements. 
 
NF = number of scouts who have earned the rank 
 
NE = Number of scouts who are below the rank and whose service time exceeds the 
Base Average 
 
The computed average is expressed on the report in months/tenths: 

 
(Average time in days x 12)/365 

 123



APPENDIX G. TECHNICAL SUPPORT 
 

Virtually everything you need to know about using TroopMaster is readily available without 
your having to contact us. We recommend the following approach: 

 
1) First, consult the on-line help. Every dialog has a Help button that will display the 

section of the manual applicable to the dialog being displayed. Also, the main menu has a 
Help option that gives you access to the on-line help through several different avenues, 
including an index “search” feature. 

 
2) Consult the User Manual. To see it, start TroopMaster and select Help/View User 

Manual (requires Acrobat Reader 4.0 or newer). 
 
3) Visit the “Frequently Asked Questions” (FAQ’s) page on our web site. There is a 

separate FAQ’s page for TroopMaster. 
 

If you still cannot find the answer you need, contact us directly. While we cannot accept 
collect phone calls, we are available to answer questions at 434-589-6788 (Mon-Fri 9AM-
5PM EST). Simple questions can also be handled via our Technical Support form on our web 
page. Detailed questions require that you call us. 
 
Replacement CDs outside of the warranty period are $10, including shipping/handling. 

 
We have always tried to provide the very best technical support available, completely free to 
our users. However, the advent of email threatens our ability to continue doing that. For 
many of the email questions we get, the answer is easily available through the on-line help or 
the User Manual. Please help us keep our user support free by not contacting us directly 
unless you cannot find the answer yourself. 

 124

http://www.troopmaster.com/faq/faq_misc.html


Index 
 

Activities 
 - backpacking (see Backpacking) 
 - calendar of .................................................................................................................69, 86
 - color codes for .................................................................................................................70  
 - combined .........................................................................................................................68  
 - defining types of ..............................................................................................................70
 - deleting ........................................................................................................................... 70
 - levels..........................................................................................................................67, 71
 - generating schedule of .....................................................................................................71
Additional enrollment report..................................................................................................101
Adults 
 - archiving/deleting ...................................................................................... 72, 74, 107-108
 - leadership positions for (see Leadership positions, adults) 
 - O/A for.............................................................................................................................80
 - photos of (see Photos) 
 - receiving from another unit .............................................................................................76
 - retrieving from archive ............................................................................................76, 108
 - special awards for (see Special awards, adult) 
 - training of (see Training, adult) 
 - transferring to another unit ..............................................................................................76
Archive 
 - creating new.....................................................................................................................36
 - deleting empty .................................................................................................................36
 - moving scouts/adults to .........................................................................49, 51, 72, 74, 107
 - opening/reviewing ...................................................................................................26, 107
 - retrieving scouts/adults from .............................................................................54, 76, 108
Attendance, crediting ......................................................................................................... 68-69
Automated District Management System (ADMS),  
 - importing data from.........................................................................................................32
 - transferring data to...........................................................................................................31
Backpacking.......................................................................................................................67, 83
Backups (see Data) 
Blue cards (see Merit badges, applications for) 
Brothers (see Siblings) 
Camping 
 - merit badge ......................................................................................................................92
 - recording attendance at (see Attendance) 
Court of Honor............................................................................................................. 58, 88-89
Cub Scouts, importing from PackMaster...........................................................................33, 54
Customizing TroopMaster (see Preferences) 
Data 
 - backing up...................................................................................... 20, 24, 26, 42, 109-110
 - emailing ...........................................................................................................................27
 - encrypting ........................................................................................ 24-25, 27, 36, 37, 109
 - protecting sensitive .................................................................................24-25,  36-37,  44
 - restoring from backups .............................................................................................. 26-27

 125



Data collection forms..................................................................................................... 105-106
Database management ....................................................................................................... 36-39
Dates, entering and changing....................................................................................... 20-21, 57
Disabled scouts ......................................................................................................................120
Divorced/separated parents......................................................................................................50
DotNet add-on...................................................................................................................  38-40
Duty to God Award (LDS) ....................................................................................45, 65, 66, 94
Eagle 
 - application .......................................................................................................................94
 - Honor Roll .................................................................................................................66, 94
 - required merit badges (se Merit Badges, processing of Eagle-required) 
Emailing 
 - database ...........................................................................................................................27
 - messages ........................................................................................................ 27-28, 50, 73
 - reports ..............................................................................................................................82
 - using BCC when..............................................................................................................27
Encryption (see Data, encrypting) 
Envelopes, printing ..................................................................................................................95
Exporting data........................................................................................................ 30-31, 55, 75
External files, linking.........................................................................................................51, 73
Family links ................................................................................................................... 111-113
Filtered selection.................................................................................................... 23-24, 46, 81
Fonts, selecting ........................................................................................................................43
FTP site .............................................................................................................................. 38-41
Fundraisers................................................................................................................... 78, 94-95
Group credit of awards/training ................................................................................... 64-65, 75
Hiking 
 - recording attendance at (see Attendance) 
Importing data........................................................................................................ 31-32, 54, 76
LDS units ..................................................................................................45,  47, 51, 66, 74, 94
Leadership positions 
 - adult ........................................................................................................................... 74-75
 - defining......................................................................................................................53, 75
 - scout.................................................................................................................................52
License agreement ................................................................................................................. 2-5
Limits (see System limitations) 
Links (see Family Links) 
Mailing labels.......................................................................................................................... 95
MBCounselors 
 - Exporting data to .............................................................................................................31
 - Importing data from.........................................................................................................32
Medical information...................................................................................................50, 73, 101
Meetings , recording attendance at (see Attendance) 
Member groups .................................................................................................... 46-47, 67, 105
Merit badge counselors .......................................................................................... 60, 76, 95-96
Merit badges 
 - adding new.......................................................................................................................57
 - applications for (blue cards) ............................................................................................93
 - defining requirements for ................................................................................................60

 126



 - disabled scouts, alternatives for (see Disabled scouts) 
 - manual placement of................................................................................................56, 117
 - omitting completed badges from selection lists ..............................................................42
 - partial completion of...................................................................................... 61, 65, 91-92
 - processing of Eagle-required ..........................................................57-58, 59, 60, 117-119
 - recording/reviewing counselors for .......................................................................... 60, 91
Mic-O-Say ...................................................................................................................43, 79, 96
O/A, eligibility for ............................................................................................................75, 97
PackMaster, importing Cubs from (see Cub Scouts) 
Parent resources (see Resource survey information) 
Passwords 
 - changing............................................................................................................... 36-38, 37
 - data access ................................................................................................24-25, 36-37, 43
 - data encryption .............................................................................................. 24-25, 36, 38
 - lost ...................................................................................................................................37
 - use of for program startup ...............................................................................................43
Patches, program update ..........................................................................................................18
Patrol awards....................................................................................................................47, 102
Patrols 
 - assigning scouts to ...........................................................................................................46
 - defining............................................................................................................................46
Permission slips .....................................................................................................................105
Photos...............................................................................................26, 39, 46, 49, 72, 102, 109
Points of Contact (POCs)............................................................................................. 77, 97-98
Position of Responsibility, auto crediting of....................................................................53, 115
Preferences......................................................................................................................... 42-44
Print settings....................................................................................................................... 42-44
Privacy (see Data, protecting sensitive, encrypting) 
Recharter 
 - annual....................................................................................................................... 99-101
 - guidance for ........................................................................................................... 121-122
Registering your software ........................................................................................................15
Reported/presented (R/P) flags ....................................................................................58, 89, 90
Satellites............................................................................................................................. 36-39
Scouts 
 - archiving/deleting ..............................................................................................49, 51, 107
 - leadership positions for (see Leadership positions, scouts) 
 - photos of (see Photos) 
 - O/A for.............................................................................................................................80
 - receiving from another unit .............................................................................................55
 - retrieving from archive ............................................................................................54, 108
 - transferring to adults file..................................................................................................51
 - transferring to another unit ........................................................................................55, 90
 
ScoutNET 
 - data entry guidelines for ..................................................................................................24
 - importing data from.........................................................................................................33
 - reports ...............................................................................................50, 73, 88-89, 98-100
Sea Scout awards ....................................................................................................... 62-63, 104

 127



Service hours, crediting (see Attendance, crediting) 
Service stars .......................................................................................49, 50, 72, 73, 88, 89, 103
Service projects 
 - automatic credit of rank requirements for .....................................................................116
 - recording attendance at (see Attendance) 
Siblings ............................................................................................................................51, 111  
Social security numbers ...................................................................... 24-25, 36, 44, 49, 50, 72
Special awards 
 - adult ...........................................................................................................................74, 75
 - defining......................................................................................................................53, 75
 - scout.................................................................................................................................63
Special needs................................................................................................................45, 50, 73
Swimming levels........................................................................................................ 52-53, 102  
System limitations..................................................................................................................114
System requirements................................................................................................................15
Technical support...................................................................................................................124
Time to rank 
 - computation method for.................................................................................................123
 - on report...........................................................................................................................91
Tour permit assistance ..................................................................................... 44, 49, 72, 84-85
Training 
 - adult ...........................................................................................................................75, 87
 - defining......................................................................................................................53, 76
 - expiration periods for.....................................................................................76, 86, 88, 92
 - scout...........................................................................................................................63, 98
 - status of leaders ...............................................................................................................87
Troop Advancement Report (see Unit Advancement Report) 
TroopLedger 

 - importing from.................................................................................................................34
 - transferring data to...........................................................................................................36
TroopMaster Traveler, transferring data to/from............................................................... 34-35
Unit Advancement Report (4403)............................................................................................88
Unit awards ......................................................................................................................48, 103
Unit number, changing (see License Agreement) 
Unit resource survey (see Resource survey information) 
Unit type, changing..................................................................................................................45
Upgrading from earlier versions ........................................................................................ 16-17
User support (see Technical support) 
Varsity Scout awards ...........................................................................................56, 61, 65, 103
Vehicle information .............................................................................................45, 50, 73, 103
Venturing awards .................................................................................................56, 61, 65, 104
World Conservation award ................................................................................................92, 94

 128


	Users Manual
	Chapter 7 - Activities 67
	Chapter 8 - Adults 72

